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Foreword 

The U.S. Army Corps of Engineers (USACE), Hydrologic Engineering 

Center’s (HEC) Statistical Software Package (HEC-SSP) is software that 

allows users to perform statistical analyses of hydrologic data.   

The first official version of HEC-SSP (Version 1.0) was released in 

August of 2008.  Version 1.1 was released in April, 2009 and included 

improvements to data entry, results visualization and reporting, and added 

capability to the volume frequency analysis.  Version 2.0 was released in 

October 2010 and included three new analyses: a duration analysis, a 

coincident frequency analysis, and a curve combination analysis.  Version 

2.1, released in July 2016, included improvements to the volume 

frequency analysis, general frequency analysis, and Bulletin 17B 

(Interagency Advisory Committee on Water Data, 1982) flow frequency 

analysis in addition to two new analyses: Bulletin 17C (England, et al., 

2015) flow frequency using the Expected Moments Algorithm and a 

Balanced Hydrograph analysis.  These new features are discussed in the 

User’s Manual for Version 2.1.   

The HEC-SSP software was designed by Mr. Gary Brunner, Mr. Jeff 

Harris, Dr. Beth Faber, Mr. Matthew Fleming, Mr. Michael Bartles, and 

Mr. William Lehman.  The HEC-SSP user interface and computation code 

was programmed by Resource Management Associates.  This manual was 

written by Mr. Michael Bartles, Mr. Gary Brunner, Mr. Matthew Fleming, 

Dr. Beth Faber, and Ms. Julia Slaughter.
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CHAPTER  1  

Introduction 

Welcome to the U.S. Army Corps of Engineers, Hydrologic Engineering 

Center’s (HEC) Statistical Software Package (HEC-SSP).  This software 

allows users to perform statistical analyses of hydrologic data.  The 

current version of HEC-SSP can perform flood flow frequency analysis 

based on Bulletin 17B (Interagency Advisory Committee on Water Data, 

1982) and Bulletin 17C (England, et al., 2015), a generalized frequency 

analysis on not only flow data but other hydrologic data as well, a volume 

frequency analysis on high and low flows, a duration analysis, a 

coincident frequency analysis, and a balanced hydrograph analysis.   

HEC-SSP has been implemented using software guidelines established at 

HEC.  These guidelines will produce more consistent results when using 

HEC software in water resources studies.  Also, the guidelines facilitate a 

common graphical user interface and “look and feel” for HEC software in 

the PC environment.  Recent HEC software implemented under these 

guidelines include: rainfall-runoff analysis (HEC-HMS), river hydraulics 

(HEC-RAS), reservoir system analysis (HEC-ResSim), flood damage 

analysis (HEC-FDA), flood impact analysis (HEC-FIA), and ecosystem 

function analysis (HEC-EFM).  HEC software implementation is under the 

guidance of Christopher N. Dunn, Director, Hydrologic Engineering 

Center. 

This chapter discusses the general philosophy of HEC-SSP and gives a 

brief overview of the capabilities of the software.  An overview of this 

manual is also provided. 

Contents 

 General Philosophy of HEC-SSP 

 Overview of Program Capabilities 

 Overview of this Manual 
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General Philosophy of HEC-SSP 

HEC-SSP is designed for interactive use in a multi-tasking environment.  

The system is comprised of a graphical user interface (GUI), separate 

statistical analysis components, data storage and management capabilities, 

mapping, graphics, and reporting tools. 

Over a period of many years, HEC has supported a variety of statistical 

packages that perform frequency analysis and other statistical 

computations. Historically, the programs that received the most use within 

USACE were HEC-FFA (Flood Frequency Analysis) and STATS 

(Statistical Analysis of Time Series Data).  HEC-FFA incorporates 

Bulletin 17B procedures that are used for flow frequency analysis.  The 

STATS software package is used for statistical analysis of time series data.  

STATS can provide either analytical or graphical frequency analysis, 

specified by the user.  STATS has the capability of computing monthly 

and annual maximum, minimum, and mean values along with computing a 

volume-duration analysis.  Two other packages that have received a lot of 

use within USACE are REGFRQ (Regional Frequency Computation) and 

MLRP (Multiple Linear Regression Program).  REGFRQ performs 

regional frequency analysis and MLRP is a multiple linear regression 

analysis tool. 

The goal of HEC-SSP is to combine all of the statistical analyses 

capabilities of HEC-FFA, STATS, REGFRQ and MLRP while advancing 

the realm of statistical hydrology through cutting-edge techniques (such as 

the use of the Expected Moments Algorithm).  The current version of 

HEC-SSP supports performing flood flow frequency analyses based on 

Bulletin 17B and Bulletin 17C guidelines, general frequency analyses, 

volume frequency analyses, duration analyses, coincident frequency 

analyses, and balanced hydrograph analyses.  New features and additional 

capabilities will be added in future releases.   

Overview of Program Capabilities 

HEC-SSP is designed to perform statistical analyses of hydrologic data.  

The following is a description of the major capabilities of HEC-SSP. 

User Interface 

The user interacts with HEC-SSP through a graphical user interface 

(GUI).  The main focus in the design of the interface was to make it easy 

to use the software, while still maintaining a high level of efficiency for 

the user.  The interface provides for the following functions: 
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 File management 

 Data entry, importing, and editing 

 Statistical analyses 

 Tabulation and graphical displays of results 

 Reporting facilities 

Statistical Analysis Components 

Flow Frequency Analysis (Bulletin 17) – This component of the software 

allows the user to analytically perform annual peak flow frequency 

analyses.  The software implements two algorithms for computing annual 

peak flow frequencies.  The first is contained within Bulletin 17B, which 

was published by the Interagency Advisory Committee on Water Data in 

1982.  The second is contained within Bulletin 17C, which was released in 

draft form by the Subcommittee on Hydrology in December 2015.  The 

Bulletin 17C document is currently being reviewed. 

General Frequency Analysis – This component of the software allows the 

user to perform peak flow frequency analyses by various methods.  

Additionally the user can perform frequency analysis of variables other 

than peak flows, such as stage and precipitation data. 

Volume Frequency Analysis – This component of the software allows the 

user to perform a volume frequency analyses on daily flow or stage data. 

Duration Analysis – This component of the software allows the user to 

perform a duration analysis on any type of data recorded at regular 

intervals.  The duration analysis can be used to show the percent of time 

that a hydrologic variable is likely to equal or exceed some specific value 

of interest.   

Coincident Frequency Analysis – This component of the software assists 

the user in computing the exceedance frequency relationship for a variable 

that is a function of two other variables. 

Balanced Hydrograph Analysis – This component provides a tool for the 

creation of balanced hydrographs of multiple durations using existing flow 

and volume frequency analyses and input hydrograph shapes. 

Data Storage and Management 

Data storage is accomplished through the use of "text" files (American 

Standard Code for Information Interchange; ASCII; and Extensible 

Markup Language; XML), as well as the HEC Data Storage System 

(HEC-DSS).  User input data are stored in flat files under separate 

categories of study, analyses, and a data storage list.  Gage data are stored 
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in a project HEC-DSS file as time series data.  Output data is 

predominantly stored in HEC-DSS, while a summary of the results is 

written to an XML file.  Additionally, an analysis report file is generated 

whenever a computation is made.  This report file is written to a standard 

ASCII text file. 

Data management is accomplished through the user interface.  The 

modeler is requested to enter a Name and Description for each study under 

development.  Once the study name is entered, a directory with that name 

is created, as well as a study file.  Additionally, a set of subdirectories is 

created with the following names: Bulletin17Results, 

GeneralFrequencyResults, VolumeFrequencyAnalysisResults, 

DurationAnalysisResults, CoincidentFreqResults, BalancedHydrograph, 

Layouts, and Maps.  As the user creates new analyses, an analysis file is 

created in the main project directory.  The interface provides for renaming 

and deletion of files on a study-by-study basis. 

Graphical and Tabular Output  

Graphics include a map window, plots of the data, and plots of analysis 

results.  The map window can be used to display background map layers.  

Locations of the data being analyzed can be displayed on top of the map 

layers.  Once data are brought into HEC-SSP, they can be plotted for 

visual inspection.  The frequency curve plots show the results of the 

analyses, which include the analytically computed curve, the expected 

probability curve, confidence limits, and the raw data points plotted based 

on the selected plotting position method.  Tabular output consists of tables 

showing the computed frequency curves, confidence limits, and summary 

statistics.  All graphical and tabular output can be displayed on the screen, 

sent directly to a printer (or plotter), or passed through the Windows 

Clipboard to other software, such as a word-processor or spreadsheet. 

A report file is available for each analysis.  This report file includes the 

input data, preliminary results, all of the statistical tests (Low and High 

Outliers, Broken Record, Zero Flows Years, Incomplete Record, Regional 

Skews, and Historic Information), and final results.  This report file is 

similar to the FFA output file. 

 Overview of This Manual 

This user's manual is the primary documentation on how to use HEC-SSP.  

The manual is organized as follows: 

 Chapters 1-2 provide an introduction and overview of HEC-SSP, as 

well as instructions on how to install the software. 

 Chapter 3 provides an overview on how to use the HEC-SSP 

software in a step-by-step procedure, including a sample problem 

that the user can follow.   
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 Chapter 4 explains in detail how to enter and view data. 

 Chapter 5 provides a detailed discussion on how to use the Bulletin 

17 Analysis editor. 

 Chapter 6 provides a detailed discussion on how to use the General 

Frequency Analysis editor. 

 Chapter 7 provides a detailed discussion on how to use the Volume 

Frequency Analysis editor. 

 Chapter 8 provides a detailed discussion on how to use the Duration 

Analysis editor. 

 Chapter 9 provides a detailed discussion on how to use the 

Coincident Frequency Analysis editor. 

 Chapter 10 provides a detailed discussion on how to use the 

Balanced Hydrograph Analysis editor. 

 Appendix A contains a list of references. 

 Appendix B has a series of example analyses that demonstrate the 

various capabilities of HEC-SSP when performing a Bulletin 17B 

flow frequency analysis, a General Frequency Analysis, a Volume 

Frequency Analysis, a Duration Analysis, a Coincident Frequency 

Analysis, and a Balanced Hydrograph Analysis. 

 Appendix C has a series of example analyses that demonstrate the 

use of HEC-SSP using the Expected Moments Algorithm (EMA) to 

fit a Log Pearson Type III distribution to annual maximum flow data 

sets. 

 Appendix D has an example detailing the creation of a partial 

duration series from a daily flow dataset to illustrate the use of the 

Find Peaks tool within HEC-DSSVue as well as comparing the 

differences between a partial duration series and an annual maximum 

series.
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CHAPTER  2  

Installing HEC-SSP 

The user can install HEC-SSP using the program installation package 

available from HEC’s web site.  The setup program installs the software, 

documentation, and the example applications.  This chapter discusses the 

hardware and system requirements needed to use HEC-SSP, how to install 

the software, and how to uninstall the software. 

Contents 

 Hardware and Software Requirements 

 Installation Procedure 

 Uninstall Procedure 
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Hardware and Software Requirements 

Before installing the HEC-SSP software, make sure that the computer has 

at least the minimum required hardware and software.  In order to get the 

maximum performance from the HEC-SSP software, recommended 

hardware and software is shown in parentheses.  This version of HEC-SSP 

will run on a computer that has the following: 

 Intel Based PC or compatible machine with Pentium processor or 

higher (a Pentium 4 or higher is recommended).  

 A hard disk with at least 100 megabytes of free space  

 A CD-Rom drive (or CD-R, CD-RW, DVD), if installing from a CD. 

 A minimum of 512 megabytes of RAM (1 Gigabyte or more is 

recommended). 

 A mouse. 

 Color Video Display (Recommend running in 1280x1024 or higher 

resolution, and as large a monitor as possible).  Recommend at least a 

17" monitor. 

 Microsoft Windows XP or 7 (or later versions).  

 

Installation Procedure 

Installation of the HEC-SSP software is accomplished through the use of 

the Setup program.   

To install the software onto your hard disk do the 
following: 

1. Download the HEC-SSP setup program from our web page: 

www.hec.usace.army.mil. 

 

2. Save the setup file in a temporary directory and then execute the 

“HEC-SSP_21_Setup.exe” file to run the setup program. 

 

3. Follow the setup instructions on the screen. 

The install creates a program group called HEC.  This program group will 

be listed under the Programs menu, which is under the Start menu.  The 

HEC-SSP program icon will be contained within the HEC program group, 

within the HEC-SSP subdirectory.  The user can request that a shortcut 

icon for HEC-SSP be created on the desktop.  If the 32-bit application is 

http://www.hec.usace.army.mil/
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installed in the default directory, the HEC-SSP executable can be found in 

the C:\Program Files (x86)\HEC\HEC-SSP\2.1 directory with the name 

"HEC-SSP.EXE".  If the 64-bit application is installed in the default 

directory, the HEC-SSP executable can be found in the C:\Program 

Files\HEC\HEC-SSP\2.1 directory with the name "HEC-SSP.EXE”. 

The HEC-SSP User’s Manual and example data sets are also installed with 

the software.  The User’s Manual can be viewed by selecting User’s 

Manual from the Help menu.  To view the User’s Manual, Adobe 

Acrobat Reader must be installed.  This viewer can be obtained for free 

from the Adobe web page.   

A zip file containing the example data sets described in Appendix B and 

Appendix C have been installed in the "…\Examples" folder within the 

program directory. The example data sets can be installed by selecting the 

Install Example Data option from the Help menu.  After selecting the 

appropriate menu option, a window will open to choose a location to 

install the example data sets.  The program will create two subdirectories 

within your chosen folder called SSP_Examples and 

Bulletin_17C_Examples.  Project files with an “.ssp” file extension will 

be contained in both subdirectories.  The test data sets can be loaded by 

using the Open Study option from the File menu and then use the file 

chooser to select either project file. 

Uninstall Procedure 

The HEC-SSP Setup program automatically registers the software with the 

Windows operating system.  To uninstall the software, do the following: 

 From the Start Menu select Control Panel. 

 Select Add/Remove Programs from within the Control Panel folder. 

 From the list of installed software, select the HEC-SSP program and 

press the Remove button. 

 Follow the uninstall directions on the screen and the software will be 

removed from the computer.   
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CHAPTER  3  

Working With HEC-SSP – An Overview 

HEC-SSP is an integrated package of statistical analysis modules, in 

which the user interacts with the system through the use of a Graphical 

User Interface (GUI).  The current version is capable of performing flow 

frequency analyses based on Bulletin 17B (Interagency Advisory 

Committee on Water Data, 1982) and/or Bulletin 17C (England, et al., 

2015) guidelines, general frequency analyses, volume frequency analyses, 

duration analyses, coincident frequency analyses, curve combination 

analyses, and balanced hydrograph analyses.  This chapter provides an 

overview of how a Bulletin 17C flow frequency analyses can be 

performed with the HEC-SSP software.  General frequency and volume-

duration frequency analyses can be developed in a similar manner as 

outlined for the Bulletin 17 analysis.    

In HEC-SSP terminology, a Study is a set of files associated with a 

particular set of data and statistical analyses being performed.  The files 

for a study are categorized as follows:  study information, data list, and 

analysis data. 

Contents 

 Starting HEC-SSP 

 Overview of the Software Layout 

 Steps in Performing a Bulletin 17C Frequency Analysis 
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Starting HEC-SSP 

When you run the HEC-SSP Setup program, a new program group called 

HEC and a program icon called HEC-SSP are created.  They should 

appear in the start menu under the section called All Programs.  The user 

also has the option of creating a shortcut on the desktop.  If a shortcut is 

created, the icon for HEC-SSP will look like Figure 3-1. 

 
Figure 3-1.  The HEC-SSP Icon. 

To Start HEC-SSP from Windows:  

 Double-click on the HEC-SSP Icon.  If you do not have an HEC-SSP 

shortcut on the desktop, go to the Start menu and select All 

Programs  HEC  HEC-SSP  HEC-SSP 2.1. 

Overview of the Software Layout 

When you first start HEC-SSP, you will see the main window as shown in 

Figure 3-2, except you will not have any study data on your main window.  

As shown in Figure 3-2, the main window is laid out with a Menu Bar, a 

Tool Bar, and four window panes.   

 

The upper right pane (which occupies most of the window area) is the 

Desktop Area (Referred to as the "Desktop" from this point in the 

manual).  This area is used for displaying maps, data editors, and analysis 

windows.   

The upper left pane is called the Study Explorer.  The Study Explorer 

acts like an explorer tree for the study.  The top level of the tree is the 

study (“SSP Examples” in this example).  Below the study is an analysis 

branch, a data branch, and a map branch.  Under the analysis branch, the 

first level is the type of analysis.  Under each analysis type will be the 

current user-defined analyses for that type.  The data branch lists all of the 

available data sets that have been brought into the current study.  

Generally, a data set represents a piece of data at a specific gage location.  

For example, all of the peak annual flows at a single gage would be stored 

as a single data set.  When an analysis is created, the user selects a data set 

to be used for that particular analysis.  The map branch of the tree contains 

any maps the user has put together for the study.  By default there is 

automatically a "Base Map" listed under the maps folder.   
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The lower left pane, and associated tabs, also belongs to the study 

explorer.  This window is used to show additional information about items 

selected in the study explorer.  The tabs are used to switch to different 

views within the study explorer window.  The first tab, labeled Study, 

shows the explorer view of the study.  The second tab, labeled Maps, lists 

the available maps and map layers associated with each map.  The last tab, 

labeled Files, shows all of the files that make up the current study. 

The lower right pane is called the Message Window.  This window is 

used to display messages from the software as to what it is doing.   

 

 
Figure 3-2.  The HEC-SSP Main Window. 

 

At the top of the HEC-SSP main window is a Menu bar with the following 

options: 

 

 

 

 

Study Explorer Desktop Area 

Message Window 
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File:  This menu is used for file management.  Options available under the 

File menu include New Study, Open 

Study, Save Study, Save Study As, 

Close Study, Study Properties, 

Export, Recent Studies, and Exit.  

The Study Properties option is used 

to describe the study.  The Export 

option is used to export HEC-SSP 

results, stored in the study DSS file, 

to another DSS file. The Recent 

Studies option lists the most recently 

opened studies, which allows the user 

to quickly open a study that was 

recently worked on. 

 

 

Edit:  This menu is used for applying the Cut, Copy, 

and Paste clipboard features to data in editable fields 

and tables.   

 

 

 

View:  The View menu allows the user to control display of the toolbars 

and the study windows. The user can 

also toggle between viewing all of the 

panes or just the Main View Pane.  The 

View menu also has options for saving 

the current layout (currently opened 

windows and their sizes and locations) 

and restoring a previously saved layout.  

The Set Study Display Units option 

allows the user to switch output between 

English and metric units.   

The Select Working Sets menu option 

allows the user to group items in each 

folder and then display only those items 

in the user interface.  For example, 

Figure 3-3 shows the Bulletin 17 folder 

in the study explorer.  The Edit Working Set editor, Figure 3-4, was used 

to group all Bulletin 17 analyses that started with “FFA” into one working 

set.  The working set was named “FFA Analyses”.  This working set was 
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activated by right clicking on top of the Bulletin 17 folder in the study 

explorer and selecting Select Working SetsFFA Analyses, as shown in 

Figure 3-5.  Only the Bulletin 17 analyses within the working set will then 

be displayed in the study explorer, as shown in Figure 3-6.  To display all 

Bulletin 17 analysis, right click on top of the Bulletin 17 folder in the 

study explorer and select Select Working SetsNo Working Set.  

 
Figure 3-3.  Study Explorer before Defining a Working Set. 

 

 
Figure 3-4.  Edit Working Set Editor. 
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Figure 3-5.  Activate a Working Set from the Study Explorer. 

 

 
Figure 3-6.  Bulletin 17 Folder Only Displays Analyses in Working Set. 

The user may also prefer to 

group multiple analyses of 

the same type together using 

folders.  Folders can be 

created by right clicking on 

the analysis type of interest 

and selecting New Folder…  

After the user has named the 

folder, analyses can be added 

to the new folder by left clicking on the analysis, holding down the left 

mouse button, dragging the analysis to the newly created folder, and 

releasing the left mouse button. 
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Maps:  This menu is used to set the Default Map Properties (Coordinate 

system, extents,  etc…), define a new map, add map layers to the study, 

and remove a map.   Additionally, 

this menu has the following options 

available: Map Window Settings 

(allows the user to turn map layers 

on and off), Zoom To Entire Map 

Extents, Save Map Image, Import, 

and Export.  The Zoom To Entire 

Map Extents option displays the 

entire set of map layers within the 

map window.  The Save Map 

Image option can be used to save 

the current view of the map to a 

file.   

 

Data:  The Data menu allows the user to define a new data set, open the 

metadata editor, and delete any existing data 

sets from the data list.  Other options include 

opening a plot and table of the data. 

 

 

 

 

 

 

 

Analysis:  The Analysis menu is used to create the various statistical 

analyses available in the software.  Each 

statistical analysis is saved as a separate file 

containing the information that is pertinent to 

that specific analysis type.  The current 

options under this menu item include New, 

Open, Delete from Study, Save, Save As, 

Rename, and Compute Manager.  The 

compute manager allows the user to select 

one, several, or all of the analyses, and then 

have them all recomputed. 
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Results:  The Results menu allows the user to graph and tabulate any of 

the existing analyses that have been computed.  

Additionally, the user can request to view the 

report file from a analysis.  Users must select at 

least one analysis in the Study Explorer before 

selecting Graph, Table, Report, or Summary 

Report.  If more than one analysis of the same 

type are selected (this is accomplished by 

holding down the control key while clicking on 

the various analyses), the Graph and Summary 

Report options will include results from all analyses that are selected.  

However, when multiple analyses are selected, the Table and Report 

option bring up separate windows for each of the selected analyses.  The 

Default Plot Line Styles menu option lets the user change the default line 

styles applied to different data types that are plotted in a graph.  For 

example, the user can change the default line style for high outliers so that 

they are displayed as black triangular data points when a plot is opened. 

 

Tools:  The Tools menu includes HEC-

DSSVue, Plot Probability Lines, Options, 

Console Output, and Memory Monitor.  The 

HEC-DSSVue option brings up the HEC-

DSSVue program and automatically loads the 

current study DSS file.  HEC-DSSVue is a 

DSS utility to tabulate, graph, edit, and enter 

data into DSS.  The Plot Probability Lines 

option opens an editor, shown in Figure 3-7, 

that lets the user add, delete, or edit the 

probability lines and axis labels that are displayed in all frequency curve 

plots.   The Options menu item opens the Options editor that allows the 

user to set default HEC-SSP options.  The Results tab in the Options 

editor, shown in Figure 3-8, allows the user to set the number of decimal 

digits that are displayed in all results.   
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Figure 3-7.  Plot Probability Lines Editor. 

 
Figure 3-8.  Dialog for Controlling the Number of Decimal Digits Shown in 

Result Tables and Reports. 
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Window:  This menu includes Tile, Cascade, Next Window, Previous 

Window, Window Selector, and Window.  These options are used to 

control the appearance of the 

windows in the Desktop area.  

When more than one window is 

open (such as a data importer, 

and various analysis windows), 

these menu items will help the 

user organize the windows, or 

quickly navigate to a specific 

window.   The Tile option can 

be used to organize all of the 

currently opened windows in either a vertical or horizontal tile.  The 

Cascade option puts one window on top of the next in a cascading fashion.  

The Next Window option brings the next window in the list of currently 

opened windows to the top.  The Previous Window brings the last window 

that was on top back to the top.  The Window Selector option brings up a 

pick list of the currently opened windows and allows you to select the one 

you want.  The Window option has a sub menu list of all the opened 

windows and allows you to select one.  

 

Help:  This menu allows the user to open the HEC-SSP User’s Manual, 

install example data sets, read the terms and conditions of use statement, 

and display the current version information about HEC-SSP. 

 

Also on the HEC-SSP main window is a Tool Bar.  The buttons on the 

tool bar provide quick access to the most frequently used options under the 

HEC-SSP File and Edit menus. 
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Steps in Performing a Bulletin 17C Frequency Analysis 

There are five main steps in performing a Bulletin 17C flow frequency 

analysis using HEC-SSP.  Similar steps are required when performing 

other statistical analyses.  

 Starting a new study 

 Adding a Background Map (Optional) 

 Importing, Entering, and Editing Data 

 Performing the Bulletin 17C Frequency Analysis 

 Viewing and Printing Results 

Starting a New Study 

The first step in performing a flow frequency analysis with HEC-SSP is to 

establish which directory you wish to work in and to enter a title for the 

new study.  To start a new study, go to the File menu and select New 

Study.  This will open the Create New Study window as shown in Figure 

3-9. 

 

 

Figure 3-9.  New Study Window. 

 

The user is required to enter a name for the study, select a directory to 

work in (a default location is provided), and select the desired units 

system.  Adding a description of the study is optional.  The user should 

also define a Coordinate System if background spatial data will be plotted.  

Multiple coordinate systems are provided for use.  The choice of a 

coordinate system will not affect any computed results.  Once you have 

entered all the information, press the OK button to have the information 

accepted.  After the OK button is pressed, a subdirectory will be created 
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under the user chosen directory.  The subdirectory will be labeled with the 

same name as the user-entered study name.  This study directory is where 

the HEC-SSP project file, as well as other study files and directories will 

be located.  Additionally, a default map window will appear in the Main 

View Pane.  However, the map window will be blank when it first opens.  

 

Adding a Background Map  

By default, when you start a new project in HEC-SSP a default map 

window (called Base Map) will open in the Desktop window.  Having a 

background map is optional in HEC-SSP.  Not having a map does not 

prevent the user from importing and entering data, or performing an 

analysis and viewing results.  The map is mostly a visual aid of the study 

area.  Additionally, when you bring in gage data you can enter the map 

coordinates of the gage and it will show up on the map.  The user must 

supply a coordinate system other than X-Y (i.e. Geographic) for imported 

gage data to be displayed properly.  Once a gage is located on the map you 

can right click on it to open a shortcut menu for viewing the data, or 

graphing and tabulating the results. 

To add a map layer to the default map, go to the Maps menu and select 

Add Map Layers.  When this option is selected a file chooser window 

will appear, as shown in Figure 3-10, allowing the user to select map 

layers to bring into the map.  The Create Copy option on the window will 

make a copy of the selected map and place it in the Maps subdirectory 

within the study folder. 

Currently, the HEC-SSP software can load the following types of map 

layers: United States Geologic Survey (USGS) DLG, AutoCAD DXF, 

shapefile, Raster Image, USGS DEM, Arc Info DEM, ASCII NetTIN, and 

Mr Sid.   

An example map is shown in Figure 3-11.  This map contains a shapefile 

of state boundaries and data locations. 
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Figure 3-10.  Select a Map Layer to add to the Base Map. 

 

 

Figure 3-11.  Example Background Map. 

If more than one map layer is going to be added to a map, then it is up to 

the user to ensure that all map layers are in the same coordinate system.  

HEC-SSP does not perform coordinate system projections.  Also, HEC-
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SSP cannot always determine the coordinate system for all map layers 

entered.  However, under the Maps menu is an option called Default Map 

Properties.  This menu option can be used to set the default coordinate 

system for the map layers displayed in HEC-SSP.  The user should set the 

default coordinate system first and then bring in map layers to the study. 

Importing, Entering, and Editing Data  

Before any analyses can be performed, the user must bring data into the 

HEC-SSP study.  For a peak flow frequency analysis following guidelines 

in Bulletin 17C, the data must consist of peak annual flow values.  To 

bring data into HEC-SSP go to the Data menu and select New.  This will 

bring up the Data Importer as shown in Figure 3-12. 

 

Figure 3-12.  HEC-SSP Data Importer. 

 

As shown in Figure 3-12, the Data Importer has fields for the Name, Short 

Identifier, and the Description of the data at the top of the window.  

Additionally, it lists the study DSS file name that the data will be stored in 

once it is brought into the study.  The study DSS file is always labeled the 

same name as your study with the .DSS file extension. 

The Data Importer contains two tabs, Data Source and Details.  The Data 

Source tab is shown first.  This tab is used for selecting and defining a 

source for bringing data into the HEC-SSP study.  Currently, there are five 
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ways to bring data into an HEC-SSP study: import from another HEC-

DSS file, import data from the USGS web site, import from a Microsoft 

Excel spreadsheet, manually entering the data into a table, and import the 

data from a text file.  All of these methods will import data into the study 

DSS file. 

For this example, importing data from the USGS website will be shown.  

For a complete description of the data importer see Chapter 4.  To import 

data from the USGS website, first select the USGS Website option from 

the list of five options available in the Location panel.  Next, select 

Annual Peak Data as the data type and make sure the Flow option is 

selected.  The next step is to press the button labeled Get USGS Station 

ID’s by State.  When this button is pressed a window will appear (Figure 

3-13) allowing the user to select a state from which to get data. 

 
Figure 3-13.  Window to Select a State for Downloading Data. 

 

Once a state is selected, press the OK button and a list of the available 

gages from that state will appear in a pick list as shown in Figure 3-14.  

Check the boxes for all of the gages you would like to import and then 

press the Import to Study DSS File button.  Once the import button is 

pressed, a process will begin during which the data will be downloaded 

from the USGS website and saved to the study DSS file.  HEC-SSP will 

automatically name the data when importing multiple gages at one time.  

The USGS import process will download annual peak flow data, and the 

USGS data quality codes.  The quality codes will be added as an addition 

object to the Data folder.   

In addition to the data itself, any metadata that is available will be 

downloaded and stored with the data.  The metadata can be viewed from 

the Details Tab on the Data Importer.  Metadata can also be viewed or 

edited by opening the Metadata Editor.  To open this editor, place the 

mouse on top of a data object in the Data folder and click the right mouse 

button.  The shortcut menu contains an Edit Metadata option, as shown 

in Figure 3-15.  The metadata editor is shown in Figure 3-16. 
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Figure 3-14.  Example of Choosing Gages from a USGS State List to Import. 

 

 
Figure 3-15.  Open the Metadata Editor Using the Right Mouse Click Menu. 
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Figure 3-16.  Metadata can be Viewed or Edited by Opening the Metadata Editor. 

 

As shown in Figure 3-16, the metadata consists of the State, County, 

Stream, Location, Drainage Area, DA Units, Gage Operator, USGS Gage 

No., Gage Datum, HUC (Hydrologic Unit Code), Vertical Datum, and a 

description field.  Additionally, the coordinate location of the data is 

shown.  The coordinate location consists of Coordinate System, 

Coordinate ID, Horizontal Datum, Datum Units, Coordinate X Value, and 

Coordinate Y Value.  Most of the USGS data is retrieved with the 

Latitude/Longitude coordinate system as shown in the example.  In 

addition to editing the metadata, the Metadata Editor allows the user to 

change the name of the data, enter a short identifier, and enter a longer 

description. 

If the metadata does not download automatically, the user has the option 

to enter any of the information by hand.  Metadata is not generated 

automatically for any of the other four data sources.  Therefore, entering 

the metadata is required if the user wants it to be carried along with the 

study. 
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After the data is imported into the study, the user can select any one of the 

gages in the Data folder and Plot or Tabulate the data.  The plot and 

tabulate options are available from the Data menu and from a shortcut 

menu that opens by clicking the right mouse button when the pointer is 

located on top of the gage object in the Data folder.  If you select the Plot 

option, you will get a plot of the peak flow data for that gage.  If you 

select the Tabulate option, you will get a table containing the data.  Data 

values can be edited within the table; however, the editing mode must be 

turned on.  To turn on editing, select the EditAllow Editing menu 

option.  Use the FileSave or FileSave As menu option to save the 

data when you are satisfied with edits.  

If the data has coordinate location information, it will then be plotted on 

top of the background maps.  The software will 

convert the coordinates of the point data to the 

default coordinate system of the base map. The 

user can interact with the plotted points by right 

clicking on the gage icon in the map and a shortcut 

menu will appear as shown.  The user has the 

option to edit the metadata, plot, tabulate, rename, 

or delete the data. 

 

Performing the Bulletin 17C Flow Frequency Analysis 

To perform a Bulletin 17C flow frequency analysis, go to the Analysis 

menu and select New  Bulletin 17 Flow Frequency.  This will bring up 

an empty Bulletin 17 editor.  As shown in Figure 3-17, the user must enter 

a name for the analysis, a description (optional), and select a flow data set 

(gage data stored in study DSS file).  The DSS File Name and Report File 

are automatically filled in by the program.  For now, the DSS File Name 

will be the study DSS file and the report file will have the same name as 

the analysis.  

The editor window contains four tabs: General, Options, EMA Data, and 

Tabular Results. The General tab contains settings for Generalized Skew, 

Expected Probability Curve, Method for Computing Statistics and 

Confidence Limits, Plotting Positions, Confidence limits, a Time Window 

Modification, and Low Outlier Test.  Default settings are already 

established for each of the options on the General tab; however, the user 

can change the default settings.   

The Options tab contains information on Low Outlier Threshold, Historic 

Period Data, and User-Specified Frequency Ordinates.  These options are 

not required for most analyses but may be necessary depending upon the 

data. 
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The EMA Data tab contains information specifically related to flow 

frequency analyses that make use of the procedures contained within 

Bulletin 17C, which uses the Expected Moments Algorithm (EMA) to 

compute flow frequency and confidence limits for the associated flow data 

set.  A detailed description of each of the Bulletin 17C settings and options 

can be found in Chapter 5, Performing a Bulletin 17 Flow Frequency 

Analysis.  The EMA Data tab is shown in Figure 3-18. 

Once all of the settings and options have been selected, the user presses 

the Compute button to have the computations performed.  When the 

computations have finished a message window will open stating Compute 

Complete.  Press the OK button on the message window to close the 

window.  Once the computations have finished the user can begin to look 

at output. 

 

 
Figure 3-17.  Bulletin 17 Flow Frequency Analysis General Tab. 
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Figure 3-18.  Bulletin 17 Flow Frequency Analysis EMA Data Tab. 

  

Viewing and Printing Results 

Tabular output can be viewed by selecting the Tabular Results tab.  

When this tab is pressed, a set of tables will appear as shown in Figure 

3-19.  The primary table on the Tabular Results tab consists of percent 

chance exceedance, computed flow frequency curve, the expected 

probability adjusted curve (if enabled on the General tab), and the 5 and 

95 percent confidence limits.  The second table (bottom left) contains 

general statistics about the data, such as the mean, standard deviation, 

station skew, regional skew, weighted skew, and the adopted skew of the 

analysis.  The third table (bottom right) contains the number of historic 

events, high outliers, low outliers, zero or missing values, systematic 

events in the data set, and the number of years in the historic period.   The 

table can be sent to the printer by pressing the Print button at the bottom 

of the analysis window.  The user can control the number of decimal digits 

shown in the result tables and in reports.  Select Options from the Tools 

menu and then open the Results tab, as shown in Figure 3-19. 
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Figure 3-19.  Bulletin 17 Flow Frequency Analysis EMA Tabular Results Tab. 

 

Graphical output can be obtained by pressing the Plot Curve button at the 

bottom of the analysis editor.  When this button is pressed, a plot will 

appear like the one in Figure 3-20.  This plot contains the computed 

frequency curve, the expected probability adjusted curve (if enabled on the 

General tab), the confidence limits, and the data points plotted using the 

Hirsch/Stedinger plotting position method.  Additionally, a plot title is 

listed at the top.  The plot title is by default the user-defined name of the 

analysis.  The user can modify the plot properties by selecting the 

EditPlot Properties menu option.  A plot properties window will open 

that lets the user change the line style for each data type, change the axis 

labels, modify the plot title, and edit other plot properties.  The user can 

also edit line styles by placing the mouse on top of the line or data point in 

the plot or legend and clicking the right mouse button.  Then select the 

Edit Properties menu option in the shortcut menu.  The plot can be 

printed or sent to the windows clipboard by using the Print and Copy to 

Clipboard options found under the File menu. 

Additional points and lines can be added to a plot by placing the mouse 

anywhere in the plot area and clicking the right mouse button.  Then select 

the Add Marker option to add a line or Add Marker Point to add a 

point.  Draw properties can be edited for these user-defined lines and 
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points by placing the mouse on top of the point or line and clicking the 

right mouse button.  Then select the Edit Properties option in the shortcut 

menu. 

 

Figure 3-20.  Flow Frequency Curve Plot. 

 

The final piece of output available from a flow frequency analysis is a text 

report file.  The report file lists all of the input data and user settings, 

plotting positions of the data points, intermediate results, each of the 

various statistical tests performed (i.e. high and low outliers, historical 

data, etc.), and the final results.  This file is often useful for understanding 

how the software arrived at the final frequency curve.  Press the View 

Report button at the bottom of the analysis editor to view the report file.  

When this button is pressed, a window will appear containing the report as 

shown in Figure 3-21. 
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Figure 3-21.  Report File from Bulletin 17 Frequency Analysis.
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CHAPTER  4  

Using the HEC-SSP Data Importer 

The HEC-SSP Data Importer is used to import, enter, and view data and 

the corresponding metadata used in an HEC-SSP study.  The current 

version of HEC-SSP can be used to import annual peak data (flow and 

stage) and data stored at regular intervals, like hourly flow data.   

Contents 

 Developing a New Data Set 

 Importing Data from an HEC-DSS File 

 Importing Data from the USGS Website 

 Importing Data from an Excel Spreadsheet 

 Entering Data Manually 

 Entering Data from a Text File 

 Metadata 

 Plotting and Tabulating Data 
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Developing a New Data Set 

Before any analyses can be performed in HEC-SSP, the user must import 

or enter data into the study.  Importing, entering, and viewing data is 

accomplished in the Data Importer.  To open the data importer, go to the 

Data menu and select New from the list of options, which will bring up a 

data importer as shown in Figure 4-1. 

 

Figure 4-1.  HEC-SSP Data Importer. 

 

At the top of the Data Importer, the user can enter a Name for the new 

data set.  Optionally, the user can enter a short identifier (limited to 16 

characters) and a Description of the data set.  The study DSS file name is 

provided.  The DSS file is used for storing the data for the study.  The user 

does not have to enter a name when importing or manually entering data.  

The program will automatically name the data using USGS names or 

HEC-DSS pathname parts.  If a Name is entered then it will be combined 

with the USGS gage name or HEC-DSS pathname parts to create a unique 

name.  The user can rename a data set by selecting the data set in the study 

explorer and clicking the right mouse button.  A shortcut menu should 
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open with a Rename menu option.  The Data menu also contains a 

Rename menu option; however, the data set must be selected in the study 

explorer before this menu option is active. 

The Data Importer contains two main tabs, Data Source and Details.  The 

Data Source tab is used for importing or entering data manually while the 

Details tab is used to describe the data (i.e. metadata).  The Data Source 

tab contains five options for getting data into the study DSS file: 

Importing from an existing HEC-DSS file, importing from the USGS 

Website, importing from an Excel spreadsheet, entering the data manually, 

and importing from a text file. 

Importing Data from an HEC-DSS File 

To import data from an HEC-DSS file into the HEC-SSP study DSS file, 

first select the HEC-DSS radio button on the data importer.  Selecting 

HEC-DSS will change the view of the Data Importer to look like Figure 

4-2. 

 

Figure 4-2.  Data Importer with HEC-DSS Import Option. 
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As shown in Figure 4-2, the user first selects a DSS file to import from by 

typing the path and name or by choosing the file browser at the end of the 

input field.  Once a DSS file is selected, the table of pathnames will be 

filled with the records that are contained in that DSS file.  The user can 

reduce the number of listed pathnames by selecting pathname parts to 

filter in the pathname part selection area just above the table.  Any 

pathname part can be used to filter the list down to a more manageable 

number of pathnames to select from.  The user can then select pathnames 

to import by double clicking on one or more of the listed pathnames in the 

table.  Each selected pathname will show up in the list below the table.  

Once the user has selected all of the pathnames that they want to import, 

pressing the Import to Study DSS File button enacts the import process.  

An HEC-SSP data set will be developed for each pathname that was 

selected. 

Importing Data from the USGS Website 

The second way to import data into HEC-SSP is to use the USGS Website 

option.  When this option is selected, the data importer will look like 

Figure 4-3. 
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Figure 4-3.  HEC-SSP Data Importer with USGS Website Import Option. 

 

The first step in using the USGS import option is to select a data type to 

import (e.g. Annual Peak Data).  Then choose to import Flow and/or 

Stage data.  Next the user should select the Get USGS Station ID’s by 

State button.  Selecting this button will bring up a small window that 

allows the user to select a state in which to acquire data, as shown in 

Figure 4-4. 

 
Figure 4-4.  Window to Select a State for Importing USGS Data. 
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Once the user selects a state and presses the OK button, a process will 

begin in which all of the gage locations for that state will be downloaded 

from the USGS website.  A listing of all the gages for that state will then 

be displayed in the table at the bottom of the data importer.  An example 

of the data importer with a list of USGS gages is shown in Figure 4-5. 

 
Figure 4-5.  Data Importer with USGS Gages Listed in Table. 

 

The next step is to select the desired gages for importing into the HEC-

SSP study.  The user can filter the list to a smaller number of gages by 

using the filter drop down boxes at the top of the table.  To select a gage 

for importing, simply check the box in the left hand column for each gage 

location that is to be imported.  After all of the desired locations are 

selected, press the Import to DSS File button to import the data into the 

study DSS file.  Pressing this button will start a process of downloading 

data from the USGS website.  For each selected location, the software will 

download the Data Quality Codes if they are available.  The program 

issues a message that data quality codes are available and adds the codes 
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as an additional data set to the Data folder.  For an explanation of the 

codes, please visit the USGS website. 

Warning: all data downloaded from the USGS website should be 

reviewed to ensure it is appropriate before any analyses are performed on 

the data.  Some data stored on the USGS website are estimated, not 

measured.  The user should check the data on the USGS website and be 

aware of the quality of all the data before using it.  HEC-SSP will import 

the annual peak flow and stage quality codes (the program does not import 

quality codes for daily, instantaneous, and real time data).  A description 

of the quality codes for annual peak flows is contained in Table 4-1 and a 

description of the quality codes for annual peak stages are contained in 

Table 4-2. 

 

Table 4-1.  Quality Codes for USGS Annual Peak Flow Data. 

Code Description 

1 Discharge is a Maximum Daily Average 

2 Discharge is an Estimate 

3 Discharge affected by Dam Failure 

4 
Discharge less than indicated value which is Minimum 

Recordable Discharge at this site 

5 
Discharge affected to unknown degree by Regulation or 

Diversion 

6 Discharge affected by Regulation or Diversion 

7 Discharge is an Historic Peak 

8 Discharge actually greater than indicated value 

9 
Discharge due to Snowmelt, Hurricane, Ice-Jam or Debris 

Dam breakup 

A Year of occurrence is unknown or not exact 

B Month or Day of occurrence is unknown or not exact 

C 
All or part of the record affected by Urbanization, Mining, 

Agricultural changes, Channelization, or other 

D Base Discharge changed during this year 

E Only Annual Maximum Peak available for this year 

 

 

Table 4-2.  Quality Codes for USGS Annual Peak Stage Data. 

Code Description 

1 Gage height affected by backwater 

2 Gage height not the maximum for the year 

3 Gage height at different site and(or) datum 

4 Gage height below minimum recordable elevation 



Chapter 4 - Using the HEC-SSP Data Importer HEC-SSP User's Manual 

 

4-8 

5 Gage height is an estimate 

6 Gage datum changed during this year 

 

Importing Data from an Excel Spreadsheet 

The third option for importing data into HEC-SSP is MS Excel.  When 

this option is selected, the data importer will change as shown in Figure 

4-6.  Currently, HEC-SSP can only import data from Excel 97-2003 

Workbooks (*.xls).  The first step in importing data from an Excel 

spreadsheet is to select the browse button, , at the end of the Excel File 

field.  Once an Excel file is selected, a data view window will open 

showing the data contained in the selected spreadsheet.  An example 

Excel® Data Viewer is shown in Figure 4-7. 

 
Figure 4-6.  Data Importer with MS Excel Import Option Selected. 
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Figure 4-7.  Example Excel Data Viewer. 

 

The next step is to highlight the date and data values to be imported into 

the study (only highlight the data, not the column headings).  The data 

must be in a format of Date in the first column and Data in the second 

column.  The date must be in the Day, Month, Year format (ddmmyyyy) 

as shown in Figure 4-7.  Next, press the OK button and the data will be 

placed in the table at the bottom of the editor.  The last step before 

importing the data is to specify the units of the data, and each of the 

pathname parts for storing the data in the study DSS file (make sure to edit 

the C-part pathname if data is not annual peaks).  Enter units of cfs for 

data in cubic feet per second or units of cms for data in cubic meters per 

second.  The final step is to press the Import to Study DSS File button, 

and the data will be imported. 
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Entering Data Manually 

Another option for getting data into the study is to enter the data manually.  

When the Manual option is selected, the window will change to what is 

shown in Figure 4-8.   

 

Figure 4-8.  Data Importer with Manual Data Entry Option Selected. 

  

To enter data manually, the user enters a name for the data set at the top, 

along with a short identifier and a description (optional).  A starting date 

and time must be entered.  The units of the data must also be defined as 

well as the data type.  The last step before entering the data is to specify 

the pathname parts for how the data will be stored into the study DSS file.  

This requires the user to enter a label for the A, B, C, E, and F part of the 

DSS pathname.  Once all of the data labeling is completed, the data can be 

entered into the table at the bottom of the editor.  The user must enter the 

Date, Time, and data Value for each peak flow value to be entered.  After 

a Date, Time, and Value are entered into a row, a new row will be 

generated in the table when the user leaves the Value field.  The date must 

be in the Day, Month, Year format (ddmmyyyy).  Another option for 
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getting data into the table is to copy it to the clipboard and then paste it 

into the table.  The table supports pasting data one column at a time or you 

can paste the date, time, and value information all at once.  When all of the 

data are entered into the table, the user presses the Import to Study DSS 

File button and the data will be stored in the study DSS file. 

Importing Data from a Text File 

The fifth option for importing data into HEC-SSP is a comma delimited 

Text File.  When this option is selected, the data importer will change as 

shown in Figure 4-9.   

 
Figure 4-9.  Data Importer with Text File Option Selected. 

 

The first step in importing data from a comma delimited Text File is to 

press the Select File, , button at the end of the File field.  Once a 

comma delimited text file is selected, a data view window will open 

showing the data contained in the selected file.  An example text file data 

viewer is shown in Figure 4-10. 
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Figure 4-10.  Example Text File Data Viewer. 

 

The next step is to highlight the date, time, and data columns.  Only 

highlight the data that will be imported, not the column headings.  If there 

are column headings then they need to be identified.  To do this, select the 

row or rows that do not contain data to be imported.  Then click the right 

mouse button and select the Skip Row(s) menu option, as shown in Figure 

4-11. 
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Figure 4-11.  Identify Rows that do not Contain Data to be Imported. 

 

To identify the date and time columns, place the mouse pointer on the 

column number at the top of the table and click the right mouse button.  

Then move the mouse pointer to the Date – Time Column option to see 

an additional menu of options, as shown in Figure 4-12.  Figure 4-12 

shows that column 2 will be defined as the date column.  The date must be 

in the Day, Month, Year format (ddmmyyyy).  The data viewer will 

highlight the date and time columns once they have been defined.   
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Figure 4-12.  Identify Date and Time Columns. 

 

To define the data column, place the mouse pointer on the column number 

at the top of the table and click the right mouse button.  Then choose the 

Set Data Column menu option from the shortcut menu.  Another editor 

will open, as shown in Figure 4-13, that allows the user to define the 

pathname parts, data units, and data type.  After defining these data 

properties, click the Import Now button to import the data and data 

properties into the Data Importer.  You can edit the data values or data 

properties in the data importer before importing the data to the study.  The 

final step is to press the Import to Study DSS File button, and the data 

will be imported. 
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Figure 4-13.  Editor for Defining the Data Properties. 

 

Metadata 

When downloading data from the USGS website, in addition to the raw 

data, the software will also attempt to download any metadata available 

for each gage location.  When using one of the other four methods for 

importing data, the user can manually enter metadata by selecting the 

Details tab, as shown in Figure 4-14.  The metadata consists of the State, 

County, Stream, Location, Drainage Area, DA Units, Gage Operator, 

USGS Gage No., Gage Datum, HUC (Hydrologic Unit Code), Vertical 

Datum, and a description field.  Additionally, the coordinate location of 

the data is shown.  The coordinate location consists of Coordinate System, 

Coordinate ID, Horizontal Datum, Datum Units, Coordinate X Value, and 

Coordinate Y Value.  If coordinate system data are entered, data icons and 

text labels will show up on the background map at the specified locations. 

Metadata can be viewed and edited any time after the data has been 

imported into the study by opening the Metadata Editor.  To open the 

Metadata Editor, place the mouse pointer on top of a data set in the Data 

folder and then click the right mouse button.  Choose the Edit Metadata 

option from the shortcut menu, as shown in Figure 4-15.  The Metadata 

Editor will look exactly like the Details tab on the Data Importer.  The 

Metadata Editor can also be opened from the Data menu and from a 

shortcut menu that opens by right clicking on a data icon in a background 

map. 
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Figure 4-14.  Details Tab on the HEC-SSP Data Importer. 

 

 
Figure 4-15.  Menu Option for Opening the Metadata Editor. 
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Plotting and Tabulating the Data 

After the data is imported into the study, the user can select any one of the 

data sets in the study explorer.  A shortcut menu will open when clicking 

the right mouse button while a data set is selected.  The shortcut menu 

contains options to change the name, plot, and tabulate the data.  These 

options are also available from the Data menu; however, the data must be 

selected in the study explorer before these options are available.  If you 

select the Plot option, you will get a plot similar to the one shown in 

Figure 4-16. 

 
Figure 4-16.  Plot of Peak Annual Flow Data. 

 

If you select the Tabulate option, a table will open with the data listed as 

shown in Figure 4-17.  Data values in the table can be edited after 

selecting the EditAllow Editing menu option.  To save any edits, select 

the FileSave menu option. 
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Figure 4-17.  Table Containing Peak Annual Flow Data. 
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CHAPTER  5  

Performing a Bulletin 17 Flow 

Frequency Analysis 

The current version of HEC-SSP allows the user to perform flow 

frequency analyses using two different methodologies which are 

commonly referred to as Bulletin 17B and Bulletin 17C.  This chapter 

discusses in detail how to perform a Flow Frequency Analysis within 

HEC-SSP using either method. 

Contents 

 Bulletin 17B vs. Bulletin 17C 

 Starting a New Analysis 

 General Settings, Options, and Computations 

 Viewing and Printing Results 
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Bulletin 17B vs. Bulletin 17C 

The Bulletin 17B guidance has guided the development of peak flow 

frequency analyses within the United States since the early 1980’s.  This 

guidance recommended the use of the Log Pearson Type III probability 

distribution for annual peak flows on unregulated streams fit by the 

Method of Moments (Interagency Advisory Committee on Water Data, 

1982).  Using the Bulletin 17B methodology, distribution parameters are 

estimated from the moments of the sample data (i.e. mean, standard 

deviation and skew).  Bulletin 17B also includes adjustments to those 

parameters for non-standard data (missing years, flows below gage base, 

or estimated flows), low outliers, and historical events.  Adjustments can 

be made with a series of specified procedures including the conditional 

probability adjustment and the historical adjustment (weighted moments) 

procedure.  The Bulletin 17B methodology characterizes the peak flow in 

each year as either (1) part of the systematic (observed) record, for which 

a point estimate of flow exists or (2) an historical event from a time before 

a gage was present but for which an estimate of flow can be made. 

The Bulletin 17C guidance brings a change to the computation of peak 

flow frequency within the United States.  This guidance incorporates 

changes motivated by four of the items listed as future work within 

Bulletin 17B and more than 30 years of post-Bulletin 17B research on 

flood processes and statistical methods (England, et al., 2015).  As part of 

the Bulletin 17C methodology, the moments/parameters of the Log 

Pearson Type III distribution are estimated using the Expected Moments 

Algorithm (EMA).  Like Bulletin 17B, the Bulletin 17C/EMA (17C EMA) 

methodology also estimates distribution parameters based on sample 

moments, but does so in a more integrated manner that incorporates non-

standard, censored, or historical data at once, rather than as a series of 

adjustment procedures (Cohn, Lane, & Baier, 1997).  The use of Bulletin 

17C procedures can also provide improved confidence intervals for the 

resulting frequency curve that incorporate diverse information 

appropriately, as historical data and censored values impact the 

uncertainty in the estimated frequency curve (Cohn, Lane, & Stedinger, 

2001).  Within the 17C EMA methodology, every annual peak flow in the 

analysis period, whether observed or not, is represented by a flow range.  

That range might simply be limited to the gaged value when one exists.  

However it could also reflect an uncertain flow estimate.  
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Starting a New Analysis 

A flow frequency analysis can be started in two ways within the software, 

either by right clicking on the Bulletin 17 folder in the study explorer and 

selecting New, or by going to the Analysis menu and selecting New and 

then Bulletin 17 Flow Frequency.  When a new flow frequency analysis 

is selected, the Bulletin 17 Editor will appear as shown in Figure 5-1. 

 

 
Figure 5-1.  Bulletin 17 Flow Frequency Analysis Editor. 

 

The user is required to enter a Name for the analysis, while a Description 

is optional.  An annual peak flow data set must be selected from the 

available data sets stored in the current study DSS file (see chapter 4 for 

importing data into the study).  The list of data that can be selected for a 

Bulletin 17 analysis will only include those data that have an irregular 

interval, like IR-CENTURY and IR-YEAR (E-part pathname).  Once a 

Name is entered, and a flow data set is selected, the DSS File Name and 

Report File will automatically be populated.  The DSS filename is by 

default the study DSS file.  The report file is given the same name as the 

analysis with the extension ".rpt".   
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General Settings, Options, and Computations 

Once the analysis name and flow data set are selected, the user can begin 

setting up the analysis.  Four tabs are contained on the Bulletin 17 editor.  

The tabs are labeled General, Options, EMA Data (which is non-

selectable unless the analysis is set to use 17C EMA methods), and 

Tabular Results.   

General Settings 

The first tab contains general settings for performing the flow frequency 

analysis (Figure 5-1).  These settings include: 

 Method for Computing Statistics and Confidence Limits 

 Generalized Skew 

 Expected Probability Curve 

 Low Outlier Test 

 Plotting Positions 

 Confidence Limits 

 Time Window Modification 

Method for Computing Statistics and Confidence Limits 

There are two 

choices available 

for computing flow 

frequency statistics 

and confidence 

limits within HEC-

SSP: 17C EMA and 17B Methods.  The user is referred to the Bulletin 

17C publication for in depth discussions regarding the differences between 

Bulletin 17B and Bulletin 17C.  In general, 17C EMA will provide the 

same computed flow frequency curve as Bulletin 17B methods when there 

are no historical events/periods and no low outliers included within the 

analysis.  Also, the computed confidence intervals will be nearly the same 

when using a skew that is near zero. 

Choosing either 17C EMA or 17B Methods will invoke different options 

throughout the flow frequency analysis (for instance, choosing the 17C 

EMA method results in the inability to compute the expected probability 

curve).  When opening a new Bulletin 17 analysis, the user must select a 

method for computing statistics and confidence limits before proceeding 

with the analysis.  Until a method is selected, all other options will be 

inactive. 
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Generalized Skew 

There are three options contained within the generalized skew setting: Use 

Station Skew, Use 

Weighted Skew, and 

Use Regional Skew.  

The default skew 

setting is Use Station 

Skew.  With this 

setting, the skew of 

the computed curve 

will be based solely 

on computing a skew 

from the data points 

contained in the data set.  No weighting with regional skew will be 

performed to compute the final skew.   

The Use Weighted Skew option requires the user to enter a generalized 

regional skew and a Mean-Square Error (MSE) of the generalized regional 

skew.  This option weights the computed station skew with the generalized 

regional skew based upon the inverse of the mean square error in each 

skew estimate.  The equation for performing this weighting can be found 

in Bulletin 17B (equation 6).  If a regional skew is taken from Plate I of 

Bulletin 17B (the skew map of the United States), the value of MSE = 

0.302.  Additional estimates of regional skew to be used in peak flow and 

flow-duration statistical analyses are being developed by the USGS and 

others; for example, see (Parrett, et al., 2010). 

The last generalized skew option is Use Regional Skew.  When this 

option is selected, the user must enter a generalized regional skew and an 

MSE for that skew.  The program will ignore the computed station skew 

and use only the regional skew. 

Expected Probability Curve 

This setting has two options: compute the expected probability curve and 

do not compute the expected probability curve.  The default setting is to 

not compute the 

expected probability 

curve.  When using 

the 17C EMA 

method to compute 

statistics and 

confidence limits, the expected probability curve is not computed. 
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However, when using the Bulletin 17B method and computing the 

expected probability curve, this curve will be shown in both the result 

tables and the plots as an additional curve.  The expected probability 

adjustment is a correction for bias in the computed frequency curve.  The 

bias is caused by uncertainty due to the shortness of the data record.  The 

Method of Moments estimation of the Log Pearson III parameters 

produces a median estimate of each frequency curve quantile, and the 

adjustment changes to a mean (unbiased) estimate, which is different from 

the median because of the skewness of the uncertainty distribution.  The 

reader may review the discussion in Bulletin 17B about the expected 

probability curve adjustment for an explanation of how and why it is 

computed. 

The use of the expected probability curve is a policy decision.  It is most 

often used in establishing design flood criteria.  The basic flood frequency 

curve without the expected probability adjustment is the curve used in 

computation of confidence limits, risk, and in obtaining weighted averages 

of independent estimates of flood frequency discharge (Interagency 

Advisory Committee on Water Data, 1982). 

Low Outlier Test 

This option allows the user to choose the test that is performed to identify 

low-value data points that depart significantly from the trend of the 

remaining data and 

inappropriately affect 

the extreme quantiles 

in the upper tail of the 

frequency curve.  

There are two options 

for testing low outliers within HEC-SSP: Multiple Grubbs-Beck and 

Single Grubbs-Beck. 

These low-value data points can significantly distort the entire computed 

flow-frequency curve due to the use of logarithms within both the 17B and 

17C EMA methods.  These distortions are more severe with the 17C EMA 

method.  As part of the development of the Bulletin 17C methodology, the 

standard Single Grubbs-Beck low outlier test was expanded to more 

successfully identify multiple low outliers (also referred to as potentially 

influential low floods, or PILFs).  Therefore, the only option available 

when using the 17C EMA method within HEC-SSP is the Multiple 

Grubbs-Beck test.  When low outliers are calculated using the Multiple 

Grubbs-Beck test, both perception thresholds and flow ranges are 

modified within the 17C EMA framework to prevent excessive influence 

on the computed flow frequency curve.  Example 2 within Appendix C 

presents an instance where multiple low outliers are identified using the 
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Multiple Grubbs-Beck test and the resulting modifications that are made 

within the 17C EMA framework. 

When using the 17B methodology, the default test is the Single Grubbs-

Beck test. 

Plotting Positions 

Plotting positions are used for 

plotting the input flow data 

set on a probability scale 

along with the computed 

frequency curve and 

confidence limits.  There are 

five options for computing 

plotting positions within 

HEC-SSP: Weibull, Median, 

Hazen, Hirsch/Stedinger, and 

user entered coefficients.  

The only method available 

for computing plotting 

positions when using the 17C 

EMA method is 

Hirsch/Stedinger (Hirsch and 

Stedinger, 1987).  The default 

method when using the Bulletin 17B method is the Median plotting 

position formula.  When using 17C EMA methods and the 

Hirsch/Stedinger plotting position formula, flow data screened as low 

outliers (a.k.a. Potentially Influential Low Floods) are assigned a plotting 

position using the Median plotting position formula within HEC-SSP. 

The generalized plotting position equation is:  

)1(

)(

BAn

Am
P




  

where: m = rank of flood values with the largest equal to 1. 

  n = number of flood peaks in the data set. 

A & B = constants dependent on which equation is used (Weibull 

A and B=0; Median A and B = 0.3; and Hazen A and 

B=0.5). 

Plotting positions represent estimates of the exceedance probability of 

each data point (peak flow).  Different plotting position formulas can give 

very different values for the probabilities of the highest and lowest points 

in the data set.  In both the Bulletin 17B and 17C EMA methodologies, the 
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plotting of data on the graph by a plotting position method is only done as 

a guide to assist in evaluating the computed curve.  The plotting position 

method selected does not have any impact on the computed curve. 

Confidence Limits 

The computed flow frequency curve is only an estimate of the probability 

distribution of the larger parent population.  Confidence limits can be used 

to provide a measure of the uncertainty of the estimated exceedance 

probability of a selected discharge or a measure of the uncertainty of the 

discharge at a selected exceedance probability.  Confidence limits 

computed when using the 17C EMA methodology are outlined in Bulletin 

17C, Appendix 6.  Confidence limits computed when using the 17B 

methodology are outlined in Bulletin 17B, Appendix 9.  Generally 

speaking, the confidence intervals computed with 17B procedures are less 

accurate than those computed using the 17C EMA methodology.  The 17B 

methodology neglects the uncertainty in the estimated skew coefficient 

and does not recognize or use historical information. 

By default, HEC-

SSP calculates the 90 

percent confidence 

interval for all flow 

frequency analyses 

(i.e. the 5% and 95% 

confidence limits).  

By comparison, the 

default confidence 

interval used within the USGS PeakFQ program is 95% (i.e. 2.5% and 

97.5% confidence limits) (Veilleux, Cohn, Flynn, Mason, & Hummel, 

2013).  The confidence limits must be entered in decimal form (i.e. 95% = 

0.95, and 5% = 0.05).  The user has the option to override the default 

values and enter whatever values they would like for the confidence limits. 

Time Window Modification 

This option allows the user to narrow the time window used for the 

analysis.  The 

default is to use all 

of the annual peak 

flow data contained 

in the selected data 

set.  The user can 

enter either a start 

date for the analysis, and end date, or both a start and end date.  If a start 

and/or end date are used, they must be dates that are encompassed within 
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the data stored in the selected data set.  The date range for the selected 

data set is shown in the editor just above the Start Date field. 

Any dates entered within the Time Window Modification will be ignored 

when using the 17C EMA Method for Computing Statistics and 

Confidence Limits.  When using 17C EMA, changes to the start and end 

period should be made within the EMA Data tab. 

 

Options 

In addition to the general settings, there are also several options available 

to the user for modifying the computations of the frequency curves.  These 

options include:  

 Low Outlier Threshold 

 Historic Period Data 

 User-Specified Frequency Ordinates 

 

When the Options tab is selected, the Bulletin 17 Editor will appear as 

shown in Figure 5-2. 
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Figure 5-2.  Bulletin 17 Editor with Options Tab Selected. 

 

Low Outlier Threshold 

High and low outlier tests are based on the procedures outlined in Bulletin 

17B and Bulletin 17C.  The calculated outlier thresholds are used as 

default values for the high and 

low outlier thresholds in HEC-

SSP.  The user has the option 

to enter a different value for the 

low outlier threshold if the 

Single or Multiple Grubbs-Beck low outlier tests do not adequately 

identify low outliers.  If a value is entered for the low outlier threshold, 

then this value will override the computed value.  When applying the 

outlier tests, HEC-SSP will identify both high and low outliers.  However, 

only low outliers will be removed from the data set when performing the 

analysis.  If a high outlier is identified in the data set, the analyst should 

try to incorporate historical period information to extend the time period 

for which the high outlier(s) is (are) considered to be the maximum 

value(s).  When using Bulletin 17B procedures, the low outlier threshold 
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cannot be set to a value that would censor more than 50 percent of the 

peak flows. 

To override the computed low outlier threshold, simply check the box and 

enter the value. 

Historic Period Data 

This option is only available when using Bulletin 17B procedures.  To 

make use of historic data within the 17C EMA procedures, this 

information should be entered on the EMA Data tab. 

All historic data that provides reliable estimates of flood peaks outside the 

systematic record should be used in order to improve the estimated flood 

frequency curve.    

Flood information 

of large events 

outside of the 

systematic record 

can often be used to 

extend the record to 

a historic period 

much longer than 

that of the 

systematic record.  

HEC-SSP uses 

historic data specified in this table as recommended in Bulletin 17B. 

However, to use historic data in a 17B analysis within HEC-SSP, check 

the box labeled Use Historic Data.  The user can enter a starting year for 

the historic period, ending year for a historic period, and a high threshold 

value.  If the user enters a high threshold value, then any value in the 

systematic record greater than that value will also be treated as a historical 

flood peak.   The user can also enter historic flood peaks that are not 

contained in the systematic record.  This is done in the table at the bottom 

labeled Historic Flood Peaks.  All years must be entered as water year 

values (October 1 through September 30).  If a start year is not entered, 

then the assumed start year is the earliest year of the systematic record and 

any historical values that have been entered.  If an end year is not entered, 

then the assumed end year is the latest year in the systematic record and 

any entered historic values. 

Note:  The program treats all data in the data set as systematic data when 

using Bulletin 17B procedures.  If historic events are included in the data 

set, then the user must define the analysis time window (General tab – 

Time Window Modification) so that it only bounds the systematic record.  

Then the user must define the historic events in the Historic Events table.  
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The user is directed to Example 6 in Appendix B for an instance of using 

the historic data adjustment within a Bulletin 17B analysis.   

User Specified Frequency Ordinates 

This option allows the user to change or add to the frequency ordinates for 

which the resulting frequency curve and confidence limits are computed.  

The default values listed in 

percent chance exceedance are 

0.2, 0.5, 1, 2, 5, 10, 20, 50, 80, 

90, 95, and 99.  Check the box 

next to Use Values from Table 

below to change or add 

additional values.  Once this 

box is checked, the user can 

add/remove rows and edit the 

frequency values.  To add or 

remove a row from the table, 

select the row(s), place the 

mouse over the highlighted 

row(s) and click the right 

mouse button.  The shortcut 

menu contains options to Insert 

Row(s) and Delete Row(s).  The program will use the default values, even 

if they are not contained in the table, when the Use Values from Table 

below option is not checked.  Finally, all values in the table must be 

between 0 and 100.  Note that these values have no impact on the 

computed frequency curve, but rather only the values of the curve that are 

reported. 

EMA Data 

The Bulletin 17C methodology represents a shift in the determination of 

peak flow frequency and how data is used within peak flow frequency 

analyses.  When using the 17C EMA methodology, additional data is 

required in order to compute peak flow frequency, confidence intervals, 

and plotting positions.  This new information includes perception 

thresholds and flow ranges.  Every year in the analysis period must have 

perception thresholds and a flow range specified.  The additional data that 

is required for use within a 17C EMA analysis is accessed/input within the 

EMA Data tab, as shown in Figure 5-3. 
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Figure 5-3.  Bulletin 17C Analysis EMA Data Tab. 

Perception Thresholds 

The EMA procedure introduces the new concept of Perception Thresholds.  

Perception thresholds define the range of streamflow for which a flood 

event could have been observed.  The inherent assumption and 

consequence is that any year for which an event was not observed and 

recorded must have had a peak flow rate outside of (usually below) the 

perception range. 

Consider the example of an historical flood in 1882 estimated as 50,000 

cfs, and then a gage was installed in 1926.  This flood estimate suggests a 

perception threshold of 50,000 cfs to infinity, because there is evidence 

that a value as low as 50,000 cfs was noted/perceived (with high water 

marks, indirect evidence, and/or hydraulic modeling) during the ungaged 

period.  One can further assume that any flow larger than 50,000 cfs 

would also have been perceived, and so any flow not perceived must have 

been less than 50,000 cfs.  Therefore, for the unobserved period of 1883 to 

1925, we assign the complementary flow range of 0 to 50,000 cfs to 

represent the likely range of peak flows during the unobserved period.  

The perception threshold and flow range for this hypothetical dataset is 

shown in Figure 5-4. 
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Figure 5-4.  Example Showing a Perception Threshold and Flow Range. 

 

The first row within the Perception Thresholds table will automatically be 

created to span the entire period of record of the selected Flow Data Set.  

The start and end year of this first perception threshold can be modified to 

alter the analysis time frame.  This first perception threshold must have a 

low value of 0 and a high value of infinity.  Additional rows within the 

perception threshold table supersede the rows above, for the specified time 

frame.  Within HEC-SSP, perception threshold time frames should not 

overlap one another. 

For any missing years in the analysis period, perception thresholds other 

than zero to infinity must be entered after the first row.  The reason for this 

requirement is that a perception threshold of zero and infinity presumes 

any flow that occurred could have been observed, implying that 

unobserved years would not be possible.  Therefore, unobserved years 

must have a perception threshold with either a lower bound greater than 

zero or an upper bound less than infinity.  Most commonly, since very 

large flows do tend to be observed in some way (as historical events are 

estimated based on some evidence in the watershed), a lower bound 

greater than zero is chosen. 
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To assign a value of 

infinity within the High 

Threshold column, double 

left-click to begin editing 

the desired cell, right-click, 

and select Set as INF 

(infinity).  Use the 

Comments column to provide a descriptive note to a perception threshold.  

The use of this column is not required.  The comment associated with the 

first perception threshold will be automatically set to “Total Record”. 

Multiple rows within the Perception Thresholds table can be sorted using 

chronological order by right-clicking within the table and selecting Sort by 

Start Year.  Similarly, rows can also be inserted or deleted by right-

clicking within the table. 

When low outliers are detected using the Multiple Grubbs-Beck test, the 

perception threshold low value for systematic events will be changed to 

use the smallest non-screened annual peak flow.  Further discussion 

regarding the impacts of low outliers on perception thresholds is contained 

within the Appendix C EMA examples. 

Flow Ranges 

The Bulletin 17B methodology limited the use of annual peak flow data to 

point-value flow estimates or zero flows.  The 17C EMA methodology 

represents each annual peak flow within the analysis period as a range, 

whether it was observed or not.  The flow range for a given year is 

assumed to be the value itself for an observed value or the complement of 

the perception threshold for that same year.   

Flow data can be classified within one of three categories: Systematic, 

Censored, and Historical.  This choice is specified in the Data Type 

column of the Flow Ranges table and can be changed by the user.  By 

default, all flow data contained within the associated Flow Data Set will 

be set to Systematic while missing years will be set to Censored.  

Historical data generally refers to flood peaks that occurred outside of the 

systematic data collection period.  Within the USGS NWIS database, a 

qualification code of “7” will indicate the presence of an historical peak.  

If this flow data is contained within the associated Flow Data Set, it will 

be labeled as Systematic by default.  The user should change the data type 

to Historical. 

By default, the low and high value for an observed (gaged/systematic) 

flood event is set equal to the gage estimate.  The perception thresholds for 

these data points are 0 to infinity.  However, if there is uncertainty about 

the flow estimate, the range can expand to represent the possible value(s).  
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Similar to unobserved years in the historical period, if a crest stage gage is 

unable to estimate flow below a gage base of perhaps 50 cfs, then the 

perception thresholds would be 50 cfs to infinity, and the associated flow 

range for an event marked as “limited by gage base” is 0 to 50 cfs, which 

is set as the complement of the perception thresholds.  The flow range for 

all three data types can be manually altered by the user.  Figure 5-5 

demonstrates several possible flow ranges and data types. 

 
Figure 5-5.  Example Flow Range Table with Systematic, Censored, and 

Historical Data. 

When a flow event is reported as only a high and low value, a peak value 

should be estimated by taking the average of the low and high values.  The 

peak value is used to compute a plotting position as well as within the 

Multiple Grubbs-Beck low outlier threshold computation. 

The Apply Thresholds button can be used to automatically fill out the flow 

range table with the complementary flow 

ranges.  For example, if a perception threshold is 

specified for a period of missing flow data with a low value of 50,000 cfs 

and a high value of infinity, the complementary flow range for each 

missing year would be set to 0 to 50,000 cfs after hitting Apply 

Thresholds.  The user should ensure that the peak, low, and high 

values within the flow range table are appropriate for use before 

computing the analysis. 
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The plot within the 

EMA Data tab 

contains the flow 

values and the 

complementary Flow 

Ranges (as 

determined by the 

input Perception 

Thresholds) for the 

analysis period.  The 

Perception Thresholds 

themselves are not 

contained within this 

figure. 

The Refresh button 

will update the plot if 

changes are made to either the flow values or Perception Thresholds/Flow 

Ranges.  

The user can double left-click the chart to create a separate window 

containing the plot.  Colors, symbols, and various chart properties can then 

be edited. 

When low outliers are detected using the Multiple Grubbs-Beck test, the 

high value within the flow range for systematic events will be changed to 

use the lowest non-screened annual peak flow.  Further discussion 

regarding the impacts of low outliers on flow ranges is contained within 

the Appendix C EMA examples. 

National Water Information System Qualification Codes 

HEC-SSP will import the National Water Information System 

Qualification (NWIS) annual peak flow and stage qualification/quality 

codes when available (the program does not import quality codes for daily, 

instantaneous, and real time data).  A description of the quality codes for 

annual peak flows is contained within Table 4-1 and a description of the 

quality codes for annual peak stages is contained within Table 4-2.  These 

qualification codes can be examined by the user to inform the choice of 

perception thresholds, flow ranges, and data types. 

Figure 5-3 contains an example peak discharge time series and the 

treatment of the NWIS qualification codes using EMA (Paretti, Kennedy, 

& Cohn, 2014).  Within this example, the shaded area represents the 

historical period (H) and the nonshaded area represents the systematic 

record (S).  The seven types of peak streamflow data are: 



Chapter 5 - Performing a Bulletin 17 Flow Frequency Analysis HEC-SSP User's Manual 

 

5-18 

1. Historical discharge (NWIS code 7, Qhist) and historical perception 

threshold specified with an upper perception threshold (T1 and T2 

thresh upper). 

2. Mean daily maximum (NWIS code 1) is described with an upper 

discharge interval bound (Q1 int upper) equal to a perception threshold 

and a known discharge as the lower interval bound (Q1 int lower). 

3. A recorded gage height, missing the corresponding discharge, 

could be used to estimate a discharge interval (Q2 int) where both 

interval bounds are uncertain. 

4. Discharge greater than known maximum discharge (NWIS code 8) 

and used as the lower interval bound (Q3 int lower) and an upper 

interval bound equal to a perception threshold (Q3 int upper). 

5. Missing peak flow data for a portion of the period of record but a 

correlated nearby gage could be used to set an upper perception 

threshold (T3 thresh upper). 

6. A discharge less than a known recordable gage base flow (NWIS 

code 4) is describable with a lower interval bound (Q4 int lower = 

zero) and an upper interval bound (Q4 int upper) equal to the 

minimum gage base discharge. 

7. Systematic peak flow discharge (Qsys). 

 

 
Figure 5-6.  Example Peak Discharge Time Series and the Treatment of the 

NWIS Qualification Codes used within the Expected Moments Algorithm 

(Paretti, Kennedy, & Cohn, 2014). 

 

Compute 

Once the new analysis has been defined, and the user has all of the settings 

and options the way they want them, performing the computations is 

simply a matter of pressing the Compute button at the 

bottom of the Bulletin 17 Editor.  If the computations are 

successful, the user will receive a message that says Compute Complete.  
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At this point, the user can begin to review the results of the flow frequency 

analysis. 

Multiple Bulletin 17 analyses can be computed using the Compute 

Manager.  Select the AnalysisCompute Manager menu option to open 

the Compute Manager.  Select the analyses to be computed and then press 

the Compute button.  Close the compute dialogs and Compute Manager 

when the program finished computing the analyses.  

Viewing and Printing Results 

The user can view output from the flow frequency analysis directly from 

the Bulletin 17 Editor.  The output consists of tabular results, a frequency 

curve plot, and a report documenting the data and computations 

performed. 

Tabular Output 

Once the computations for the flow frequency analysis are completed, the 

user can view tabular output by opening the Tabular Results tab.  When 

this tab is pressed, the results will be displayed as shown in Figure 5-7. 
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Figure 5-7.  Bulletin 17 Editor with Tabular Results Tab Active. 

 

Output on the results tab consists of three tables: Frequency Curves, 

Statistics, and Number of Events.  The Frequency Curve output table 

contains the percent chance exceedance ordinates, the computed Log 

Pearson III frequency curve quantiles, the expected probability adjusted 

frequency curve quantiles (if selected on the General tab), and the 

computed confidence limits (0.05 and 0.95, by default).  Data in the 

frequency curve table can be re-sorted.  Click the Percent Chance 

Exceedance column header (two mouse clicks are required the first time).  

The percent chance exceedance ordinates, along with frequency curve and 

confidence limits values, will sort so that the lowest values are on top or 

the highest values are on top.  The Statistics table contains the mean of 

the data in log space, standard deviation in log space, station log-space 

skew, user entered regional skew, weighted skew (weighted between 

station skew and regional skew), and the adopted skew for the analysis.  

The Number of Events table tabulates the number of historic events, high 

outliers (not calculated when using 17C EMA), low outliers and zero 
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flows, missing values, systematic events, and the number of years in the 

historic period. 

The tabular results can be printed by using the Print button at the bottom 

of the Bulletin 17 Editor.  When the print button is pressed, a window will 

appear giving the user options for how they would like the table to be 

printed. 

Graphical Output 

Graphical output of the frequency curves can be obtained by pressing the 

Plot Curve button.  When the Plot Curve button is pressed, a frequency 

curve plot will appear in a separate window as shown in Figure 5-8.  The 

user can modify the plot properties by selecting the EditPlot Properties 

menu option.  A plot properties window will open that lets the user change 

the line style for each data type, change the axis labels, modify the plot 

title, and edit other plot properties.  The user can also edit line styles by 

placing the mouse on top of the line or data point in the plot or legend and 

clicking the right mouse button.  Then select the Edit Properties menu 

option in the shortcut menu.  Both the Y and X-axis properties can be 

edited by placing the mouse on top of axis and clicking the right mouse 

button.  Then select the Edit Properties menu option in the shortcut 

menu.  For example, the user can turn on minor tic marks for the y-axis 

and modify the minimum and maximum scale for the x-axis. 
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Figure 5-8.  Example Frequency Curve Plot. 

 

The frequency curve plot can be sent to the printer by selecting the Print 

option from the File menu at the top of the window.  Additional printing 

options available from the File menu are Page Setup, Print Preview, and 

Print Multiple (used for printing multiple graphs on the same page).  The 

graphic can also be sent to the Windows Clipboard by selecting Copy to 

Clipboard from the File menu.  Additionally, the plot can be saved to a 

file by selecting the Save As option from the File menu.   When the Save 

As option is selected, a window will appear allowing the user to select a 

directory, enter a filename, and select the format for saving the file.  

Currently, four file formats are available for saving the graphic to disk, 

windows metafile, postscript, JPEG, and portable network graphic. 

The data contained within the plot can also be tabulated by selecting 

Tabulate from the File menu.  When this option is selected, a separate 

window will appear with the data tabulated.  Additional options are 

available from the File menu for saving the graphics options as a template 

(Save Template) and applying previously saved templates to the current 

graphic (Apply Template).   
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The Edit menu on the graphic window contains several options for 

customizing the graphic.  These options include Plot Properties, Configure 

Plot Layout, Default Line Styles, and Default Plot Properties.   

Also, a shortcut menu will appear with further customizing options when 

the user right-clicks on a line on the graph or the legend. 

The graphic customizing capabilities within HEC-SSP are very powerful, 

but are also somewhat complex to use.  The code used in developing the 

plots in HEC-SSP is the same code that is used for developing graphics in 

HEC-DSSVue and several other HEC software programs.  Please refer to 

the HEC-DSSVue User’s Manual for details on customizing plots. 

Viewing the Report File 

When the Bulletin 17 computations are performed, a report file 

documenting the statistical computations is created.  The report file lists 

all of the input data and user settings, plotting positions of the data points, 

intermediate results, each of the various statistical tests performed (i.e. 

high and low outliers, historical data, etc…), and the final results.  This 

also includes the EMA estimate of mean square error, effective record 

length, the Multiple Grubbs-Beck Test low outlier threshold, and the 

variance for each probability quantile.  This file is often useful for 

understanding how the software arrived at the final frequency curve.   

Press the View Report button at the bottom of the Bulletin 17 Analysis 

editor to view the report file.  When this button is pressed a window will 

appear containing the report as shown in Figure 5-9. 
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Figure 5-9.  Example of the Bulletin 17 Report File. 

 

Plots, tables and reports can also be created by selecting menu options 

from the Results menu.  At least one Bulletin 17 analysis must be selected 

in the study explorer before selecting one of the menu options on the 

Results menu.  Results from multiple analyses are combined in one graph 

if they are selected in the study explorer when the Graph menu option is 

selected.  The ResultsSummary Report menu option will create a 

summary table of statistics and frequency curve ordinates for the selected 

analyses as shown in Figure 5-10.  



HEC-SSP User's Manual Chapter 5 - Performing a Bulletin 17 Flow Frequency Analysis 

 

 5-25 

 
Figure 5-10.  Summary Table for Selected Bulletin 17 Analyses. 
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CHAPTER  6  

Performing a General Frequency 

Analysis 

The current version of HEC-SSP allows the user to perform generalized 

frequency analyses of flow and stage data, as well as other data types.   

The user can choose between different analytical distributions or perform 

a graphical fit to the data.  This chapter discusses in detail how to use the 

General Frequency Analysis editor in HEC-SSP. 

Contents 

 Starting a New Analysis 

 General Settings and Options 

 Analytical Frequency Analysis 

 Graphical Frequency Analysis 

 Viewing and Printing Results 
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Starting a New Analysis 

A general frequency analysis can be started in two ways, either by right 

clicking on the General Frequency Analysis folder in the study explorer 

and selecting New, or by going to the Analysis menu and selecting New 

and then General Frequency Analysis.  When a new general frequency 

analysis is selected, the General Frequency Analysis editor will appear as 

shown in Figure 6-1. 

 

Figure 6-1.  General Frequency Analysis Editor. 

 

The user is required to enter a Name for the analysis, while a Description 

is optional.  A data set (flow, stage, or other) must be selected from the 

available data sets stored in the current study DSS file (see Chapter 4 for 

importing data into the study).  The list of data that can be selected for a 

general frequency analysis will only include those data that have an 

irregular interval, like IR-CENTURY and IR-YEAR (E-part pathname).  

Once a Name is entered and a data set is selected, the DSS File Name and 

Report File will automatically be filled out.  The DSS filename is by 
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default the study DSS file.  The report file is given the same name as the 

analysis with the extension ".rpt".   

General Settings and Options 

Once the analysis name and data set are selected, the user can begin to 

perform the computations.  Contained on the General Frequency Analysis 

editor are four tabs.  The tabs are labeled General, Options, Analytical, 

and Graphical.  This section of the manual explains the use of the General 

and Options tabs.  

General Settings 

The first tab contains general settings for performing the frequency 

analysis (Figure 6-1).  These settings include: 

 Log Transforms 

 Confidence Limits 

 Time Window Modification 

 Data Sampling 

 Plotting Positions 

Log Transform 

There are two options contained within the Log Transform setting: Use 

Log Transform and Do not use Log 

Transform.  If the user selects Use Log 

Transform then the logs of the data will 

be taken first.  The frequency analysis 

will be performed on the logs of the data.  

If the user selects Do not use Log 

Transform, then the frequency analysis will be performed on the raw data 

values without taking the logs of the data.   The default setting is Use Log 

Transform.    
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Confidence Limits 

Confidence limits provide a measure of the uncertainty in the computed 

value for a given exceedance probability.  The computation of confidence 

limits is outlined in 

Bulletin 17B, 

Appendix 9, and is 

applied in the same 

manner here in the 

general frequency 

analysis.  By 

default, HEC-SSP 

calculates the 90 

percent confidence 

interval (i.e. the 5% and 95% confidence limits).  The confidence limits 

must be entered in decimal form (i.e. 95% = 0.95, and 5% = 0.05).  The 

user has the option to override the default values. 

 

Time Window Modification 

This option allows the user to narrow the time window used for the 

analysis.  The 

default is to use all 

of the data 

contained in the 

selected data set.   

The user can enter 

either a start date 

and end date or 

both a start and end date.  If a start and/or end date are used, they must be 

dates that are encompassed within the data stored in the selected data set.  

The date range for the selected data set is shown in the editor just above 

the Start Date field. 

Data Sampling 

Two methods are available for sampling data within HEC-SSP: Partial 

Duration and Annual Maximum.  An annual maximum series is ordinarily 

used when the 

primary interest 

lies in the larger 

events or when the 

second, third, 

fourth… nth largest 
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event in any year is of little concern in the analysis.  Conversely, a partial 

duration series represents the frequency of all independent events of 

interest, regardless of whether two or more occurred in the same year.  

Partial Duration analyses may be more appropriate for situations where 

considerable flood damage is wrought by the second or third largest flood 

events in a given year.  However, a flow-frequency curve based upon an 

annual maximum and a partial duration series will converge to form a 

single flow-frequency curve as exceedance probability decreases.  

Commonly, this convergence occurs between the 0.1 and 0.01 exceedance 

probabilities. 

Peak flow data is most often represented by an annual maximum series.  

For instance, choosing to download annual peak data from the USGS 

website (as is detailed in Section 4) will result in the import of an annual 

maximum series.  The user is required to produce an appropriate partial 

duration series for use in a partial duration analysis.  This can be achieved 

in several ways.  For instance, the user can manually select independent 

events from a flow data set with hourly ordinates.  However, it is more 

expedient to use a peak (or minimum) search algorithm, such as the Find 

Peaks tool that can be used within HEC-DSSVue.  This tool will allow the 

user to filter a continuous data set to find either maximum or minimum 

values using user-defined minimum threshold, flow differential, and a 

minimum elapsed time interval between events.  Figure 6-2 demonstrates 

the differences between an hourly flow data set, an annual maximum 

series, and a partial duration series for a four year span at a particular 

stream gage location.  Please see Appendix D for an example use of the 

Find Peaks tool to create a partial duration series.  

The Period of Record Years is used to extract ranked data points from the 

associated data set when using the partial duration data sampling.  For 

instance, if the Period of Record Years is set to 50, then the top 50 ranked 

events will be extracted from the associated data set. 
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Figure 6-2.  Hourly Flow, Annual Maximum, and Partial Duration Series for a 

Stream Gage. 

 

Choosing either Partial Duration or Annual Maximum will enable and 

disable various other features throughout the General Frequency Analysis.  

Annual Maximum is the default. 

Plotting Positions 

Plotting positions are used for plotting the raw data points on the graph.  

There are four options for plotting position 

methodologies within HEC-SSP: Weibull, 

Median, Hazen, and user entered 

coefficients.  The default method is the 

Weibull plotting position formula.  The 

generalized plotting position equation is: 

)1(
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P




  

 

where: m = rank of flood values with the largest equal to 1. 

 n = number of flood peaks in the data set. 
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A & B = constants dependent on which equation is used (Weibull 

A and B=0; Median A and B = 0.3; and Hazen A and 

B=0.5). 

Plotting positions are estimates of the exceedance probability of each data 

point.  Different methods can give very different values for the 

probabilities of the highest and lowest points in the data set.  In the 

General Frequency methodology, the plotting of data on the graph by a 

plotting position method is only done as a guide to assist in evaluating the 

computed curve.  The plotting position method selected does not have any 

impact on the computed curve. 

Options 

In addition to the general settings, there are also several options available 

to the user for modifying the computations of the frequency curves.  These 

options include:  

 Low Outlier Threshold 

 Historic Period Data 

 User-Specified Frequency Ordinates 

 Output Labeling 

When the Options tab is selected, the General Frequency Analysis editor 

will appear as shown in Figure 6-3. 
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Figure 6-3.  General Frequency Editor with Options Tab Selected. 

 

Low Outlier Threshold 

High and low outlier tests 

are based on the procedures 

outlined in Bulletin 17B, and 

are applied in the same 

manner in the General 

Frequency Analysis.  The 

calculated outlier magnitudes, by the Bulletin 17B procedure, are used as 

default values for the high and low outlier thresholds in HEC-SSP.  The 

user has the option to enter a different value for the low outlier threshold.  

If a value is entered for the low outlier threshold, then this value will 

override the computed value from the Bulletin 17B methodology.  When 

applying the outlier tests, HEC-SSP will identify both high and low 

outliers.  However, only low outliers will be removed from the data set 

when performing the analysis.  If a high outlier is identified in the data set, 

the analyst should try to incorporate historical period information to 

extend the time period for which the high outlier(s) is considered to be the 

maximum value(s).  Further discussion of outlier thresholds can be found 
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in Bulletin 17B.  To use the low outlier threshold, simply check the box 

and enter the value. 

Historic Period Data 

All historic data that provides reliable estimates outside the systematic 

record should be used in order to improve the frequency computations.  

Information outside of the systematic record can often be used to extend 

the record of the largest events to a historic period much longer than that 

of the systematic record.  

HEC-SSP uses historic 

data as recommended in 

Bulletin 17B. This 

calculation is applied in 

the same manner in the 

General Frequency 

Analysis.    To use 

historic data, check the 

box labeled Use 

Historic Data.  The user 

can enter a starting year 

for the historic period, 

ending year for a historic 

period, and a High Threshold value.  If the user enters a high threshold 

value, then any data in the systematic record greater than that value will 

also be treated as a historical annual maximum.   The user can also enter 

historic data that are not contained in the systematic record.  This is done 

in the table at the bottom labeled Historic Events.  All years must be 

entered as water year values (October 1 through September 30).  If a start 

year is not entered, then the assumed start year is the earliest year of the 

systematic record and any historical values that have been entered.  If an 

end year is not entered, then the assumed end year is the latest year in the 

systematic record and any entered historic values.  Further discussion of 

the use of historical data can be found in Bulletin 17B. 

Note:  The program treats all data in the data set as systematic data.  If 

historic events are included in the data set, then the user can define the 

analysis time window (General tab – Time Window Modification) so that 

it only bounds the systematic record.  Then define the historic events in 

the Historic Events table.  Instead of using the Time Window Modification 

option, another option is to enter a High Threshold value so that the 

historic data point(s) would be treated as historic data (rather than part of 

the systematic record).  Please see Example 6 in Appendix B for an 

example of using the historic data adjustment. 
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User Specified Frequency Ordinates 

This option allows the user to change the frequency ordinates used in 

computing the resulting 

frequency curves and confidence 

limits.  The default values listed 

in percent chance exceedance 

are 0.2, 0.5, 1, 2, 5, 10, 20, 50, 

80, 90, 95, and 99.  Check the 

box next to Use Values from 

Table below to change or add 

additional values.  Once this box 

is checked, the user can 

add/remove rows and edit the 

frequency values.  To add or 

remove a row from the table, 

select the row(s), place the 

mouse over the highlighted 

row(s) and click the right mouse 

button.  The shortcut menu 

contains options to Insert Row(s) and Delete Row(s).  The program will 

use the default values, even if they are not contained in the table, when the 

Use Values from Table below option are not checked.  Finally, all values 

in the table must be between 0 and 100. 

Output Labeling 

This option allows the user to change the default labels for data contained 

in the output tables and plots.  

The user can change both the 

name of the data as well as 

how the units of the data are 

labeled. 
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Analytical Frequency Analysis 

Once the new analysis has been defined and the user has all of the general 

settings and options the way they want them, the user can choose between 

performing an Analytical Frequency analysis or a Graphical Frequency 

analysis.  This section of the manual describes how to use the Analytical 

Frequency analysis option. 

When the user selects the Analytical tab on the General Frequency 

Analysis editor, the window will appear as shown in Figure 6-4.  As 

shown, three additional tabs will appear on the screen: Settings, Tabular 

Results, and Plot. 

 
Figure 6-4.  Analytical Analysis Tab of the General Frequency Analysis Editor. 
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Settings 

The Settings tab contains additional settings for the analytical frequency 

analysis.  These settings include: 

 Distribution 

 Generalized Skew 

 Expected Probability Curve 

Distribution 

This option allows the user to select from available analytical distributions 

to perform the frequency analysis.  

The current version of HEC-SSP 

contains three distribution choices: 

None, Normal, LogNormal, Pearson 

III, and LogPearson III.   If the user 

has selected to transform the data to 

log space (General tab), then the 

only available choices for 

distribution will be None, LogNormal, and LogPearson III.  If the user did 

not select the option to transform the data to log space (General tab), then 

the only available choices for distribution will be None, Normal and 

Pearson III.  Finally, if the user has selected to use a partial duration series 

on the General Tab, then no distributions will be available for use.   

Generalized Skew 

There are three options contained within the generalized skew setting: Use 

Station Skew, Use Weighted Skew, and Use Regional Skew.  The default 

skew setting is Use Station Skew.  With this setting, the skew of the 

computed curve will be based solely on computing a skew from the data 

points.   

To use either of the two other 

options requires the use of the Log 

Person III distribution.  The Use 

Weighted Skew option requires the 

user to enter a generalized regional 

skew and a Mean-Square Error 

(MSE) of the generalized regional 

skew.  This option weights the 

computed station skew with the 

generalized regional skew.  The 

equation for performing this 

weighting can be found in Bulletin 17B (Equation 6).  If a regional skew is 
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taken from Plate I of Bulletin 17B (the skew map of the United States), the 

value of MSE = 0.302.   

The last generalized skew option is Use Regional Skew.  When this 

option is selected, the user must enter a generalized regional skew and an 

MSE for that skew.  The program will ignore the computed station skew 

and use only the generalized regional skew. 

Expected Probability Curve   

This setting has two options: Compute the expected probability curve and 

do not compute the expected probability curve.  The default setting is to 

not compute the expected probability curve.  When computed, this curve 

will be shown in both the 

tables and the plots as an 

additional curve to the 

computed curve.   The 

expected probability 

adjustment is a correction for 

bias in the computed frequency curve.  The bias is caused by the skew in 

the uncertainty due to the shortness of the data record.  The Method of 

Moments estimation of the Log Pearson III parameters produces a median 

estimate of each frequency curve quantile, and the adjustment changes to a 

mean (unbiased) estimate, which is different from the median because of a 

skewed uncertainty distribution.  Please review the discussion in Bulletin 

17B about the expected probability curve adjustment for an explanation of 

how and why it is computed.  The use of the expected probability curve is 

a policy decision.  It is most often used in establishing design flood 

criteria.  The basic flood frequency curve without the expected probability 

adjustment is the curve used in computation of confidence limits, risk, and 

in obtaining weighted averages of independent estimates of flood 

frequency discharge (Interagency Advisory Committee on Water Data, 

1982). 

Compute 

Once the new analysis has been defined, and the user has all of the 

General, Options, and Settings information selected the way they want, 

performing the computations is simply a matter of pressing the Compute 

button at the bottom of the General Frequency Analysis editor.  If the 

computations are successful, the user will receive a message that says 

“Compute Complete”.  At this point, the user can begin to review the 

results of the Analytical Frequency computations. 

Multiple General Frequency analyses can be computed using the 

Compute Manager.  Select the AnalysisCompute Manager menu 
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option to open the Compute Manager.  Select the analyses to be computed 

and then press the Compute button.  Close the compute dialogs and 

Compute Manager when the program finished computing the analyses.  

Tabular Results 

The Tabular Results tab will bring up a table of results for the Analytical 

Frequency analysis.  An example of the results tab is shown in Figure 6-5. 

As shown in Figure 6-5, the window contains three tables.  The top table 

contains results of the computed frequency curve.  The very left column of 

the top table is the Percent Chance Exceedance for all the computed 

values.  The next three columns in the top table contain the computed 

frequency curve and the 95% and 5% confidence limits that correspond to 

that computed curve.  The last three columns of the top table contain a 

computed frequency curve and confidence limits for an analysis based on 

user-adjusted statistics for the mean, standard deviation, adopted skew, 

and equivalent years of record.  User entered adjusted statistics are an 

option that the user can set on the Plot tab, which is discussed in detail in 

the next section of this manual.  If the user has not entered adjusted 

statistics, then these columns will be empty.  Data in the frequency curve 

table can be re-sorted.  Click the Percent Chance Exceedance column 

header (two mouse clicks are required the first time).  The percent chance 

exceedance ordinates, along with frequency curve and confidence limits 

values, will sort so that the lowest values are on top or the highest values 

are on top.   

Two additional tables are shown at the bottom of the window: Statistics 

and Number of Events.  The Statistics table consists of the mean, standard 

deviation, station skew, user entered regional skew, weighted skew 

(weighted between station skew and regional skew), and the adopted skew 

for the analysis.  The Number of Events table contains the number of 

historic events, high outliers, low outliers, zero or missing values, 

systematic events, and the number of years in the historic period (this 

value only comes into play if the user entered historic data). 

Additionally, the lower right portion of the table will show if Log 

Transform is On or Off, and which analytical distribution was selected for 

the analysis. 
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Figure 6-5.  Tabular Results Tab for Analytical Analysis. 

 

Plot 

In addition to tabular results, a Plot tab is available for viewing a graphical 

plot of both the computed frequency curve, as well as a computed curve 

based on any user-adjusted statistics.  When the Plot tab is selected the 

window will change to what is shown in Figure 6-6. 
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Figure 6-6.  Plot Tab of the General Frequency Analytical Analysis. 

 

 

As shown in Figure 6-6, the plot contains the computed frequency curve, 

95% and 5% confidence limits, and raw data points plotted by the user 

selected plotting position method.  The computed statistics for the 

frequency curve are shown in a table on the right side of the window.  

Below the computed statistics is a table labeled "User Statistics".  There is 

a check box and a data entry field for the Mean, Standard Deviation, 

Adopted Skew, and Equivalent Years of Record.  The user can enter 

values into any or all of these fields.  Turning on the check box then 

enables that field to be used in computing a curve with the user entered 

statistic overriding the computed value from the raw data.  The user 

statistics option allows the user to see how the curve would change if any 

or all of the statistics were different.  When data is entered into the user 

statistics fields, and the check boxes are turned on, the user must press the 

compute button again in order for the computations to be performed with 

the user entered statistics.  After the compute button is pressed, both the 
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plot and the table on the Tabular Results tab will be updated to reflect any 

user entered statistics. 

 

Graphical Frequency Analysis 

In addition to an analytical frequency analysis which uses a statistical 

distribution fit to the data, the user has the option to graphically fit a curve 

to the data.  A graphical fit can be very useful when the available 

analytical distributions do not provide a good fit to the data.  One example 

of when a graphical frequency analysis is most appropriate is when 

plotting a frequency curve for flow data that is downstream of a flood 

control reservoir.  Analytical frequency distributions are often not 

appropriate for describing flow data that is significantly regulated by 

upstream reservoirs.  In general, a portion of the flow frequency data for a 

highly regulated stream will be very flat in the zone in which upstream 

regulation can control the flows for a range of frequencies.  This type of 

data lends itself to a graphical fit analysis rather than the use of an 

analytical equation.  Another example of using a graphical fitting 

technique over an analytical curve is when trying to compute a frequency 

curve for annual peak stage data at a point on a river.  Often the stages will 

flatten out with decreased frequencies when flows go out into the 

overbank and floodplain area.  Again, this type of data is fitted much 

better using a graphical fit curve instead of an analytical distribution.  

Another example of using a graphical fitting technique in lieu of an 

analytical curve is when a partial duration series is being used instead of 

an annual maximum series. 

When the Graphical tab is selected, the editor will display a plot and table 

as shown in Figure 6-7.  Three points are required to define a graphical 

frequency curve.  In the plot, the data will be plotted using the user 

selected plotting position method.  The table to the right of the plot allows 

the user to enter data values for the frequency ordinates defined on the 

Options tab. 

Additionally, the Multi-Point Edit tool can be used to define the 

frequency ordinates by drawing a curve.  To use this tool, begin 

by selecting the tool on the left side of the editor.  Then, define 

the curve by left clicking within the plot window at the desired locations.  

To finish defining the curve, right click.  It should be noted that the Multi-

Point Edit tool will not extrapolate flow frequency information; it will 

only interpolate to the user-defined frequency ordinates specified on the 

Options tab.  Bold, dashed lines will be displayed on the plot that 

correspond to the frequency ordinates defined on the Options tab.  These 

vertical lines help to visually identify the locations where flow frequency 
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information will be extracted from the drawn curve.  Frequency ordinates 

must be defined in a decreasing order (when compared to percent chance 

exceedance). 

The Data Type and Equivalent Years of Record options are required to 

compute the confidence limits using the order statistics method that is 

discussed in ETL 1110-2-537.  If the data is not flow or stage, select the 

Flow data type when the graphical frequency curve is approximately 

analytic for extreme probabilities (frequency curve is not relatively flat for 

extreme probabilities).  Select the Stage data type when the graphical 

frequency curve is relatively flat for extreme probabilities (U.S. Army 

Corps of Engineers, 1997). When the user enters values into the frequency 

curve table, those values will be plotted as a line on the plot after the 

Compute button is pressed.  The idea is to enter values in the table that 

will create a best fit line of the data, based on the user’s judgment. 

When using a partial duration series, the Axis Type options will become 

enabled.  By default the Normal (Top N Events) will be set as the default.  

The Normal (Top N Events) option will use the Period of Record Years 

that was defined on the General Tab to extract and plot the top N events.  

For instance, if the user defined a Period of Record Years of 79 on the 

Graphical Tab, the top 79 events within the associated partial duration 

series will be plotted using the Plotting Position defined on the General 

tab.  When using the Log (All Events) axis option, all events will be 

plotted using the average number of events per year to define the x-axis.  

The two different plotting options are shown in Figure 6-8. 
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Figure 6-7.  Graphical Tab of the General Frequency Analysis Editor. 
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Figure 6-8.  Axis Type Options on the Graphical Tab.  
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Viewing and Printing Results 

The user can view output for the frequency analysis directly from the 

General Frequency Analysis editor (Tabular and Graphical output) or by 

using the plot and view buttons at the bottom of the editor.  The output 

consists of tabular results, an analytical frequency curve plot, a graphical 

frequency curve plot, and a report documenting the data and computations 

performed. 

Tabular Output 

Once the computations for the analytical frequency analysis are 

completed, the user can view tabular output by selecting the Tabular 

Results tab under the Analytical analysis tab.  The details of this table 

were discussed under the analytical analysis option above. 

The tabular results can be printed by using the Print button at the bottom 

of the General Frequency Analysis editor.  When the print button is 

pressed, a window will appear giving the user options for how they would 

like the table to be printed. 

Graphical Output 

Graphical output of the analytical frequency curve can be obtained by 

selecting either the Plot tab under the analytical analysis tab, or by 

pressing the button labeled Plot Analytical Curve at the bottom of the 

general frequency editor.  When the Plot Analytical Curve button is 

pressed, a frequency curve plot will appear in a separate window as shown 

in Figure 6-9. 
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Figure 6-9.  Analytical Analysis Frequency Curve Plot. 

 

The analytical frequency curve plot can be sent to the printer by selecting 

the Print option from the File menu at the top of the window.  Additional 

printing options available from the File menu are Page Setup, Print 

Preview, and Print Multiple (used for printing multiple graphs on the same 

page).  The graphic can also be sent to the Windows Clipboard by 

selecting Copy to Clipboard from the File menu.  Additionally, the plot 

can be saved to a file by selecting the Save As option from the File menu.   

When the Save As option is selected, a window will appear allowing the 

user to select a directory, enter a filename, and select the format for saving 

the file.  Currently four file formats are available for saving the graphic to 

disk: windows metafile, postscript, JPEG, and portable network graphic.   

The data contained within the plot can also be tabulated by selecting 

Tabulate from the File menu.  When this option is selected, a separate 

window will appear with the data tabulated.  Additional options are 

available from the File menu for saving the plot options as a template 

(Save Template) and applying previously saved templates to the current 

plot (Apply Template).   

The Edit menu contains several options for customizing the graphic.  

These options include Plot Properties, Configure Plot Layout, Default 

Line Styles, and Default Plot Properties.  Also, a shortcut menu will 

appear with further customizing options when the user right-clicks on a 



HEC-SSP User's Manual Chapter 6 - Performing a General Frequency Analysis 

 

 6-23 

line on the graph or the legend.  Both the Y and X-axis properties can be 

edited by placing the mouse on top of axis and clicking the right mouse 

button.  Then select the Edit Properties menu option in the shortcut 

menu.  For example, the user can turn on minor tic marks for the y-axis 

and modify the minimum and maximum scale for the x-axis.  The graphic 

customizing capabilities within HEC-SSP are very powerful, but are also 

somewhat complex to use.  The code used in developing the plots in HEC-

SSP is the same code that is used for developing plots in HEC-DSSVue 

and several other HEC software programs.  Please refer to the HEC-

DSSVue User’s Manual for details on customizing plots. 

A plot of the graphical frequency curve can be obtained by pressing either 

the Graphical tab, or by pressing the button labeled Plot Graphical 

Curve at the bottom of the general frequency editor.  When the Plot 

Graphical Curve button is pressed, a frequency curve plot will appear in a 

separate window as shown in Figure 6-10.  All of the same options for 

tabulating, printing, and sending results to the windows clipboard are 

available for this plot as they are for the analytical frequency curve plot. 

 
Figure 6-10.  Graphical Analysis Frequency Curve Plot. 
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Viewing the Report File 

When the General Frequency analysis computations are performed, a 

report file of the statistical computations is created.  The report file lists all 

of the input data and user settings, plotting positions of the data points, 

intermediate results, each of the various statistical tests performed (i.e. 

high and low outliers, historical data, etc…), and the final results.  This 

file is often useful for understanding and describing how the software 

arrived at the final frequency curve.   

To view the report file press the View Report button at the bottom of the 

General Frequency analysis editor.  When this button is pressed, a window 

will appear containing the report as shown in Figure 6-11. 
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Figure 6-11.  General Frequency Analysis Report File. 

 

Plots, tables, and reports can also be created by selecting menu options 

from the Results menu.  At least one General Frequency analysis must be 

selected in the study explorer before selecting one of the menu options on 

the Results menu.  Results from multiple analyses are combined in one 

graph if they are selected in the study explorer when the Graph menu 

option is selected.  The ResultsSummary Report menu option will 

create a summary table of statistics and frequency curve ordinates for the 

selected analyses as shown in Figure 6-12.  
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Figure 6-12.  Summary Table for Selected General Frequency Analyses. 
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CHAPTER  7  

Performing a Volume Frequency 

Analysis 

The current version of HEC-SSP allows the user to perform a volume 

frequency analysis of flow data.  In this type of analysis, frequency curves 

are developed using daily average flows.  Runoff volumes are expressed 

as average flows over a time duration.  For example, the 3-day flow is the 

average flow over a three day period.  The volume from the 3-day flow 

would be computed by multiplying the 3-day flow (in cfs) by 259,200 

seconds (3-days).  Typical volume frequency analyses would develop 

frequency curves for a number of volumes (flow-duration), like the 1, 3, 7, 

15, 30, 60, 90, 120, and 180 day volumes.  The user can choose between 

different analytical distributions as well as perform a graphical fit to the 

data.  This chapter discusses in detail how to use the Volume Frequency 

Analysis editor in HEC-SSP. 

Contents 

 Starting a New Volume Frequency Analysis 

 General Settings and Options 

 Extracting the Volume-Duration Data 

 Analytical Frequency Analysis 

 Graphical Frequency Analysis 

 Viewing and Printing Results 
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Starting a New Volume Frequency Analysis 

A volume frequency analysis can be started in two ways within the 

software, either by right clicking on the Volume Frequency Analysis 

folder in the study explorer and selecting New, or by going to the Analysis 

menu and selecting New and then Volume-Frequency Analysis.  When a 

new volume frequency analysis is selected, the Volume Frequency 

Analysis editor will appear as shown in Figure 7-1. 

 

Figure 7-1.  Volume Frequency Analysis Editor. 

 

The user is required to enter a Name for the analysis; while a Description 

is optional.  A data set must be selected from the available data sets stored 

in the current study DSS file (see Chapter 4 for importing daily flow data 

into the study).  The list of data that can be selected for a volume 

frequency analysis will only include those data that have a regular interval, 

like 1HOUR and 1DAY (E-part pathname).  Once a Name is entered and 

a data set is selected, the DSS File Name and Report File will 

automatically be filled out.  The DSS filename is by default the same 
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name as the study DSS file.  The report file is given the same name as the 

analysis with the extension ".rpt".  

General Settings and Options 

Once the analysis name and data set are selected, the user can begin 

defining the analysis.  Five tabs are contained on the Volume Frequency 

Analysis editor.  The tabs are labeled General, Options, Duration Table, 

Analytical, and Graphical.  This section of the manual explains the use of 

the General and Options tabs.  

General Settings 

The first tab contains general settings for performing the frequency 

analysis (Figure 7-1).  These settings include: 

 Log Transforms 

 Plotting Positions 

 Maximum or Minimum Analysis 

 Year Specification 

 Time Window Modification 

Log Transform 

There are two options contained within the Log Transform setting: Use 

Log Transform and Do not use Log 

Transform.  If the user selects Use Log 

Transform, then the logs of the data 

will be computed first, and the frequency 

analysis will be performed on the logs of 

the data.  If the user selects Do not use 

Log Transform, then the frequency analysis will be performed on the raw 

data values without taking the logs of the data.  The default setting is Use 

Log Transform. 

  



Chapter 7 - Performing a Volume Frequency Analysis HEC-SSP User's Manual 

 

7-4 

Plotting Positions 

Plotting positions are used for plotting the raw data points on the graph.  

There are four options for 

plotting position within 

HEC-SSP: Weibull, 

Median, Hazen, and user 

entered coefficients.  The 

default method is the 

Weibull plotting position 

method.   

The generalized plotting 

position equation is: 

)1(

)(

BAn

Am
P




  

where: m = rank of 

flood values with the 

largest equal to 1. 

  n = number of flood peaks in the data set. 

A & B = constants dependent on which equation is used (Weibull 

A and B=0; Median A and B = 0.3; and Hazen A and 

B=0.5). 

Plotting positions are estimates of the exceedance probability for each data 

point.  Different methods can give different values for the probabilities of 

the highest and lowest points in the data set.  The plotting of data on the 

graph by a plotting position method is only done as a guide to assist in 

evaluating the computed curve.  The plotting position method selected 

does not have any impact on the computed curve. 
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Maximum or Minimum Analysis 

A volume frequency analysis can be performed using annual maximum or 

minimum flows.  A maximum flow analysis could be used for determining 

the amount of reservoir storage required for a flood of specific frequency.  

A minimum flow, or low flow 

analysis, could be used determine 

if a river could supply a given 

demand.  A low flow analysis 

could also be beneficial for water 

quality and reservoir storage 

projects. There are two options 

contained in the Maximum or Minimum Analysis section.  If Analyze 

Maximums is selected, then the program will extract annual maximum 

volumes for all durations.  The program will extract annual minimum 

volumes for all durations if Analyze Minimums is selected.  

Year Specification 

This option allows the user to define the beginning and ending date for 

what will be considered as the analysis year for extracting the data.  These 

dates are used for extracting the annual maximum or minimum flows, in 

order to get one value for each analysis year.  It is important to choose a 

start date that captures all flood events from a certain hydrologic regime.  

If high flows generally occur between November and May, then the year 

should not start between 

these months.   This will 

minimize the possibility 

that the same flood event 

is used for consecutive 

years.  There are three 

options contained in the 

Year Specification 

section.   If Water Year 

is selected, the program 

uses a starting date of 

October 1 and an ending 

date of September 30.  If 

Calendar Year is selected, the program uses a starting date of January 1 

and an ending date of December 31.  The Other option lets the user define 

the starting date.  One way to determine when the year should begin is to 

plot each year of record on top of one another, as shown in Figure 7-2.  

The program will create a graph like the one shown in Figure 7-2 when the 

Plot Yearly Data button is pressed.  This data set is from an area that 

experiences both snowmelt floods and summer/fall rain floods.  Starting 
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the year on January 1 would be more appropriate for this data set because 

a few large flood events occurred around October 1.                

   
Figure 7-2.  Plot Showing when Flood Events Typically Occur. 

 

Time Window Modification 

This option allows the user to narrow the time window used for the 

analysis.  When left unchecked, the program will use all of the data 

contained in the selected data set.  The user can enter either a start or end 

date or both a start and end date.  If a start and/or end date are used, they 

must be dates that are included within the selected data set.  The date 

range for the selected data set is shown in the editor just above the Start 

Date field.    

An additional option at the bottom of the time window modification 

section allows the user to define a shorter duration, a Season, within the 

year in which the program extracts maximum or minimum flows.  This 

option allows the user to analyze floods that typically occur during a 
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specific season, like snowmelt floods.  When left unchecked, the program 

will examine all flow records during the year.  The season start and end 

dates must be entered using a two digit day followed by the month, 

example 15May.  The season start and end dates must fall within a year as 

defined in the Year Specification.  The user must enter both start and end 

dates to define the season subset. 

 

Options 

In addition to the general settings, there are also several options available 

to the user for modifying the computation of the volume-frequency curves.  

These options include:  

 Flow-durations 

 User-Specified Frequency Ordinates 

 Output Labeling 

 Low Outlier Threshold 

 Historic Period Data 

When the Options tab is selected, the Volume Frequency Analysis editor 

will appear as shown in Figure 7-3. 
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Figure 7-3.  Volume Frequency Analysis Editor with Options Tab Selected. 

                                         

Flow-Durations 

This option lets the user define which durations are used in the volume 

frequency analysis.  The program will extract annual maximum or 

minimum volumes based on the durations defined in this table.  The 

default durations are 1, 3, 7, 15, 30, 60, 120, and 

183 days.  Check the box next to Change or 

add to default values to change or add 

additional durations to the analysis.  Once this 

box is checked, the user can add/remove rows 

and edit the duration values.  To add or remove 

a row from the table, select the row(s), place the 

mouse over the highlighted row(s) and click the 

right mouse button.  The shortcut menu contains 

options to Insert Row(s) and Delete Row(s).  

The program will use the default durations, even 

if they are not contained in the table, when the 

Change or add to default values option is not 

checked.   
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User Specified Frequency Ordinates 

 This option allows the user to change the frequency ordinates used for 

creating result tables and graphs.  The default 

values listed in percent chance exceedance are 0.2, 

0.5, 1, 2, 5, 10, 20, 50, 80, 90, 95, and 99.  Check 

the box next to Use Values from Table below to 

change or add additional values.  Once this box is 

checked, the user can add/remove rows and edit 

the frequency values.  To add or remove a row 

from the table, select the row(s), place the mouse 

over the highlighted row(s) and click the right 

mouse button.  The shortcut menu contains 

options to Insert Row(s) and Delete Row(s).  The 

program will use the default values, even if they 

are not contained in the table, when the Use 

Values from Table below option is not checked.  

Finally, all values in the table must be between 0 

and 100. 
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Output Labeling 

This option allows the user to change the default labels for data contained 

in the output tables and plots.  The user can change both the name of the 

data and how the units of the data are labeled.   

 

 

Low Outlier Threshold 

High and low outlier tests are based on the procedures outlined in Bulletin 

17B, and are applied in the same manner in the Volume Frequency 

Analysis.  The 

outlier 

magnitudes 

calculated by 

the Bulletin 

17B procedure 

are used as 

default values 

for the high 

and low outlier thresholds in HEC-SSP.  The user has the option to enter a 

different low outlier threshold for each duration.  If a value is entered for 

the low outlier threshold, then this value will override the computed value 

from the Bulletin 17B methodology.  When analyzing maximum flows, 

HEC-SSP will identify both high and low outliers.  However, only low 

outliers will be removed from the data set when performing the analysis.  

If a high outlier is identified in the data set, the analyst should try to 

incorporate historical period information to extend the time period for 

which the high outlier(s) is considered to be the maximum value(s).  

Further discussion of outlier thresholds can be found in Bulletin 17B and 

the HEC-SSP Statistical Reference Guide.  To use the low outlier 

threshold, simply check the box and enter a value for one duration or all 

durations.   

When Analyzing Minimums is selected on the General tab, then the Low 

Outlier Threshold criteria becomes the High Outlier Threshold.  When 

applying the outlier tests, HEC-SSP will identify both high and low 
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outliers.  However, only high outliers will be removed from the data set 

when performing the analysis.  If a low outlier is identified in the data set, 

the analyst should try to incorporate historical period information to 

extend the time period for which the low outlier(s) is considered to be the 

minimum value(s).   

Historic Period Data 

All historic data that provides reliable estimates outside the systematic 

record should be used in order to improve the frequency computations.  

Information outside of the systematic record can often be used to extend 

the record of the largest events to a historic period much longer than that 

of the systematic record.  HEC-SSP uses historic data as recommended in 

Bulletin 17B. This calculation is applied in the same manner in the 

Volume Frequency Analysis.  To use historic data, check the box labeled 

Use Historic Data.  The user can enter a starting year for the historic 

period, ending year for a historic period and a High Threshold value for 

each duration as shown in Figure 7-4.  If the user enters a high threshold 

value, then any data in the systematic record greater than that value will 

also be treated as a historical annual maximum.  The user can also enter 

historic data that are not contained in the systematic record.  This is done 

in the table at the bottom labeled Historic Events.  If a start year is not 

entered, then the assumed start year is the earliest year of the systematic 

record and any historical values that have been entered.  If an end year is 

not entered, then the assumed end year is the latest year in the systematic 

record and any entered historic values.  Further discussion of the use of 

historical data can be found in Bulletin 17B.  If Analyze Minimums is 

selected on the General tab then the High Threshold becomes the Low 

Threshold.  The program will treat systematic values that are lower than 

the low threshold as historic annual minimums.  

Note:  The program treats all data in the data set as systematic data.  If 

historic events are included in the data set, then the user can define the 

analysis time window (General tab – Time Window Modification) so that 

it only bounds the systematic record.  Then define the historic events in 

the Historic Events table.  Instead of using the Time Window Modification 

option, another option is to enter a High Threshold value so that the 

historic data point(s) would be treated as historic data (rather than part of 

the systematic record).   
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Figure 7-4.  Historic Period Data on the Options Tab. 

Extracting the Volume-Duration Data 

The user can extract the volume-duration data once settings have been 

defined on the General and Options tabs.  When the Duration Table tab is 

selected, the Volume Frequency Analysis editor will appear as shown in 

Figure 7-5.  The program will compute the annual maximum or minimum 

average flows for the durations specified on the Options tab when the user 

presses the Extract Volume-Duration Data button at the bottom of the 

Duration Table.   

The program computes the maximum/minimum flows by evaluating the 

flow record as one continuous record.  For each duration, the program 

computes a time-series of average flow.  These time-series are written to 

the study DSS file and can be viewed using HEC-DSSVue.  Then the 

program extracts the annual maximum/minimum flows and populates the 

duration table.  A similar procedure is followed when a Season has been 

defined within the Time Window Modification panel.  The program will 

only extract the annual maximum from within the season. 
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The Allow Editing checkbox in the upper left portion of the Duration 

Table tab allows the user to manually edit values in the volume-duration 

table.  The table becomes editable when the Allow Editing box is 

checked.  Then the user can overwrite the extracted volume-duration data.  

In addition, the program will no longer extract volume-duration data 

during a compute and the Extract Volume-Duration Data button 

becomes inactive.    

When computing the analysis, the program will issue a warning message if 

any of the maximum/minimum flows occur a specific number of days 

after the beginning of the year.  The number of days is determined by the 

duration plus five days.  For example, for a fifteen-day duration, the 

program issues a warning if the maximum/minimum is within twenty days 

after the beginning of the year.  If water year is chosen, then the program 

issues a warning if the maximum/minimum occurs between October 1 – 

October 20.  This warning is an attempt to let the user know if a maximum 

or minimum flow is generated by an event that began in the previous year.  

The goal is to prevent a scenario in which the same flow event causes 

maximum/minimum flows in consecutive years; this is why it is important 

to choose an appropriate annual starting date.  

 

Figure 7-5.  Volume-Duration Table. 
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The user must Compute the analysis before viewing a frequency plot of 

the volume-duration data.  The plot created by pressing the Plot Duration 

Data button, located at the bottom of a Volume Frequency Analysis 

editor, shows the annual maximum/minimum volumes plotted using the 

user specified plotting position method, as shown in Figure 7-6.   

 

 

Figure 7-6.  Plot of Volume-Duration Data.   

 

Analytical Frequency Analysis 

The user can choose between performing an Analytical Frequency 

Analysis or a Graphical Frequency Analysis once settings have been 

defined on the General and Options tabs.  The Duration Data does not 

have to be extracted before computing an analysis.  The program will 

automatically extract the duration data when the Compute button is 

pressed.  This section of the manual describes how to compute and view 

results for an Analytical Frequency Analysis. 

When the user selects the Analytical tab on the Volume Frequency 

Analysis editor, the window will appear as shown in Figure 7-7.  As 

shown, four additional tabs will appear on the screen: Settings, Tabular 

Results, Plot, and Statistics. 
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Figure 7-7.  Analytical Tab of the Volume Frequency Analysis Editor. 

 

Settings 

In addition to settings on the General and Options tabs, there are more 

options on the Settings tab the user must define in order to perform an 

Analytical Frequency analysis on the volume-duration data.  These 

settings include: 

 Distribution 

 Expected Probability Curve 

 Skew 

Distribution 

This option allows the user to select a distribution to perform the 

frequency analysis.  The current version of HEC-SSP contains five 

distribution choices: None, Normal, LogNormal, 

Pearson III, and LogPearson III.  If the user has 

selected the Use Log Transform option, located 

on the General tab, then the available choices for 

distribution are None, LogNormal, and 

LogPearson III.  If the user has selected the Do 

not use Log Transform option, located on the 

General tab, then the distribution choices are None, Normal, and Pearson 

III. 
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Expected Probability Curve 

This setting has two options, Compute Expected Prob. Curve and Do 

Not Compute Expected Prob. Curve.  The default setting is to have the 

expected probability curve computed.  When computed, the expected 

probability curves will be 

shown in the report that is 

opened by pressing the View 

Report button at the bottom of 

the Volume Frequency 

Analysis editor.  The expected 

probability curves are also saved to the study DSS file, along with the 

computed volume frequency curves and 5 and 95 percent confidence 

limits.  The expected probability adjustment is a correction for bias in the 

computed frequency curve.  The bias is caused by the skew in the 

uncertainty due to the shortness of the data record.  The Method of 

Moments estimation of the Log Pearson III parameters produces a median 

estimate of each frequency curve quantile, and the adjustment changes to a 

mean (unbiased) estimate, which is different from the median because of a 

skewed uncertainty distribution.  Please review the discussion in Bulletin 

17B about the expected probability curve adjustment for an explanation of 

how and why it is computed.  The use of the expected probability curve is 

a policy decision.  It is most often used in establishing design flood 

criteria.  The basic flood frequency curve without the expected probability 

adjustment is the curve used in computation of confidence limits, risk, and 

in obtaining weighted averages of independent estimates of flood 

frequency discharge (Interagency Advisory Committee on Water Data, 

1982). 
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Skew 

The skew option is only available whenever the analytical distribution is 

set to LogPearsonIII.  There are three options contained within the skew 

setting, Use Station 

Skew, Use 

Weighted Skew, and 

Use Regional Skew.  

The default skew 

setting is Use 

Station Skew.   With 

this setting, the skew 

of the computed 

curve will be based 

solely on computing 

a skew from the data 

points.   

The Use Weighted 

Skew option requires 

the user to enter a 

generalized regional 

skew and a mean-square error (MSE) of the generalized regional skew.  

This option weights the computed station skew with the generalized 

regional skew.   

The Use Regional Skew option requires the user to enter a generalized 

regional skew and a mean-square error (MSE) of the generalized regional 

skew.  The program will ignore the computed station skew and use only 

the generalized regional skew. 

Compute  

Press the Compute button, located at the bottom of the Volume Frequency 

Analysis editor, once options have been set on the 

General, Options, and Settings tabs.  If the compute is 

successful, the user will receive a message that says 

Compute Complete.  At this point, the user can review results from the 

analytical analysis by selecting the Tabular Results and Plot tabs. 

Multiple Volume Frequency analyses can be computed using the 

Compute Manager.  Select the AnalysisCompute Manager menu 

option to open the Compute Manager.  Select the analyses to be computed 

and then press the Compute button.  Close the compute dialogs and 

Compute Manager when the program finishes computing the analyses.  
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Tabular Results 

The Tabular Results tab contains a table of results for the analytical 

frequency analysis.  An example of the results table is shown in Figure 7-

8.  The top portion of this table contains the analytical frequency curves 

for each duration.  Data in the frequency curves can be re-sorted.  Click 

the Percent Chance Exceedance column header (two mouse clicks are 

required the first time).  The percent chance exceedance ordinates, along 

with the frequency curves, will sort so that the lowest values are on top or 

the highest values are on top.  The statistics of the analytical frequency 

curves are contained below the frequency curve ordinates.  The statistics 

include the mean, standard deviation, station skew, regional skew, 

weighted skew, adopted skew, number of years of record, and number of 

years with zero or missing flow.   

User-adjusted statistics can be defined by the user on the Statistics tab.  If 

the user has not entered statistics on the Statistics tab, then the results table 

will look similar to Figure 7-8.  If the user does enter statistics on the 

Statistics tab, then the results table will include the adjusted mean, 

adjusted standard deviation, and adjusted skew.  If specified by the user, 

the program will use the user-adjusted statistics when computing the 

analytical curves.  

 

Figure 7-8.  Tabular Results for a Volume Frequency Analysis. 
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Plot 

In addition to tabular results, a Plot tab is available for viewing results, as 

shown in Figure 7-9.  The results graph includes the systematic annual 

maximum/minimum volumes, plotted using the specified plotting position 

method, and the analytical frequency curves.  The analytical frequency 

curves are based on the computed statistics or user-adjusted statistics if 

they are defined on the Statistics tab.  

 

Figure 7-9.  Plot of Analytical Results for a Volume Frequency Analysis. 

 

Statistics 

As discussed in EM 1110-2-1415, a necessary step in a volume-frequency 

analysis is to make sure the analytical frequency curves are consistent 

across all durations (USACE, 1993).   In some situations, frequency 

curves from different durations might cross one another.  The Statistics 

tab contains tools allowing the user to modify the mean, standard 

deviation, and skew to make sure frequency curves do not cross one 

another.   

When the user selects the Statistics tab, the window will appear as shown 

in Figure 7-10.  The upper portion of the Statistics tab contains a plot of 

the computed and user-adjusted statistics.  The user has the option of 

choosing the parameter to be plotted in the comparison graph.  Computed 
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statistics are plotted as black data points and user-adjusted statistics are 

plotted as blue data points.  The first table, Sample Statistics, contains the 

statistics computed from the systematic data.  In addition, the adopted 

skew value in this table can be the station skew, weighted skew, or 

regional skew.  The adopted skew is set by the user on the Settings tab.  

The lower table is where the user enters the adjusted statistics.  Before 

entering adjusted statistics, the user must check the box in Column 1.  

User-adjusted statistics entered in this table are used when the program 

computes the analytical frequency curve. 

 

Figure 7-10.  Statistics Tab in the Volume Frequency Analysis Editor. 

 

Graphical Frequency Analysis 

In addition to an analytical frequency analysis, which uses a statistical 

distribution to fit the data, the user has the option to graphically fit a 

frequency curve to the data.  A graphical curve can be very useful when 

the available analytical distributions do not provide a good fit.  One 

example of when a graphical frequency analysis is more appropriate is 

when plotting a frequency curve for flow data that is downstream of a 

flood control reservoir.  Analytical frequency distributions are often not 

appropriate for fitting flow data that is significantly regulated by upstream 

reservoirs.  In general, a portion of the flow frequency data for a highly 
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regulated stream will be very flat in the zone in which upstream regulation 

can control the flow.  This type of data lends itself to a graphical fit.   

When the Graphical tab is selected on the Volume Frequency analysis 

editor, the window will appear as shown in Figure 7-11.  As indicated, two 

additional tabs will appear on the screen, Curve Input and Plot.   

 

Figure 7-11.  Graphical Curve Table for a Volume Frequency Analysis. 

 

Curve Input 

The user manually enters the frequency ordinates for all durations in the 

table on the Curve Input tab.  As previously mentioned, the number of 

frequency ordinates and durations are set on the Options tab.  The idea is 

to enter values in the table that will create a best fit line of the data, based 

on the user’s judgment.  Data entered in the graphical curve table will be 

plotted as a line in the graph on the Plot tab after the Compute button is 

pressed.  

Plot 

The graphical analysis Plot tab is available for viewing results, as shown 

in Figure 7-12.  The results graph includes the historic annual 

maximum/minimum flows, plotted using the specified plotting position 

method, and the user-defined graphical curve, which was entered in the 

table on the Curve Input tab. 
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Figure 7-12.  Plot Tab for a Graphical Analysis. 

 

Viewing and Printing Results – Volume Frequency 

Analysis 

The user can view output for the frequency analysis directly from the 

Volume Frequency Analysis editor (Tabular and Graphical output) or by 

using the plot and view report buttons at the bottom of the editor.  The 

output consists of tabular results, an analytical frequency curve plot, a 

graphical frequency curve plot, and a report documenting the data and 

computations performed. 

Tabular Output 

Once the computations for the analytical frequency analysis are 

completed, the user can view tabular output by opening the Tabular 

Results tab under the Analytical analysis tab.  The details of this table 

were discussed above.  The tabular results can be printed by using the 

Print button at the bottom of the Volume Frequency Analysis editor.  

When the print button is pressed, a window will appear, giving the user 

options for how the table is to be printed. 
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Graphical Output 

Graphical output can be opened by selecting one of the plot buttons at the 

bottom of the Volume Frequency Analysis editor or by selecting the Plot 

tab under the Analytical or Graphical tabs.  There are three plot buttons at 

the bottom of the Volume Frequency Analysis editor, Plot Duration Data, 

Plot Analytical Curve, and Plot Graphical Curve.  Pressing the Plot 

Duration Data button will open a new window containing a graph showing 

the systematic data plotted using the user-defined plotting position 

method.  Pressing the Plot Analytical Curve button will open a new 

window containing a graph with both the systematic data and the 

computed analytical frequency curves, as shown in Figure 7-13.  Pressing 

the Plot Graphical Curve button will open a new window containing a 

graph with both the systematic data and the user-defined frequency curves.  

 

Figure 7-13.  Plot of Systematic Data and Analytical Frequency Curves.  

 

All plots opened by selecting one of the plot buttons at the bottom of the 

Volume Frequency Analysis editor contain menu options for printing, 

editing, and saving the plots.   

Plots can be sent to the printer by selecting the Print option located on the 

File menu.  Additional printing options available from the File menu are 

Page Setup, Print Preview, and Print Multiple (used for printing multiple 

graphs on the same page).  The plot can also be sent to the Windows 

Clipboard by selecting Copy to Clipboard from the File menu.  

Additionally, the plot can be saved to a file by selecting the Save As 

option from the File menu.  When the Save As option is selected, a 
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window will appear allowing the user to select a directory, enter a 

filename, and select the format for saving the file.  Currently four file 

formats are available for saving the plot to disk: windows metafile, 

postscript, JPEG, and portable network graphic.  The data contained 

within the plot can also be tabulated by selecting Tabulate from the File 

menu.  When this option is selected, a separate window will appear with 

the data tabulated.  Additional options are available from the File menu for 

saving the plot properties as a template (Save Template) and applying 

previously saved templates to the current plot (Apply Template).   

The Edit menu contains several options for customizing the plot 

properties.  These options include Plot Properties, Configure Plot Layout, 

Default Line Styles, and Default Plot Properties.  Also, the user can right-

click on a line or data point in the plot area or in the legend and a shortcut 

menu will open with customization options.  Both the Y and X-axis 

properties can be edited by placing the mouse on top of axis and clicking 

the right mouse button.  Then select the Edit Properties menu option in 

the shortcut menu.  For example, the user can turn on minor tic marks for 

the y-axis and modify the minimum and maximum scale for the x-axis.  

The graphic customizing capabilities within HEC-SSP are very powerful, 

but are also somewhat complex to use.  The code used in developing the 

plots in HEC-SSP is the same code that is used for developing plots in 

HEC-DSSVue and several other HEC software programs.  Please refer to 

the HEC-DSSVue User’s Manual for details on customizing plots. 

Viewing the Report File 

Computational results for a volume frequency analysis are written to a 

report file.  The report file lists all of the input data and user settings, 

plotting positions of the data points, intermediate results, each of the 

various statistical tests performed (i.e. high and low outliers, historical 

data, etc…), and the final results.  This file is often useful for 

understanding how the software arrived at the final frequency curves.  

Press the View Report button at the bottom of the Volume Frequency 

Analysis editor to open the report, as shown in Figure 7-14. 
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Figure 7-14.  Volume Frequency Analysis Report. 
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Plots, tables and reports can also be created by selecting menu options 

from the Results menu.  At least one volume frequency analysis must be 

selected in the study explorer before selecting one of the menu options on 

the Results menu.  Results from multiple analyses are combined in one 

graph if they are selected in the study explorer when the Graph menu 

option is selected.  The ResultsSummary Report menu option will 

create a summary table of statistics and frequency curve ordinates for the 

selected analyses as shown in Figure 7-15.  

 
Figure 7-15.  Summary Table for a Volume Frequency Analysis. 
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CHAPTER  8  

Performing a Duration Analysis 

This chapter discusses in detail how to use the Duration Analysis editor in 

HEC-SSP.  A duration analysis can be performed on flow and stage data 

as well as other data types.  All regular interval data can be used in a 

duration analysis and an option is included to manually define a duration 

curve.   

Contents 

 Starting a New Analysis 

 General Settings and Options 

 Analytical Duration Analysis 

 Manual Analysis 

 Viewing and Printing Results 
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Starting a New Analysis 

A duration analysis can be started in two ways, either by right clicking on 

the Duration Analysis folder in the study explorer and selecting New, or 

by going to the Analysis menu and selecting New and then Duration 

Analysis.  When a new duration analysis is selected, the Duration 

Analysis editor will appear as shown in Figure 8-1. 

 

Figure 8-1.  Duration Analysis Editor. 

 

The user is required to enter a Name for the analysis, while a Description 

is optional.  A data set (flow, stage, or other) can be selected from the 

available data sets stored in the current study DSS file (see Chapter 4 for 

importing data into the study).  The list of data that can be selected for a 

duration analysis will only include those data that have a regular interval, 

like 1HOUR and 1DAY (E-part pathname).  Choose “None” for the Data 

Set when defining the duration curve manually on the Manual Entry tab.  

Once a Name is entered and a data set is selected, the DSS File Name and 

Report File will automatically be filled out.  The DSS filename is by 

default the study DSS file.  The report file is given the same name as the 

analysis with the extension ".rpt".   
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General Settings and Options 

Once the analysis name and data set are selected, the user can begin to 

perform the analysis.  Contained on the Duration Analysis editor are four 

tabs.  The tabs are labeled General, Options, Results, and Manual 

Entry.  This section of the manual explains the use of the General and 

Options tabs.  

General 

The first tab contains general settings for performing the duration analysis 

(Figure 8-1).  These settings include: 

 Method 

 X-Axis Scale 

 Y-Axis Scale 

 Time Window Modification 

 Duration Period 

Method 

This option allows the user to choose the Rank All Data Values or Bin 

(STATS) method for computing the duration 

analysis; the rank all data values method is the 

preferred choice.  This method computes the 

duration curve by sorting the data from largest 

to smallest, ranking the values from 1 to n, and 

using: )]1/([*100  nMP  where M is the 

ranked position and n is the number of events.  The Bin method uses a 

similar procedure as in the STATS program for computing the duration 

curve (U.S. Army Corps of Engineers, 1996).  The data is grouped into 

bins (classes) and the duration curve is computed using the number of data 

in each bin.         

X-Axis Scale 

This option allows the user to choose the scale of the x-axis.  The options 

are Linear and Probability.  This option will affect the x-axis scale in the 

duration curve plot and how the “interpolated” 

frequency curve is computed.   The program 

will use a probability scale when interpolating 

the final duration curve to the user specified 

exceedance ordinates. 
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Y-Axis Scale 

This option allows the user to choose the scale of the y-axis.  The options 

are Linear and Log.  This option will affect the y-axis scale in the 

duration curve plot, how the program computes 

evenly spaced bins when the Bin (Stats) method 

is selected, and how the “interpolated” frequency 

curve is computed.   One option for computing 

bins is to let the program define the bins at evenly 

spaced intervals between the minimum and 

maximum values from the selected data set.  When Log is set as the y-axis 

scale, the program will convert the minimum and maximum values to log 

space before computing the evenly spaced bin limits.  Also, the program 

will use log scale when interpolating the final duration curve to the user 

specified exceedance ordinates. 

Time Window Modification 

This option allows the user to narrow the time window used for the 

analysis.  The default is to use all of the data contained in the selected data 

set.   The user can 

enter either a start 

date and end date or 

both a start and end 

date.  If a start 

and/or end date are 

used, they must be 

dates that are 

contained within the data stored in the selected data set.  The date range 

for the selected data set is shown in the editor just above the Start Date 

field. 
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Duration Period 

This option allows the user to compute multiple duration curves for 

different time windows within the year.  If Annual is selected, then the 

program uses all the data when computing the duration curve.  If 

Quarterly is selected, then the program separates the data into quarters 

and computes a separate duration curve for each quarter.  For example, a 

duration curve for the 1st quarter includes all data measured from Jan 1 – 

March 31.  The program will compute a separate duration curve for each 

month of the year when the Monthly option is selected.  The User-

Defined option lets the user define one or multiple periods within the year.   

Then the program will perform the duration analysis using data only 

measured during the user-defined period(s).  

      

Options 

In addition to the general settings, there are also several options available 

to the user for modifying the computations of the duration curve.  These 

options include:  

 Output Labeling 

 Plotting Position Formula 

 User-Specified Exceedance Ordinates 

 Bin Limits 

When the Options tab is selected, the Duration Analysis editor will appear 

as shown in Figure 8-2. 
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Figure 8-2.  Duration Analysis Editor with Options Tab Selected. 

 

Output Labeling 

This option allows the user to change the default labels for data contained 

in the output tables and 

plots.   The user can 

change both the name of 

the data as well as the units 

of the data.  The output 

labeling does not result in 

the conversion of data from 

one unit system to another; 

it only affects what is 

displayed on table headings and the y-axis of the results plot.  
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Plotting Position Formula 

This option allows the user to choose how the 

duration curve is computed (this option is not 

available when the Bin method is selected).  

When Rank/(N+1) is selected the program 

will compute the duration curve using: 

)]1/([*100  nMP  where M is the ranked 

position and n is the number of events.  When Rank/N is selected the 

program will compute the duration curve using: ]/[*100 nMP   where M 

is the ranked position and n is the number of events. 

User-Specified Exceedance Ordinates 

This option allows the user to change the ordinates used in computing the 

resulting duration curves.  The default values listed in percent of time 

exceedance are 99, 

95, 90, 80, 50, 25, 

15, 10, 5, 2, 1, and 

0.1.  Check the box 

next to Change or 

add to default 

values to change or 

add additional 

values.  Once this 

box is checked, the 

user can add/remove 

rows and edit the 

ordinates.  To add or 

remove a row from 

the table, select the 

row(s), place the 

mouse over the 

highlighted row(s) 

and click the right mouse button.  The shortcut menu contains options to 

Insert Row(s) and Delete Row(s).  The program will use the default 

values, even if they are not contained in the table, when the Change or 

add to default values option is not checked.  Finally, all values in the 

table must be between 0 and 100. 

Bin Limits 

The Bin Limits panel is only active when the Bin (STATS) method is 

selected on the General tab.  This option helps the user to define the limits, 

the minimum and maximum values, for each bin.  There are two options; 

Evenly Spaced and User-Defined.  When Evenly Spaced is selected the 
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user must also enter the number of bins.  The Extract Bin Limits button 

will automatically populate the bin limits table by first extracting the 

minimum and maximum values from the data set and then linearly 

interpolating evenly spaced bin limits.  If Log is selected as the Y-axis 

scale on the General tab, then the program converts the minimum and 

maximum values to log space before computing the evenly spaced bin 

limits.  The User-Defined option lets the user manually enter the bin 

limits.  The user must ensure the minimum and maximum values from the 

data set are contained in the bin limits table.  For example, if the minimum 

flow from the data set is 100.0 then the first row in the table must be less 

than or equal to 100.0.  Additional rows can be added to the table.  Place 

the mouse pointer on top of the table and click the right mouse button.  

Then select the Insert Row(s)… menu option to open an editor for 

specifying the number of rows to insert into the table.       

 

Compute 

Once the new analysis has been defined, and the user has all of the 

General and Options information selected the way they want, performing 

the computations is simply a matter of pressing the 

Compute button at the bottom of the Duration Analysis 

editor.  If the computations are successful, the user will 

receive a message that says “Compute Complete”.  At this point, the user 

can begin to review the results. 

Multiple Duration analyses can be computed using the Compute 

Manager.  Select the AnalysisCompute Manager menu option to open 
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the Compute Manager.  Select the analyses to be computed and then press 

the Compute button.  Close the compute dialogs and Compute Manager 

when the program finished computing the analyses.  

Results 

This section of the manual describes results that are available for the 

Duration analysis.  When the user selects the Results tab on the Duration 

Analysis editor, the window will appear as shown in Figure 8-3.  As 

shown, two additional tabs will appear on the screen: Tabular Results 

and Plot. 

 
Figure 8-3.  Results Tab of the Duration Analysis Editor. 

 

Tabular Results 

The Tabular Results tab will bring up a table of results for the duration 

analysis.  The tabular results are different for the Rank All Data Values 

and Bin (STATS) methods.  An example of tabular results for a Rank All 

Data Values analysis is shown in Figure 8-3.  The results table will 
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contain multiple duration curves if the Quarterly, Monthly, or the User 

Defined options are selected as the Duration Period.  Data in the duration 

curve table can be re-sorted.  Click the Percent of Time Exceeded 

column header (two mouse clicks are required the first time).  The percent 

of time exceeded ordinates, along with the duration curve values, will sort 

so that the lowest values are on top or the highest values are on top.    

The tabular results tab will look different when the Bin (STATS) method 

is used to compute the duration analysis.  As shown in Figure 8-4, there 

are two tables.  The first table contains summary information about the 

bins and the second table contains the interpolated duration curve.  

 
Figure 8-4.  Results Tab for a Bin (STATS) analysis. 

 

Plot 

In addition to tabular results, a Plot tab is available for viewing a graphical 

plot of the duration curves.  When the Plot tab is selected the window will 

change to what is shown in Figure 8-5.  The plot contains the computed 

duration curve and the duration curve interpolated to the user-defined 

ordinates (defined on the Options tab).  Multiple duration curves will be 

graphed if the Quarterly, Monthly, or User Defined options are selected as 

the duration period. 



HEC-SSP User's Manual Chapter 8 - Performing a Duration Analysis 

 

 8-11 

 
Figure 8-5.  Plot Tab of the Duration Analysis. 

 

 

Manual Duration Analysis 

The user has the option to manually define a duration curve.  This option 

would be used when a duration curve has been computed outside of HEC-

SSP.  The “None” data set must be selected in order to define a duration 

curve manually.  When the Manual Entry tab is selected, the editor will 

display a plot and table as shown in Figure 8-6.  The table allows the user 

to enter data values for the percent of time exceedance ordinates defined 

on the Options tab.  When the user enters values in this table, those values 

will be plotted as a line on the plot after the Compute button is pressed.   
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Figure 8-6.  Manual Entry Tab of the Duration Analysis Editor. 

 

Viewing and Printing Results 

The user can view output for the duration analysis directly from the 

Duration Analysis editor (Tabular and Graphical output) or by using the 

buttons at the bottom of the editor.  Results can also be opened by 

selecting the duration analysis in the study explorer and then choosing the 

Graph, Table, or Report option available from the Results menu.  

Tabular Output 

Once the computations for the duration analysis are completed, the user 

can view tabular output by selecting the Tabular Results tab under the 

Results tab.  The details of this table were discussed above. 

The tabular results can be printed by using the Print button at the bottom 

of the Duration Analysis editor.  When the print button is pressed, a 

window will appear giving the user options for how they would like the 

table to be printed. 
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Graphical Output 

Graphical output of the duration curve can be obtained by selecting either 

the Plot tab under the results tab, or by pressing the button labeled Plot 

Duration Curve at the bottom of the Duration Analysis editor.  When the 

Plot Duration Curve button is pressed, a duration curve plot will appear in 

a separate window as shown in Figure 8-7. 

 
Figure 8-7.  Duration Curve Plot. 

 

The duration curve plot can be sent to the printer by selecting the Print 

option from the File menu at the top of the window.  Additional printing 

options available from the File menu are Page Setup, Print Preview, and 

Print Multiple (used for printing multiple graphs on the same page).  The 

graphic can also be sent to the Windows Clipboard by selecting Copy to 

Clipboard from the File menu.  Additionally, the plot can be saved to a 

file by selecting the Save As option from the File menu.   When the Save 

As option is selected, a window will appear allowing the user to select a 

directory, enter a filename, and select the format for saving the file.  
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Currently four file formats are available for saving the graphic to disk: 

windows metafile, postscript, JPEG, and portable network graphic. 

The data contained within the plot can also be tabulated by selecting 

Tabulate from the File menu.  When this option is selected, a separate 

window will appear with the data tabulated.  Additional options are 

available from the File menu for saving the plot options as a template 

(Save Template) and applying previously saved templates to the current 

plot (Apply Template).   

The Edit menu contains several options for customizing the graphic.  

These options include Plot Properties, Configure Plot Layout, Default 

Line Styles, and Default Plot Properties.  Also, a shortcut menu will 

appear with further customizing options when the user right-clicks on a 

line on the graph or the legend.  Both the Y and X-axis properties can be 

edited by placing the mouse on top of axis and clicking the right mouse 

button.  Then select the Edit Properties menu option in the shortcut 

menu.  For example, the user can turn on minor tic marks for the y-axis 

and modify the minimum and maximum scale for the x-axis.  The graphic 

customizing capabilities within HEC-SSP are very powerful, but are also 

somewhat complex to use.  The code used in developing the plots in HEC-

SSP is the same code that is used for developing plots in HEC-DSSVue 

and several other HEC software programs.  Please refer to the HEC-

DSSVue User’s Manual for details on customizing plots. 

Viewing the Report File 

A report file is created when the duration analysis computations are 

performed.  The report file contains information about the duration 

analysis and the final results.  To view the report file press the View 

Report button at the bottom of the Duration Analysis editor.  When this 

button is pressed, a window will appear containing the report as shown in 

Figure 8-8. 
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Figure 8-8.  Duration Analysis Report File. 
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CHAPTER  9  

Performing a Coincident Frequency 

Analysis 

This chapter discusses in detail how to use the Coincident Frequency 

Analysis editor in HEC-SSP.  A coincident frequency analysis can be 

performed on any data type; flow, stage, precipitation, wind, etc.  The 

coincident frequency analysis requires both duration and frequency 

curves.  These can be computed by existing analyses in the HEC-SSP 

study or they can be entered manually in the coincident frequency analysis 

editor.   

The Coincident Frequency Analysis is designed following guidelines in 

EM 1110-2-1415.  This analysis tool can be used to compute the 

exceedance frequency relationship for a variable that is a function of two 

other variables.  An example is illustrated in Figure 9-1.  In this example, 

the stage at the damage site on the tributary, variable C, is a function of 

stream flow from the tributary, variable A, and the stage in the mainstem 

river, variable B.      

 

 
Figure 9-1.  Example Application of the Coincident Frequency Analysis. 

The general procedure for performing a coincident frequency analysis, 

using HEC-SSP is described below.   

1) Develop a duration curve for variable B.  This can be done using the 

Duration Analysis editor or it can be defined manually in the 
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Coincident Frequency Analysis editor.  Then discretize the duration 

curve to determine index values for variable B.  The index values 

should be defined so that the area under the discretized duration curve 

approximates the original duration curve.  Figure 9-2 shows a flow 

duration curve that has been discretized using 9 index points.  The 

index points are taken at the midpoint of each discrete segment and 

there are more index points along the steeper portion of the duration 

curve.  The Coincident Frequency Analysis editor can be used to 

define the index points and to estimate the proportion of time for each 

index point.  For example, the 9th index point in Figure 9-2 is taken at 

the midpoint for the discrete segment from 100 to 60 percent of time 

exceeded.  The flow value at this point represents the variable B index 

occurring 40 percent of the time.  The 8th index point is taken at the 

midpoint for the discrete segment from 60 to 40 percent of time 

exceeded.  The flow value at this point represents the variable B index 

occurring 20 percent of the time.  The proportion of time assigned to 

each index point will be used to compute the variable C frequency 

curve. 

 
Figure 9-2.  Variable B Duration Curve Divided into Discrete Segments. 

 

   

2) Different procedures are required depending on whether variables A 

and B are independent or not independent of one another.  When 

variables A and B are assumed independent of one another, develop a 

frequency curve of variable A.  The frequency curve can come from an 

existing Bulletin 17 or General Frequency analysis or it can be defined 
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manually in the Coincident Frequency Analysis editor.  If variables A 

and B are not independent of one another, then develop a frequency 

curve of variable A for each variable B index value.  In this case, the 

variable A frequency curves must be defined manually in the 

Coincident Frequency Analysis editor.  This involves extracting 

annual peak values for variable A that occur for each discrete range 

identified on the variable B duration curve and performing a separate 

frequency analysis on each set of variable A data.  

3) Develop the response of variable C for combinations of variable A 

and variable B.  This could be done using a hydrologic or hydraulic 

model.  For the example shown in Figure 9-1, a flow value from the 

variable A frequency curve would be applied to the tributary and the 

index flow (or stage) from the variable B duration curve would be 

applied to the mainstem.  The hydrologic or hydraulic model would be 

used to compute the variable C stage at some reference point on the 

tributary.  This model simulation would be computed for many 

combinations of variable A and variable B.  Figure 9-3 shows example 

output from a hydraulic model.  The model was used to generate 

output from multiple combinations of variable A and B values.  In this 

example, there were 12 variable A values and 9 index values from 

variable B.  This resulted in 108 simulation results.  The table shown 

in Figure 9-3 is referred to as the Response Curves table in HEC-SSP 

and these values must be entered by the user.     

 

 
Figure 9-3.  Response of Variable C for Combinations of Variable A and 

Variable B. 

     

4) The program computes the variable C frequency curve by first using the 

response curves to compute conditional frequency curves of variable C.  
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This is done by assigning the same frequency from the variable A value 

to the corresponding variable C value.  Then for a selected value of 

variable C, the frequency value from each conditional frequency curve 

is multiplied by the corresponding proportion of time (probability) from 

the variable B index value.  The values are summed to obtain the 

frequency of the selected value of variable C.  This is done for a 

number of values of variable C until a complete frequency curve is 

created.  

Contents 

 Starting a New Analysis 

 General Settings  

 Variable A 

 Variable B 

 Response Curves 

 Viewing and Printing Results 

Starting a New Analysis 

A coincident frequency analysis can be started in two ways, either by right 

clicking on the Coincident Frequency Analysis folder in the study explorer 

and selecting New, or by going to the Analysis menu and selecting New 

and then Coincident Frequency Analysis.  When a new coincident 

frequency analysis is selected, the Coincident Frequency Analysis editor 

will appear as shown in Figure 9-4. 
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Figure 9-4.  Coincident Frequency Analysis Editor. 

 

The user is required to enter a Name for the analysis, while a Description 

is optional.  Once a Name is entered, the DSS File Name and Report File 

will automatically be filled out.  The DSS filename is by default the study 

DSS file.  The report file is given the same name as the analysis with the 

extension ".rpt".   

General Settings 

Once the analysis name has been entered, the user can begin to perform 

the computations.  Contained on the Coincident Frequency Analysis editor 

are five tabs.  The tabs are labeled General, Variable A, Variable B, 

Response Curves, and Results.  The first tab contains general settings for 

performing the coincident frequency analysis (Figure 9-4).  These settings 

include: 

 Variable A 

 Variable B 

 Output Labeling 

 Y-Axis Scale 

 User Specified Frequency Ordinates 
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Variable A 

This option allows the user to choose whether the coincident frequency 

analysis assumes variables A and B are independent or dependent.  When 

variables A and B can be assumed independent, there will be only one 

frequency curve for variable A.  A conditional variable A frequency curve 

assumes variables A and B are not independent, so there will be a separate 

variable A frequency curve for each variable B index value.  

 

Variable B 

This option allows the user to define the number of index values for 

variable B.  The index points are used to discretize the duration curve.  A 

probability, or a proportion of time, will be assigned to each index point.     

 

Output Labeling 

This option allows the user to enter labels for data contained in the output 

tables and plots.   The 

user must enter the 

name of the data as 

well as the data units.  

The output labeling 

does not result in the 

conversion of data 

from one unit system to another; it only affects what is displayed on table 

headings and the y-axis of the results plot.  

Y-Axis Scale 

This option allows the user to choose the scale of the y-axis.  The options 

are Linear and Log.  This option will affect the 

y-axis scale in the coincident frequency curve 

plot. 
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User Specified Frequency Ordinates 

 This option allows the user to change the 

frequency ordinates used for creating result tables 

and graphs.  The default values listed in percent 

chance exceedance are 0.2, 0.5, 1, 2, 5, 10, 20, 50, 

80, 90, 95, and 99.  Check the box next to Use 

Values from Table below to change or add 

additional values.  Once this box is checked, the 

user can add/remove rows and edit the frequency 

values.  To add or remove a row from the table, 

select the row(s), place the mouse over the 

highlighted row(s) and click the right mouse 

button.  The shortcut menu contains options to 

Insert Row(s) and Delete Row(s).  The program 

will use the default values, even if they are not 

contained in the table, when the Use Values from 

Table below option is not checked.  Finally, all 

values in the table must be between 0 and 100. 

Variable A 

The Variable A tab is used to define the frequency curve for variable A.  

This tab will look different based on the user’s selection on the General 

Tab.  The Variable A tab will look like Figure 9-5 when “A and B can be 

Assumed Independent” is selected on the General tab.  Since variables A 

and B are independent, there will only be one frequency curve for variable 

A.    

As shown in Figure 9-5, the user can choose to define the curve manually 

or select an existing study analysis.  When the Manual Entry option is 

selected, the user must define the Data Name and Data Units.  Then the 

user must enter the frequency curve for variable A.  A frequency curve 

value must be defined for each percent chance exceedance ordinate in the 

table.  When the Existing Study Analysis option is selected, the 

dropdown list will be active and the user can choose any Bulletin 17B or 

General Frequency analysis in the HEC-SSP study.  The variable A 

frequency curve table will be populated with the frequency curve when an 

analysis is selected.  The program uses the statistics from the selected 

analysis and computes the frequency curve that populates the table.   
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Figure 9-5.  Variable A Tab when Variable A and B are Independent. 

 

The Variable A tab will look like Figure 9-6 when “A and B can not be 

Assumed Independent” is selected on the General tab.  A conditional 

variable A frequency curve assumes variables A and B are not 

independent, so there will be a separate variable A frequency curve for 

each variable B index value.  

As shown in Figure 9-6, the user must define the Data Name and Data 

Units.  Then the user must manually enter the variable A frequency curve 

for each index value of variable B.  This involves extracting the annual 

peak values for variable A that occur for each discrete range identified on 

the variable B duration curve and performing a separate frequency 

analysis on each set of variable A data.  Also, a frequency curve value 

must be defined for each Percent Chance Exceedance ordinate in the table.   
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Figure 9-6.  Variable A Tab when Variable A and B are not Independent. 

 

Press the Plot button located at the lower left corner of the Variable A tab 

to open a plot of the variable A frequency curve(s).  

Variable B 

The Variable B tab is used to define the duration curve for variable B and 

the index points with an associated probability.  The index points will be 

used by the user when developing the response curves (response of 

variable C to each combination of variables A and B).  The associated 

probability represents the proportion of time that each index point can be 

expected to occur.    

As shown in Figure 9-7, the left side of the variable B tab is used to select 

the duration curve from an existing Duration Curve analysis.  Once 

selected, the program populates the duration curve table. Press the Plot 

button located at the lower left corner of the Variable B tab to open a plot 

of the variable B duration curve.   
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Figure 9-7.  Variable B Tab. 

 

After the duration curve has been selected, the right side of the variable B 

tab is used to define the index points and associated probabilities used to 

discretize the duration curve.  The number of index points is defined on 

the General tab and is included on the Variable B tab to let the user know 

how many index points must be defined in the table.  There are 4 methods 

for defining the index values and the associated probabilities.  The user 

selects one of the methods, edits the table, and then clicks the Generate 

Table button in order for the program to finish populating the table.  The 

following text describes each method.       

Define Automatically.  The program will use a predefined pattern of 

probability ranges when this option is selected, as contained in Table 9-1, 

to populate the Probability column.  The pattern is dependent on the 

number of index points and the default probability patterns do not extend 

beyond nine index points.  If more than nine index points have been 

selected for the analysis, then use one of the other methods for defining 

the index points and associated probabilities.  The program will compute 

the Index and Break Point columns when the Generate Table button is 

pressed.  The Break Point column is computed using the probability 

pattern.  The first row in this column is always 100.  The second break 

point is computed by subtracting the first probability value from the first 

break point value.  The third break point is computed by subtracting the 

second probability value from the second break point value.  This 

procedure is followed until the last break point is computed; it should 

always have a value of 0.  The Index values are taken from the duration 

curve at the midpoint between each break point range.  For example, if the 
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first break point was 100 and the second was 60 then the first Index value 

would be the value from the duration curve at 80 percent time exceeded.  

 

Table 9-1.  Default Probability Patterns.  

 Number of Index Points 

Index 3 4 5 6 7 8 9 

1 20 15 45 35 35 35 40 

2 60 35 40 30 25 20 20 

3 10 35 10 20 20 15 15 

4  15 4 10 10 10 10 

5   1 4 6 10 5 

6    1 3 6 4 

7     1 3 3 

8      1 3 

9       1 

    

Define from Index Points.  The number of rows is set by the number of 

index points.  In this case, the Index column is edited by the user; the user 

must enter an index value in each row.  When the Generate Table button 

is pressed, the program will compute the Break Point and the Probability 

values.  First, the program will use the selected duration curve and 

interpolate a percent of time exceeded for each user-defined index value.  

Then break points are computed so that they are half way between the 

percent of time exceeded values (the first and last break points will be 100 

and 0).  The probability values are computed based on the break points.  

For example, the first probability value is computed by subtracting the 

second break point value from the first.  The second probability value is 

computed by subtracting the third break point value from the second.  This 

procedure is followed until the last probability value is computed.    

Define from Probabilities.  The number of rows is set by the number of 

index points.  In this case, the Probability column is edited by the user; 

the user must enter a probability value in each row (the probability values 

should add up to 100).  When the Generate Table button is pressed, the 

Break Point column is computed using the user-entered probability 

pattern.  For example, the first row in the break point column is 100; 

therefore, the second break point is computed by subtracting the first 

probability value from the first break point value.  The third break point is 

computed by subtracting the second probability value from the second 

break point value.  This procedure is followed until the last break point is 

computed; it should always have a value of 0.  The Index values are taken 

from the duration curve at the midpoint between each break point range.  

For example, if the first break point was 100 and the second was 60 then 
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the first Index value would be the value from the duration curve at 80 

percent time exceeded.  

User-Specified Index Points and Probability Ranges.  This option can 

only be selected when the user does not select an existing Duration Curve 

to import.  This would be applicable for the case where the user developed 

the duration curve outside of HEC-SSP and developed the index points 

and associated probabilities.  As shown in Figure 9-8, the user must 

specify both the Probability and Index values; the user must enter values 

in each row.  When the Generate Table button is pressed, the Break 

Point column is computed using the user-entered probability pattern.  For 

example, the first row in the break point column is 100; therefore, the 

second break point is computed by subtracting the first probability value 

from the first break point value.  The third break point is computed by 

subtracting the second probability value from the second break point 

value.  This procedure is followed until the last break point is computed; it 

should always have a value of 0.      

 
Figure 9-8.  User-Specified Option to Define Index Points and Probability 

Ranges. 

 

Response Curves 

The Response Curves tab is used to define the response of variable C to 

each combination of variable A and variable B.  This analysis is 

performed outside of HEC-SSP.  For example, a hydraulics model could 

be used to apply flow values from the variable A frequency curve to the 

tributary and the index flow (or stage) from the variable B duration curve 
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would be applied to the mainstem.  The hydraulics model would be used 

to compute the variable C stage at some reference point on the tributary 

for multiple combinations of variable A and variable B.  The peak variable 

C stage is the value to input into the Response Curves table.    

As shown in Figure 9-9, there are two options for the Response Curves 

table; Same Variable A for each index or Different Variable A for each 

index.  When the Same Variable A for each index option is selected, 

there is only one Variable A column in the response curves table.  The 

user can manually fill in the values for Variable A or press the Import 

Variable A button.  When the button is pressed, the program will import 

the values on the Variable A tab.  The user can edit the Variable A values 

after they are imported.  When the Different Variable A for each index 

option is selected, there is a separate Variable A column for each variable 

B index value, as shown in Figure 9-10.  The user can manually fill in the 

values for Variable A or press the Import Variable A button.  When the 

button is pressed, the program will import the values from the Variable A 

tab.  The user can edit the Variable A values after they are imported.  In 

most cases, the Different Variable A for each index options will be used 

when performing a conditional analysis (variables A and B can not be 

assumed independent).  In this case, a separated variable A frequency 

curve was defined for each variable B index value; therefore, when the 

Import Variable A button is pressed the program will import the 

corresponding frequency curve into the response curves table.        

The user must compute the variable C value given the combinations of 

variables A and B.  Figure 9-9 contains 12 values of variable A and 9 

index values for variable B.  Therefore, the user would have 108 

combinations of variables A and B to compute values of variable C.  Once 

computed, the user would manually enter the variable C values into the 

response curves table.  For example, the first value in the first variable C 

column in Figure 9-9 is 481.38.  This was computed using a variable A 

value of 66039 and a variable B value of 3005.92.   

The Plot Response Surface button will open a plot similar to the one 

shown in Figure 9-11.  Each line in the response surface plot shows the 

variable C versus variable A relationship for a given variable B index 

value.  
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Figure 9-9.  Response Curves Tab for Same Variable A for Each Variable B 

Index. 

 

 
Figure 9-10.  Response Curves Tab for Different Variable A for Each Variable B 

Index. 
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Figure 9-11.  Plot of Response Curves. 

 

Compute 

Once the new analysis has been defined, and the user has all of the 

information defined on the General, Variable A, Variable B, Response 

Curves tabs, performing the computations is simply a matter of pressing 

the Compute button at the bottom of the Coincident Frequency Analysis 

editor.  If the computations are successful, the user will receive a 

message that says “Compute Complete”.  At this point, the user can begin 

to review the results. 

The following describes how the variable C coincident frequency curve is 

computed.  

1) The program uses the variable A frequency curve(s) and the variable A 

values in the response curves table to assign a frequency of 

exceedance to each variable C value in the response curves table.   

2) The program finds the minimum and maximum values of variable C in 

the response curves table. 

3) The program defines 100 evenly spaced values of variable C in-

between the minimum and maximum values (100 values include the 

minimum and maximum values).  
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4) For each variable C from step 3, the program will look-up the 

exceedance frequency value from each response curve in step 1 and 

multiply by the corresponding proportion of time (using the 

probability defined on the Variable B tab) obtained from the variable 

B index value.  These “weighted” values from each response curve are 

summed to compute the variable C frequency curve.  

5) The curve is interpolated to the selected exceedance ordinates defined 

on the General tab.  

Multiple coincident frequency analyses can be computed using the 

Compute Manager.  Select the AnalysisCompute Manager menu 

option to open the Compute Manager.  Select the analyses to be computed 

and then press the Compute button.  Close the compute dialogs and 

Compute Manager when the program finishes computing the analyses.  

Results 

This section of the manual describes results that are available for the 

Coincident Frequency analysis.  When the user selects the Results tab on 

the Coincident Frequency Analysis editor, the window will appear as 

shown in Figure 9-12.  Both tabular and graphical results are included.  

The percent chance exceedance ordinates are the same as those defined on 

the General tab.  In addition, the Data Name and Data Units defined on the 

General tab are used in the column header in the results table and the y-

axis label in the plot.  

 
Figure 9-12.  Results Tab of the Coincident Frequency Analysis Editor. 
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By pressing the Plot Condition Frequency Curves, the user can plot the 

response curves entered on the Response Curves tab along with the 

computed curve and the upper and lower accurate limits. 

 

 
Figure 9-13.  Plot of Conditional Frequency Curves. 

 

Data in the frequency curve table can be re-sorted.  Click the Percent 

Chance Exceedance column header (two mouse clicks are required the 

first time).  The percent chance exceedance ordinates, along with 

frequency values, will sort so that the lowest values are on top or the 

highest values are on top. 

Viewing and Printing Results 

The user can view output for the coincident frequency analysis directly 

from the Coincident Frequency Analysis editor (tabular and graphical 

output) or by using the buttons at the bottom of the editor.   
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Tabular Output 

Once the computations for the coincident frequency analysis are 

completed, the user can view tabular output by selecting the Results tab.  

The tabular results can be printed by using the Print button at the bottom 

of the coincident frequency analysis editor.  When the print button is 

pressed, a window will appear giving the user options for how they would 

like the table to be printed.  Result tables can also be created from the 

Results menu.  At least one coincident frequency analysis must be 

selected in the study explorer before selecting the ResultsTable option.   

Graphical Output 

Graphical output of the coincident frequency analysis can be obtained by 

selecting either the Results tab, or by pressing the Plot button at the 

bottom of the coincident frequency analysis editor.  When the Plot button 

is pressed, a frequency curve plot will appear in a separate window as 

shown in Figure 9-14.  Result graphs can also be created from the Results 

menu.  At least one coincident frequency analysis must be selected in the 

study explorer before selecting the ResultsGraph option.  Results will 

be graphed in the same plot if multiple coincident frequency analyses are 

selected in the study explorer when opening a graph from the Results 

menu. 

The coincident frequency curve plot can be sent to the printer by selecting 

the Print option from the File menu at the top of the window.  Additional 

printing options available from the File menu are Page Setup, Print 

Preview, and Print Multiple (used for printing multiple graphs on the same 

page).  The graphic can also be sent to the Windows Clipboard by 

selecting Copy to Clipboard from the File menu.  Additionally, the plot 

can be saved to a file by selecting the Save As option from the File menu.   

When the Save As option is selected, a window will appear allowing the 

user to select a directory, enter a filename, and select the format for saving 

the file.  Currently four file formats are available for saving the graphic to 

disk: windows metafile, postscript, JPEG, and portable network graphic. 
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Figure 9-14.  Coincident Frequency Analysis Plot. 

 

The data contained within the plot can also be tabulated by selecting 

Tabulate from the File menu.  When this option is selected, a separate 

window will appear with the data tabulated.  Additional options are 

available from the File menu for saving the plot options as a template 

(Save Template) and applying previously saved templates to the current 

plot (Apply Template).   

The Edit menu contains several options for customizing the graphic.  

These options include Plot Properties, Configure Plot Layout, Default 

Line Styles, and Default Plot Properties.  Also, a shortcut menu will 

appear with further customizing options when the user right-clicks on a 

line on the graph or the legend.  Both the Y and X-axis properties can be 

edited by placing the mouse on top of axis and clicking the right mouse 

button.  Then select the Edit Properties menu option in the shortcut 

menu.  For example, the user can turn on minor tic marks for the y-axis 

and modify the minimum and maximum scale for the x-axis.  The graphic 

customizing capabilities within HEC-SSP are very powerful, but are also 

somewhat complex to use.  The code used in developing the plots in HEC-

SSP is the same code that is used for developing plots in HEC-DSSVue 

and several other HEC software programs.  Please refer to the HEC-

DSSVue User’s Manual for details on customizing plots. 
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Viewing the Report File 

A report file is created when the coincident frequency analysis 

computations are performed.  The report file lists the input data, user 

settings, and the final results.  This file is often useful for understanding 

how the software arrived at the final frequency curve.   

To view the report file press the View Report button at the bottom of the 

Coincident Frequency Analysis editor.  When this button is pressed, a 

window will appear containing the report as shown in Figure 9-15. 

 
Figure 9-15.  Coincident Frequency Analysis Report File.
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CHAPTER  10  

Performing a Balanced Hydrograph 

Analysis 

The current version of HEC-SSP allows the user to compute balanced 

hydrographs.  In this type of analysis, observed data, flow, and volume-

frequency curves are used to create a hypothetical hydrograph that 

“balances” flow rates, volumes, and frequency.  Within a balanced 

hydrograph, the flow and/or volume across multiple durations satisfies the 

relation between flow/volume and duration for a given frequency.  For 

example, a 5-day 0.2 percent annual chance exceedance (ACE) balanced 

hydrograph would have individual hydrograph ordinates arranged in such 

a way that the flow volumes for the 1-hr, 1-day, …, 5-day durations would 

each equal the 0.2 percent ACE flow rates and/or volumes.  Although such 

hydrographs do not necessarily preserve the random character of natural 

hydrographs, use of balanced hydrographs ensures an appropriate flow 

rate and/or volume (in terms of frequency), regardless of the 

characteristics of a particular watershed or location.  This chapter 

discusses in detail how to use the Balanced Hydrograph Analysis editor 

within HEC-SSP. 

Contents 

 Starting a New Analysis 

 General Settings  

 Frequency Curves 

 Viewing and Printing Results 
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Starting a New Analysis 

A balanced hydrograph analysis can be started in two ways, either by right 

clicking on the Balanced Hydrograph Analysis folder in the study explorer 

and selecting New, or by going to the Analysis menu and selecting New 

and then Balanced Hydrograph Analysis.  When a new balanced 

hydrograph analysis is selected, the Balanced Hydrograph Analysis Editor 

will appear as shown in Figure 10-1. 

 
Figure 10-1.  Balanced Hydrograph Analysis Editor. 

 

The user is required to enter a Name for the analysis, while a Description 

is optional.  A Flow Data Set must be selected from the available datasets 

stored within the current study DSS file.  This flow data set could be 

comprised of daily measurements or those of a shorter duration.  Generally 

speaking, shorter duration datasets (such as 1HOUR or 15MIN) should be 

used in lieu of daily durations (see Chapter 4 for importing flow data into 

the study).  The list of data that can be selected for a balanced hydrograph 

analysis will only include those data that have a regular interval, like 

15MIN, 1HOUR, or 1DAY (E-Part pathname).  Once a Name is entered, 
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the DSS File Name and Report File will automatically be filled out.  The 

DSS filename is by default the study DSS file.  The report file is given the 

same name as the analysis with the extension ".rpt". 

General Settings 

Once the analysis name has been entered, the user can begin to perform 

the analysis.  Contained on the Balanced Hydrograph Analysis editor are 

three tabs.  The tabs are labeled General, Frequency Curves, and 

Results.  The first tab contains general settings for performing the 

balanced hydrograph analysis (Figure 10-1).  These settings include: 

 Output Labeling 

 Number of Durations 

 User-Specified Durations 

 Time Window Modification 

 Number of Probabilities 

 User-Specified Probabilities for Balanced Hydrographs 

 User Specified Frequency Ordinates 

Output Labeling 

This option allows the user to change the default labels for data contained 

in the output tables and 

plots.  The user can 

change both the name of 

the data as well as the 

units of the data.  The 

output labeling does not 

result in the conversion 

of data from one unit 

system to another; it 

only affects what is displayed on table headings and the y-axis of the 

results plot.   

Number of Durations 

This option allows the user to set the number of frequency curve durations 

that will be used to 

construct the balanced 

hydrographs.  The 

number entered will 

modify the number of rows contained within the User-Specified 
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Durations.  Typically, balanced hydrographs are constructed using more 

than one duration.  However, as the number of durations is increased, the 

resulting hydrographs will preserve less of the random character of natural 

hydrographs.  At a minimum, the number of durations must be set equal to 

one. 

The User-Specified Durations table automatically adjusts the number of 

rows based on the defined 

number of durations.  After 

the user sets the number of 

durations, the user must 

input the durations for which 

the balanced hydrographs 

will be created.  The 

program will arrange 

hydrograph ordinates to 

“balance” the flow-durations (i.e. volumes) using the durations defined 

within this table.  Note that the units for each duration is days.  For 

example, a one hour duration is equivalent to 0.0417 days.   

There are no default durations.  A typical listing of durations includes both 

shorter and longer durations.  Durations should be listed in descending 

order with shorter durations listed first followed by longer durations.  The 

smallest duration should be equal to or greater than the time step of the 

input flow data set.  For example, a 1DAY flow data set cannot be used in 

conjunction with a specified duration of 0.0417 days. 

Time Window Modification 

This option allows the user to define a time window used for the analysis.  

The time window should correspond to the period within the Flow Data 

Set that the user wishes to use as a “template” hydrograph shape.  The 

default is to use all 

of the data 

contained within 

the selected data 

set.  If the default 

time window is 

used, HEC-SSP 

will identify the event with the greatest peak flow rate within the selected 

flow data set and use that as the “template” hydrograph shape.  If a start 

and/or end date are used, they must be dates that are contained within the 

data stored in the selected data set.  The date range for the selected data set 

is shown in the editor just above the Start Date field. 
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Number of Probabilities 

This option lets the user choose the number of probabilities that will be 

used to construct the 

balanced  hydrographs. 

The default setting is “1” probability.  Using the default will result in the 

creation of a single balanced hydrograph. 

The User-Specified 

Probabilities table 

automatically adjusts 

the number of rows 

based on the defined 

number of 

probabilities.  After the 

user sets the number of 

probabilities, the user 

must input the 

probabilities for the balanced hydrograph analysis.  This listing should be 

entered in ascending order (i.e. 0.2, 0.5, 1.0, etc).  The input listing cannot 

use frequencies outside of the User Specified Frequency Ordinates.  The 

input frequencies should have units of percent. 

User Specified Frequency Ordinates 

 This option allows the user to change the frequency ordinates used for 

creating result tables and 

graphs.  The default values 

listed in percent chance 

exceedance are 0.2, 0.5, 1, 

2, 5, 10, 20, 50, 80, 90, 95, 

and 99.  Check the box next 

to Use Values from Table 

below to change or add 

additional values.  Once this 

box is checked, the user can 

add/remove rows and edit 

the frequency values.  To 

add or remove a row from 

the table, select the row(s), 

place the mouse over the highlighted row(s) and click the right mouse 

button.  The shortcut menu contains options to Insert Row(s) and Delete 

Row(s).  The program will use the default values, even if they are not 

contained in the table, when the Use Values from Table below option is 

not checked.  Finally, all values in the table must be between 0 and 100. 
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Frequency Curves 

The Frequency Curves tab is used to define the flow- frequency curves for 

the User-Specified Durations.  As shown in Figure 10-2, the Frequency 

Curves tab contains a panel for each frequency curve; the number of 

frequency curves is defined in the General tab.  Two options are available 

to define these flow-frequency curves.  First, the user can input the flow-

frequency information for all of the frequency ordinates.  Second, the user 

can input the Log-Pearson III statistics (mean, standard deviation, and 

skew).  Both forms of input can be determined using pre-determined flow- 

and/or volume-frequency analyses (i.e. Bulletin 17B, Bulletin 17C, 

Volume-Frequency, etc). 

The Plot Flow-Frequency  button will open a 

graph showing all flow-frequency curves defined on the frequency curves 

tab as well as the Flow Data Set, as show in Figure 10-3. 

 
Figure 10-2.  Balanced Hydrograph Analysis Frequency Curves Tab. 
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Figure 10-3.  Plot of Frequency Curves Defined in the Frequency Curves Tab. 

 

Compute 

Press the Compute button, located at the bottom of the 

Balanced Hydrograph Analysis editor, once options have 

been set on the General and Frequency Curves tabs.  If the 

compute is successful, the user will receive a message that says Compute 

Complete.  At this point, the user can begin to review the results. 

Multiple Balanced Hydrograph analyses can be computed using the 

Compute Manager.  Select the AnalysisCompute Manager menu 

option to open the Compute Manager.  Select the analyses to be computed 

and then press the Compute button.  Close the compute dialogs and 

Compute Manager when the program finishes computing the analyses. 

Results 

This section describes results that are available for the Balanced 

Hydrograph analysis.  When the user selects the Results tab on the 

Balanced Hydrograph Analysis editor, the window will appear as shown 

in Figure 10-4.  Both tabular and graphical results are included.  The 

durations and probabilities for the balanced hydrographs are the same as 
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those defined on the General tab.  In addition, when the Data Name and 

Data Units are defined on the General tab they are used in the y-axis label 

in the plot. 

 
Figure 10-4.  Results Tab of the Balanced Hydrograph Analysis Editor. 

 

 

Viewing and Printing Results 

The user can view the output for the balanced hydrograph analysis directly 

from the Balanced Hydrograph Analysis editor (tabular and graphical 

output) or by using the buttons at the bottom of the editor.   

Tabular Output 

Once the computations for the balanced hydrograph analysis are 

completed, the user can view the tabular 

output by selecting the Results tab.  Tabular 

results can be opened after clicking the Plot 

Balanced Hydrograph button and selecting FileTabulate or by double 

clicking on the balanced hydrograph plot in the Results tab and in the 

opened plot selecting FileTabulate. The balanced hydrograph table can 
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also be printed once opened in a new window using the FilePrint 

option. An additional printing option available from the File menu is Print 

Preview.  The table can also be exported by selecting Export… from the 

File menu.  When the Export option is selected, a window will appear 

allowing the user to select the Field Delimiter and additional Table Export 

Options.  Currently five field delimiter formats are available for exporting 

the table: TAB, SPACE, COMMA, COLON and SEMI-COLON.    

Graphical Output 

Graphical output of the balanced hydrograph analysis can be obtained by 

selecting either the Results tab, or by pressing the Plot Balanced 

Hydrograph button at the bottom of the balanced hydrograph analysis 

editor.  When the Plot Balanced Hydrograph button is pressed, a balanced 

hydrograph plot will appear in a separate window as shown in Figure 

10-5. The example balanced hydrograph plot in Figure 10-5 was created 

after modifying the Time-Window (in the General tab). The user can 

modify the Time-Window to obtain balanced hydrographs for a specific 

maximum peak in the dataset. 

The balanced hydrograph plot can be sent to the printer by selecting the 

Print option from the File menu at the top of the window.  Additional 

printing options available from the File menu are Page Setup, Print 

Preview, and Print Multiple (used for printing multiple graphs on the same 

page).  The graphic can also be sent to the Windows Clipboard by 

selecting Copy to Clipboard from the File menu.  Additionally, the plot 

can be saved to a file by selecting the Save As option from the File menu.   

When the Save As option is selected, a window will appear allowing the 

user to select a directory, enter a filename, and select the format for saving 

the file.  Currently four file formats are available for saving the graphic to 

disk: windows metafile, postscript, JPEG, and portable network 

graphic. 
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Figure 10-5.  Balanced Hydrograph Analysis Plot. 

 

As explained previously, the data contained within the plot can also be 

tabulated by selecting Tabulate from the File menu.  When this option is 

selected, a separate window will appear with the data tabulated.  

Additional options are available from the File menu for saving the plot 

options as a template (Save Template) and applying previously saved 

templates to the current plot (Apply Template).   

The Edit menu contains several options for customizing the graphic.  

These options include Plot Properties, Configure Plot Layout, Default 

Line Styles, and Default Plot Properties.  Also, a shortcut menu will 

appear with further customizing options when the user right-clicks on a 

line on the graph or the legend.  Both the Y and X-axis properties can be 

edited by placing the mouse on top of axis and clicking the right mouse 

button.  Then select the Edit Properties menu option in the shortcut 

menu.  For example, the user can turn on minor tic marks for the y-axis 

and modify the minimum and maximum scale for the x-axis.  The graphic 

customizing capabilities within HEC-SSP are very powerful, but are also 

somewhat complex to use.  The code used in developing the plots in HEC-

SSP is the same code that is used for developing plots in HEC-DSSVue 

and several other HEC software programs.  Please refer to the HEC-

DSSVue User’s Manual for details on customizing plots. 
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Viewing the Report File 

A report file is created when the balanced hydrograph analysis 

computations are performed.  The report file lists the input data, user 

settings, and the final results.  This file is often useful for understanding 

how the software arrived at the balanced hydrograph.   

To view the report file press the View Report button at 

the bottom of the Balanced Hydrograph Analysis editor.  

When this button is pressed, a window will appear containing the report as 

shown in Figure 10-6. 

 
Figure 10-6.  Balanced Hydrograph Analysis Report File. 

 

The computations that were used to create the balanced hydrographs are 

contained within the Report output.  Specifically, the base, required, and 

final flow-duration values are detailed along with the percent error for 

each duration and frequency.  Additionally, the balanced hydrograph 

report can be opened using the ResultsReport option in the Results 

dropdown menu at the top of the SSP window.
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A P P E N D I X  B   

Example Data Sets 

The input and output for eleven example data sets are provided to illustrate 

the use of selected options and to assist in verifying the correct execution 

of the program.     

The first six example data sets are the same examples that were found in 

the HEC-FFA program documentation.  The first six examples were 

duplicated with a Bulletin 17B and General Frequency analysis.  This 

manual only shows these examples using the Bulletin 17B analysis; 

however, the example data sets show that results are the same whether a 

Bulletin 17B or General Frequency analysis was performed. As shown in 

the example data sets, the HEC-SSP software produces the same results as 

HEC-FFA for these six data sets.  All of these examples are provided with 

the software as a single HEC-SSP study labeled "SSP Examples".  You 

can install this study on your computer by selecting the HelpInstall 

Example Data menu option.  After opening this study for the first time on 

your computer, you must compute each example before viewing tabular 

and graphical results.     

A brief description of each example is provided.  In most cases the 

weighted skew option was selected, and a regional skew value was entered 

from the generalized skew map of the United States provided within 

Bulletin 17B (Plate 1).   

The example problems shown in this section are entitled: 

1. Fitting the Log-Pearson Type III Distribution. 

2. Analysis with High Outliers. 

3. Testing and Adjusting for a Low Outlier. 

4. Zero Flood Years. 

5. Confidence Limits and Low Threshold Discharge. 

6. Use of Historic Data and Median Plotting Positions. 

7. Analyzing Stage Data. 

8. Using User-Adjusted Statistics. 
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9. General Frequency - Graphical Analysis. 

10. Volume Frequency Analysis, Maximum Flows.  

11. Volume Frequency Analysis, Minimum Flows.  

12. Duration Analysis, Bin (STATS) Method.  

13. Duration Analysis, Rank All Data Method. 

14. Duration Analysis, Manual Entry.  

15. Coincident Frequency Analysis, A and B can be Assumed 

Independent.  

16. Coincident Frequency Analysis, A and B cannot be Assumed 

Independent.  

17. Balanced Hydrograph Analysis, Using an Historical Event 

Hydrograph.  

18. Balanced Hydrograph Analysis, Using a Triangular-shaped 

Hydrograph.  

When the "SSP Examples" study file is open, the screen will appear as 

shown in Figure B-1.  There are six Bulletin 17B analyses, nine General 

Frequency analyses, two Volume Frequency analyses, three Duration 

analyses, two Coincidence Frequency analyses, and two Balanced 

Hydrograph analyses in this study.  The following sections document each 

of the example data sets.  Appendix C details six additional examples 

which make use of the Expected Moments Algorithm and Bulletin 17C 

procedures.  
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Figure B-1.  SSP Examples Study. 
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Example 1: Fitting the Log-Pearson Type III 
Distribution 

The input data for FFA Test 1 is the same as that for Example 1 in 

Appendix 12, Guidelines for Determining Flood Flow Frequency, Water 

Resources Council Bulletin 17B.  Example 1 illustrates the routine 

computation of a frequency curve by the Bulletin 17B methodology.   

The data for this example is from Fishkill Creek in Beacon, New York.  

The period of record used for this example is from 1945 to 1968.  To view 

the data from HEC-SSP, right-click on the data record labeled “Fishkill 

Creek-Beacon, NY” in the study explorer and then select Tabulate.  The 

data will appear as shown in Figure B-2. 

 
Figure B-2.  Tabulation of the Peak Flow Data for Fishkill Creek. 

To plot the data for this example, right-click on the data record again and 

then select Plot.  A plot of the data will appear as shown in Figure B-3. 
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Figure B-3.  Plot of the Fishkill Creek Data. 

 

A Bulletin 17B and a General Frequency analysis have been developed for 

this example.  To open the Bulletin 17B analysis editor for Example 1, 

either double-click on the analysis labeled FFA Test 1 from the Study 

Explorer, or from the Analysis menu select open, then select FFA Test 1 

from the list of available analyses.  When FFA Test 1 is selected, the 

Bulletin 17B analysis editor will appear as shown in Figure B-4. 



 Appendix B – Example Data Sets HEC-SSP User's Manual 

 

B-6 

 

Figure B-4.  Bulletin 17B Analysis Editor with FFA Test 1 Data Set. 

 

Shown in Figure B-4 are the general settings that were used to perform 

this frequency analysis.  As shown, the Skew option was set to use the 

Weighted Skew.  To use the weighted skew option, the user must enter a 

value for the Regional Skew and the Regional Skew Mean Square Error 

(MSE).  This selection requires the user to either look up a value from the 

generalized skew map of the United States, which is provided with 

Bulletin 17B, or develop a value from a regional analysis of nearby gages.  

In this example a value of 0.6 was taken from the generalized skew map of 

the U.S. from Bulletin 17B.  Bulletin 17B suggests using a Regional Skew 

MSE of 0.302 whenever regional skew values are taken from the map. 

Also for this example, the Expected Probability Curve option was 

selected to be computed in addition to the Log Pearson III computed 

curve.  The Weibull plotting position method was selected, as well as the 

default Confidence Limits of 0.05 (5 percent chance exceedance) and 

0.95 (95% chance exceedance).  Shown in Figure B-5 is the Bulletin 17B 

editor with the Options Tab selected. 
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Figure B-5.  Bulletin 17B Editor with Options Tab Selected for FFA Test 1. 

 

As shown in Figure B-5, none of the available options for modifying the 

frequency analysis were selected for this example.  These options include 

changing the Low Outlier Threshold and using Historic Data.  

Additionally, the option to override the default Frequency Ordinates was 

not selected. 

Once all of the General and Optional settings are set or selected, the user 

can press the Compute button to perform the analysis.  Once the 

computations have been completed, a message window will open stating 

Compute Complete.  Close this window and then select the Tabular 

Results tab.  The analysis window should look like Figure B-6. 
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Figure B-6.  Bulletin 17B Analysis Window with Results Tab Shown for FFA 

Test 1. 

 

As shown in Figure B-6, the Frequency Curve table contains the following 

results: 

 Percent Chance Exceedance 

 Computed Curve (Log-Pearson III results) 

 Expected Probability Curve 

 Confidence Limits (5% and 95% chance exceedance curves) 

On the bottom, left side of the results tab is a table of Statistics for the 

observed station data (mean, standard deviation, station skew) and 

regional adjustment (regional skew, weighted skew, and adopted skew).  

Also on the bottom, right side of the results tab is a Number of Events 

table showing the number of historic events used in the analysis, number 
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of high outliers found, number of low outliers, number of zero or missing 

data years, number of systematic events in the gage record, and the 

historic record length (if historic data was entered). 

In addition to the tabular results, a graphical plot of the computed 

frequency curves can be obtained by pressing the Plot Curve button at the 

bottom of the analysis window.  A plot of the results for this example is 

shown in Figure B-7. 

 

Figure B-7.  Plotted Frequency Curves for FFA Test 1. 

 

The tabular and graphical results can be sent to the printer or the Windows 

clipboard for transfer into another piece of software.  To print the tabular 

results, select Print from the bottom of the analysis window.  To send the 

tabular results to the Windows clipboard, highlight the data you want to 

send to the clipboard and then press the Control-C key sequence.  To print 

the graphical results, first bring up the graphical plot and then select Print 

from the File menu.  To send the graphic to the windows clipboard, select 

Copy to Clipboard from the File menu. 
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In addition to the tabular and graphical results, there is a report file that 

shows the order in which the calculations were performed.  To review the 

report file, press the View Report button at the bottom of the analysis 

window.  When this button is selected a text viewer will open the report 

file and display it on the screen.  Shown in Figure B-8 is the report file for 

FFA Test 1. 

The report file contains a listing of the input data, preliminary results, 

outlier and historical data tests, additional calculations needed, and the 

final frequency curve results.  Different types and amounts of information 

will show up in the report file depending on the data and the options that 

have been selected for the analysis.  The user should review the report file 

to understand how HEC-SSP performed the Bulletin 17B frequency curve 

calculations. 

 

 

Figure B-8.  FFA Test 1 Report File. 
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Example 2: Analysis with High Outliers 

The input data for FFA Test 2 is the same as that for Example 2 in 

Appendix 12, Guidelines for Determining Flood Flow Frequency, Water 

Resources Council Bulletin 17B.  Example 2 illustrates the application to 

data with a high outlier.  

The data for this example is from Floyd River in James, Iowa.  The period 

of record used is from 1935 to 1973.  To view the data from HEC-SSP, 

right-click on the data record labeled "Floyd River-James IA" in the 

study explorer and then select Tabulate.  The data will appear as shown in 

Figure B-9. 

 
Figure B-9.  Tabulation of the Peak Flow Data for the Floyd River. 
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To plot the data for this example, right-click on the data record and then 

select Plot.  A plot of the data will appear as shown in Figure B-10. 

 

Figure B-10.  Plot of Floyd River Data 

 

A Bulletin 17B and General Frequency analysis have been developed for 

this example.  To open the Bulletin 17B analysis editor for FFA Test 2, 

either double-click on the analysis labeled FFA Test 2 from the study 

pane, or from the Analysis menu select open and then select FFA Test 2 

from the list of available analyses.  When FFA Test 2 is selected, the 

Bulletin 17B analysis editor will appear as shown in Figure B-11. 
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Figure B-11.  Bulletin 17B Analysis Editor with FFA Test 2 Data Set. 

 

Shown in Figure B-11 are the general settings that were used to perform 

this frequency analysis.  As shown, the Skew option was set to use the 

Weighted Skew.  To use the weighted skew option, the user must enter a 

value for the Regional Skew and the Regional Skew Mean Square Error 

(MSE).  This selection requires the user to either look up a value from the 

generalized skew map of the United States, which is provided with 

Bulletin 17B, or develop a value from a regional analysis of nearby gages.  

In this example a value of -0.3 was taken from the generalized skew map 

of the U.S. from Bulletin 17B.  Bulletin 17B suggests using a Regional 

Skew MSE of 0.302 whenever regional skew values are taken from the 

map. 

Also for this example, the Expected Probability Curve option was 

selected to be computed in addition to the Log Pearson III computed 

curve.  The Weibull plotting position method was selected, as well as the 

default Confidence Limits of 0.05 (5 percent chance exceedance) and 

0.95 (95% chance exceedance).  Shown in Figure B-12 is the Bulletin 17B 

editor with the Options Tab selected. 
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Figure B-12.  Bulletin 17B Editor with Options Tab Selected for FFA Test 2. 

 

As shown in Figure B-12, the Historic Period Data option has been 

selected to reflect the fact that the 1953 flood peak of 71,500 cfs is known 

to be the largest flood since 1892. When the analysis was originally 

performed on this data set, the 1953 event was found to be a high outlier.  

(The reader may replicate this result by un-checking the "Use Historic 

Data" box, hitting the Compute button, and reviewing the Tabular Results 

tab.)  High outliers should not be eliminated from an analysis, as they are 

valuable pieces of the flow record.  However, when a high outlier is found 

in a data set, it suggests that the event might actually be the largest in a 

much longer period of record.  The analyst should always try to locate and 

incorporate historic information to define a longer record and improve the 

quality of the frequency analysis.  Since it was known that the 1953 event 

was the largest value since 1892, the year 1892 is entered as the Start 

Year for the historic period.  Additionally, a High Threshold Value of 

70,000 cfs was entered.  By entering the High Threshold Value of 70,000 
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cfs, the 1953 flood of 71,500 cfs was removed from the systematic record 

and treated as a historic data value during the historic data adjustment 

calculations performed by HEC-SSP and outlined in Bulletin 17B, 

Appendix 6.  Since no End Year was entered for the historic period, the 

last year of the systematic data set will be used as the End Year. 

Other features on this tab include the Low Outlier Threshold and the 

option to override the default Frequency Ordinates, neither of which are 

selected in this example. 

Once all of the General and Optional settings are set or selected, the user 

can press the Compute button to perform the analysis.  Once the 

computations have been completed, a message window will open stating 

Compute Complete.  Close this window and then select the Tabular 

Results tab.  The analysis window should look like Figure B-13. 

 

Figure B-13.  Bulletin 17B Editor with Results Tab Selected for FFA Test 2. 
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As shown in Figure B-13, the Frequency Curve table contains the 

following results: 

 Percent Chance Exceedance 

 Computed Curve (Log-Pearson III results) 

 Expected Probability Curve 

 Confidence Limits (5% and 95% chance exceedance curves) 

On the bottom left-hand side of the results tab is the Statistics table for the 

observed station data (mean, standard deviation, station skew) and 

regional adjustment (regional skew, weighted skew, and adopted skew).  

Also on the bottom right-hand side of the results tab is the Number of 

Events table showing the number of historic events used in the analysis, 

number of high outliers found, number of low outliers, number of zero or 

missing data years, number of systematic events in the gage record, and 

the historic record length (if historic data was entered). 

In addition to the tabular results, a graphical plot of the computed 

frequency curves can be obtained by pressing the Plot Curve button at the 

bottom of the analysis window.  A plot of the results for this example is 

shown in Figure B-14. 
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Figure B-14.  Plotted Frequency Curves for FFA Test 2. 

 

The tabular and graphical results can be sent to the printer or the windows 

clipboard for transfer into another piece of software.  To print the tabular 

results, select Print from the bottom of the analysis window.  To send the 

tabular results to the windows clipboard, highlight the data you want to 

send to the clipboard and then press the Control-C key sequence.  To print 

the graphical results, first bring up the graphical plot and then select Print 

from the File menu.  To send the graphic to the windows clipboard, select 

Copy to Clipboard from the File menu. 

In addition to the tabular and graphical results, there is a report file that 

shows the order in which the calculations were performed.  To review the 

report file, press the View Report button at the bottom of the analysis 

window.  When this button is selected a text viewer will open the report 

file and display it on the screen.  Shown in Figure B-15 is the report file 

for FFA Test 2. 
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The report file contains a listing of the input data, preliminary results, 

outlier and historical data tests, additional calculations needed, and the 

final frequency curve results.  Different types and amounts of information 

will show up in the report file depending on the data and the options that 

have been selected for the analysis.  The user should review the report file 

to understand how HEC-SSP performed the frequency curve calculations. 

 
Figure B-15.  FFA Test 2 Report File. 
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Example 3: Testing and Adjusting for a Low Outlier 

The input data for FFA Test 3 are the same as that for Example 3 in 

Appendix 12 of the WRC Guidelines.  FFA Test 3 illustrates the 

application to data with a low outlier.  Note that the program automatically 

screens for low outliers and, if low outliers are found, outputs the 

preliminary results in the report file in order to allow for comparison with 

the final results. 

The data for this example is from Back Creek in Jones Springs, West 

Virginia.  The period of record used for this example is from 1929 to 

1973.  To view the data, right-click on the data record labeled "Back 

Creek-Jones Springs" in the study pane and then select Tabulate.  The 

data will appear as shown in Figure B-16. 

 
Figure B-16.  Tabulation of the Peak Flow Data for Back Creek. 
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To plot the data for this example, right-click on the data record and select 

Plot.  A plot of the data will appear as shown in Figure B-17. 

 

Figure B-17.  Plot of Back Creek Data. 

 

A Bulletin 17B and General Frequency analysis have been developed for 

this example.  To open the Bulletin 17B analysis editor for FFA Test 3, 

either double-click on the analysis labeled FFA Test 3 from the study 

explorer, or from the Analysis menu select open and then select FFA Test 

3 from the list of available analyses.  When FFA Test 3 is selected, the 

Bulletin 17B analysis editor will appear as shown in Figure B-18. 
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Figure B-18.  Bulletin 17B Analysis Editor with FFA Test 3 Data Set. 

 

Shown in Figure B-18 are the general settings that were used to perform 

this frequency analysis.  As shown, the Skew option was set to use the 

Weighted Skew.  To use the weighted skew option, the user must enter a 

value for the Regional Skew and the Regional Skew Mean Square Error 

(MSE).  This selection requires the user to either look up a value from the 

generalized skew map of the United States, which is provided with 

Bulletin 17B, or develop a value from a regional analysis of nearby gages.  

In this example, a value of 0.5 was taken from the generalized skew map 

of the U.S. from Bulletin 17B.  Bulletin 17B suggests using a Regional 

Skew MSE of 0.302 whenever regional skew values are taken from the 

map. 

Also for this example, the Expected Probability Curve option was 

selected to be computed in addition to the Log Pearson III computed 

curve.  The Weibull plotting position method was selected, as well as the 

default Confidence Limits of 0.05 (5 percent chance exceedance) and 

0.95 (95% chance exceedance).  Shown in Figure B-19 is the Bulletin 17B 

editor with the Options Tab selected. 
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Figure B-19.  Bulletin 17B Editor with the Options Tab Selected for FFA Test 3. 

 

As shown in Figure B-19, none of the available options for modifying the 

frequency curve were selected for this test example.  These options 

include the Low Outlier Threshold and Historic Period Data.  

Additionally, the option to override the default Frequency Ordinates was 

not selected. 

Once all of the General and Optional settings are set or selected, the user 

can press the Compute button to perform the analysis.  Once the 

computations have been completed a message window will open stating 

Compute Complete.  Close this window and select the Tabular Results 

tab.  The analysis window should look like Figure B-20. 
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Figure B-20.  Bulletin 17B Editor with the Results Tab Selected for FFA Test 3. 

 

As shown in Figure B-20, the Frequency Curve table contains the 

following results: 

 Percent Chance Exceedance 

 Computed Curve (Log-Pearson III results) 

 Expected Probability Curve 

 Confidence Limits (5% and 95% chance exceedance curves) 

On the bottom left-hand side of the results tab is a table of Statistics for 

the observed station data (mean, standard deviation, station skew) and 

regional adjustment (regional skew, weighted skew, and adopted skew).  

Also on the bottom right-hand side of the results tab is a table of Number 

of Events showing the number of historic events used in the analysis, 

number of high outliers found, number of low outliers, number of zero or 
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missing data years, number of systematic events in the gage record, and 

the historic record length (if historic data was entered).   

In this analysis, the software detected one low outlier in the systematic 

record.  As recommended in Bulletin 17B, if a low outlier is detected, then 

that data point will be removed and the Conditional Probability 

Adjustment will be used to recalculate the frequency curve and then the 

statistics without that point.  Review the report file to see the original 

statistics, computed curves, the low outlier test, and recomputed curves. 

In addition to the tabular results, a graphical plot of the computed 

frequency curves can be obtained by pressing the Plot Curve button at the 

bottom of the analysis window.  A plot of the results for this example is 

shown in Figure B-21. 

 

Figure B-21.  Pot for FFA Test 3. 

 

In addition to the tabular and graphical results, there is a report file that 

shows the order in which the calculations were performed.  To review the 
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report file, press the View Report button at the bottom of the analysis 

window.  When this button is selected a text viewer will open the report 

file and display it on the screen.  Shown in Figure B-22 is the report file 

for FFA Test 3. 

The report file contains a listing of the input data, preliminary results, 

outlier and historical data tests, additional calculations needed, and the 

final frequency curve results.  Different types and amounts of information 

will show up in the report file depending on the data and the options that 

have been selected for the analysis. 

 

Figure B-22.  Report File for FFA Test 3.  
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Example 4: Zero-Flood Years 

The input data for FFA Test 4 are the same as that for Example 4 in 

Appendix 12 of the WRC Guidelines.  FFA Test 4 illustrates the 

application to data that includes several zero flow years. 

The data for this example is from Orestimba Creek in Newman, 

California.  The period of record used for this example is from 1932 to 

1973.  To view the data from HEC-SSP, right-click on the data record 

labeled "Orestimba Creek-Newman, CA” in the study explorer and then 

select Tabulate.  The data will appear as shown in Figure B-23. 

 
Figure B-23.  Tabulation of the Peak Flow Data for Orestimba Creek. 
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To plot the data for this example, right-click on the data record and then 

select Plot.  A plot of the data will appear as shown in Figure B-24.  The 

years with peak flows measuring zero are visible. 

 

Figure B-24.  Plot of Orestimba Creek Data. 

 

A Bulletin 17B and General Frequency analysis have been developed for 

this example.  To open the Bulletin 17B analysis editor for FFA Test 4, 

either double-click on the analysis labeled FFA Test 4 from the study 

explorer, or from the Analysis menu select open, then select FFA Test 4 

from the list of available analyses.  When FFA Test 4 is selected, the 

Bulletin 17B analysis editor will appear as shown in Figure B-25. 
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Figure B-25.  Bulletin 17B Analysis Editor with FFA Test 4 Data Set. 

 

Shown in Figure B-25 are the general settings that were used to perform 

this frequency analysis.  As shown, the Skew option was set to use the 

Weighted Skew.  To use the weighted skew option, the user must enter a 

value for the Regional Skew and the Regional Skew Mean Square Error 

(MSE).  This selection requires the user to either look up a value from the 

generalized skew map of the United States, which is provided with 

Bulletin 17B, or develop a value from a regional analysis of nearby gages.  

In this example a value of -0.3 was taken from the generalized skew map 

of the U.S. from Bulletin 17B.  Bulletin 17B suggests using a Regional 

Skew MSE of 0.302 whenever regional skew values are taken from the 

map. 

Also for this example, the Expected Probability Curve option was 

selected to be computed in addition to the Log Pearson III computed 

curve.  The Weibull plotting position method was selected, as well as the 

default Confidence Limits of 0.05 (5 percent chance exceedance) and 

0.95 (95% chance exceedance).  Shown in Figure B-26 is the Bulletin 17B 

editor with the Options Tab selected. 
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Figure B-26.  Bulletin 17B Editor with the Options Tab Selected for FFA Test 4. 

 

As shown in Figure B-26, none of the available options for modifying the 

frequency curve were selected for this test example.  These options 

include the Low Outlier Threshold and Historic Period Data.  

Additionally, the option to override the default Frequency Ordinates was 

not selected. 

Once all of the General and Optional settings are set or selected, the user 

can press the Compute button to perform the analysis.  Once the 

computations have been completed a message window will open stating 

Compute Complete.  Close this window and then select the Tabular 

Results tab.  The analysis window should look Figure B-27. 
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Figure B-27.  Bulletin 17B Editor with the Results Tab Selected for FFA Test 4. 

 

As shown in Figure B-27, the Frequency Curve table contains the 

following results: 

 Percent Chance Exceedance 

 Computed Curve (Log-Pearson III results) 

 Expected Probability Curve 

 Confidence Limits (5% and 95% chance exceedance curves) 

On the bottom left-hand side of the results tab is a table of Statistics for 

the observed station data (mean, standard deviation, station skew) and 

regional adjustment (regional skew, weighted skew, and adopted skew).  

Also on the bottom right-hand side of the results tab is a table of Number 

of Events showing the number of historic events used in the analysis, 

number of high outliers found, number of low outliers, number of zero or 
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missing data years, number of systematic events in the gage record, and 

the historic record length (if historic data was entered).    

As noted earlier, there were six zero values in this record, and also a low 

outlier.  A zero value causes difficulty because the first step in fitting a 

Log Pearson III distribution is computing the base-10 log of each flow 

value, which is undefined for zero.  Bulletin 17B recommends removing 

the zero values (and the low outlier) from the systematic record to 

compute a preliminary frequency curve, and then adjusting that curve with 

the Conditional Probability Adjustment.  The final frequency curve and 

statistics are shown in the table, and the preliminary calculations can be 

reviewed in the report file.  

In addition to the tabular results, a graphical plot of the computed 

frequency curves can be obtained by pressing the Plot Curve button at the 

bottom of the analysis window.  A plot of the results for this example is 

shown in Figure B-28. 

 

Figure B-28.  Plot of FFA Test 4 Results. 
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The tabular and graphical results can be sent to the printer or the windows 

clipboard for transfer into another piece of software.  To print the tabular 

results, select Print from the bottom of the analysis window.  To send the 

tabular results to the windows clipboard, highlight the data you want to 

send to the clipboard and then press the Control-C key sequence.  To print 

the graphical results, first bring up the graphical plot and then select Print 

from the File menu.  To send the graphic to the windows clipboard, select 

Copy to Clipboard from the File menu. 

In addition to the tabular and graphical results, there is a report file that 

shows the order in which the calculations were performed.  To review the 

report file, press the View Report button at the bottom of the analysis 

window.  When this button is selected a text viewer will open the report 

file and display it on the screen.  Shown in Figure B-29 is the report file 

for FFA Test 4. 

The report file contains a listing of the input data, preliminary results, 

outlier and historical data tests, additional calculations needed, and the 

final frequency curve results.  Different types and amounts of information 

will show up in the report file depending on the data and the options that 

have been selected for the analysis. 
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Figure B-29.  HEC-SSP Report File for FFA Test 4. 
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Example 5: Confidence Limits and Low Threshold 
Discharge 

This example illustrates the use of user-entered confidence limits.  

Probabilities of .01 and .99 were entered for the computed confidence 

limit curves.  This data set also includes two very low values, the higher of 

which is just above the default low outlier threshold.  This example 

therefore also demonstrates the use of a user-entered low outlier threshold 

set to be higher than both values.   

The data for this example is from Kaskaskia River in Vandalia, Illinois.  

The period of record used for this example is from 1908 to 1970.  To view 

the data from HEC-SSP, right-click on the data record labeled "Kaskaskia 

River-Vandalia, IL" in the study explorer and then select Tabulate.  The 

data will appear as shown in Figure B-30. 

 
Figure B-30.  Tabulation of the Peak Flow Data for Kaskaskia River. 
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To plot the data for this example, right-click on the data record and then 

select Plot.  A plot of the data will appear as shown in Figure B-31. 

 

Figure B-31.  HEC-SSP Plot of the Kaskaskia River Data. 

 

A Bulletin 17B and General Frequency analysis have been developed for 

this example.  To open the Bulletin 17B analysis editor for FFA Test 5, 

either double-click on the analysis labeled FFA Test 5 from the study 

explorer, or from the Analysis menu select Open and then select FFA 

Test 5 from the list of available analyses.  When FFA Test 5 is selected, 

the Bulletin 17B analysis editor will appear as shown in Figure B-32. 
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Figure B-32.  Bulletin 17B Analysis Editor for FFA Test 5. 

 

Shown in Figure B-32 are the general settings that were used to perform 

this frequency analysis.  As shown, the Skew option was set to use the 

Weighted Skew.  To use the weighted skew option, the user must enter a 

value for the Regional Skew and the Regional Skew Mean Square Error 

(MSE).  This selection requires the user to either look up a value from the 

generalized skew map of the United States, which is provided with 

Bulletin 17B, or develop a value from a regional analysis of nearby gages.  

In this example a value of -0.4 was taken from the generalized skew map 

of the U.S. from Bulletin 17B.  Bulletin 17B suggests using a Regional 

Skew MSE of 0.302 whenever regional skew values are taken from the 

map. 

Also for this example, the Expected Probability Curve option was 

selected to be computed in addition to the Log Pearson III computed 

curve.  The default method of Weibull plotting positions was selected.  

The default values for confidence limits (.05 and .95) were changed to 

0.01 (1 percent chance exceedance) and 0.99 (99% chance exceedance).  

Shown in Figure B-33 is the Bulletin 17B editor with the Options Tab 

selected. 
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Figure B-33.  Bulletin 17B Editor with the Options Tab Shown for FFA Test 5. 

 

As shown in Figure B-33, a Low Outlier Threshold of 2000 cfs was 

entered. In the initial computation with this data (which the reader can 

reproduce by Computing without the "Use Low Outlier Threshold" box 

checked), the default low outlier threshold was 1,253 cfs, just below the 

second lowest value of 1,270 cfs.  A look at the statistics and computed 

frequency curve from that run shows that the 1,270 cfs value is well below 

the computed curve and with a station skew of -0.21 the frequency curve 

does not fit the upper data well.  By choosing to also censor the 1,270 cfs 

value with a threshold of 2000 cfs, the fit is improved.  None of the other 

available options, such as Historic Period Data and the option to override 

the default Frequency Ordinates were selected for this test example.  

Once all of the General and Optional settings are set or selected, the user 

can press the Compute button to perform the analysis.  Once the 

computations have been completed a message window will open stating 
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Compute Complete.  Close this window and then select the Tabular 

Results tab from the analysis window.  The analysis window should look 

Figure B-34. 

 

Figure B-34.  Bulletin 17B Editor with the Results Tab Selected for FFA Test 5. 

 

As shown in Figure B-34, the Frequency Curve table contains the 

following results: 

 Percent Chance Exceedance 

 Computed Curve (Log-Pearson III results) 

 Expected Probability Curve 

 Confidence Limits (1% and 99% chance exceedance curves) 

On the bottom left-hand side of the results tab is a table of Statistics for 

the observed station data (mean, standard deviation, station skew) and 
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regional adjustment (regional skew, weighted skew, and adopted skew).  

Also on the bottom right-hand side of the results tab is a table of Number 

of Events showing the number of historic events used in the analysis, 

number of high outliers found, number of low outliers, number of zero or 

missing data years, number of systematic events in the gage record, and 

the historic record length (only if historic data was entered). 

With the user-defined low-outlier threshold of 2000 cfs, there are two low-

outliers detected.  The analysis report shows the program omitted these 

values and used the Conditional Probability Adjustment to recompute the 

resulting frequency curve and statistics.  The report file (described below) 

includes the preliminary computation before removal of outliers and the 

default and user-defined outlier thresholds, as well as the final frequency 

curve and statistics. 

In addition to the tabular results, a graphical plot of the computed 

frequency curves can be obtained by pressing the Plot Curve button at the 

bottom of the analysis window.  A plot of the results for this example is 

shown in Figure B-35. 

 

Figure B-35.  Plot of the Frequency Curve Results for FFA Test 5. 
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The tabular and graphical results can be sent to the printer or the windows 

clipboard for transfer into another piece of software.  To print the tabular 

results, select Print from the bottom of the analysis window.  To send the 

tabular results to the windows clipboard, highlight the data you want to 

send to the clipboard and then press the Control-C key sequence.  To print 

the graphical results, first bring up the graphical plot and then select Print 

from the File menu.  To send the graphic to the windows clipboard, select 

Copy to Clipboard from the File menu. 

In addition to the tabular and graphical results, there is a report file that 

shows the order in which the calculations were performed.  To review the 

report file, press the View Report button at the bottom of the analysis 

window.  When this button is selected a text viewer will open the report 

file and display it on the screen.  Shown in Figure B-36 is the report file 

for FFA Test 5. 

The report file contains a listing of the input data, preliminary results, 

outlier and historical data tests, additional calculations needed, and the 

final frequency curve results.  Different types and amounts of information 

will show up in the report file depending on the data and the options that 

have been selected for the analysis. 
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Figure B-36.  Report File for FFA Test 5. 
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Example 6: Use of Historic Data and Median Plotting 
Position 

This example demonstrates how to use historic information to improve a 

flow frequency analysis.  A historic flood peak of 15,000 cfs which 

occurred in 1843 is included in the analysis.  This value is the highest 

known value up to the present time (1974 for this example), even though 

the systematic record stopped in 1955.   

The data for this example is from Ridley Creek in Moylan, Pennsylvania.  

The period of record used for this example is from 1932 to 1955.  To view 

the data from HEC-SSP, right-click on the data record labeled "Ridley 

Creek-Moylan, PA" in the study explorer and then select Tabulate.  The 

data will appear as shown in Figure B-37. 

 
Figure B-37.  Tabulation of the Peak Flow Data for Ridley Creek. 
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To plot the data for this example, right-click on the data record and then 

select Plot.  A plot of the data will appear as shown in Figure B-38. 

 

Figure B-38.  Plot of the Ridley Creek Data. 

 

A Bulletin 17B and General Frequency analysis have been developed for 

this example.  To open the Bulletin 17B analysis editor for FFA Test 6, 

either double-click on the analysis labeled FFA Test 6 from the study 

explorer, or from the Analysis menu select open, then select FFA Test 6 

from the list of available analyses.  When FFA Test 6 is selected, the 

Bulletin 17B analysis editor will appear as shown in Figure B-39. 
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Figure B-39.  Bulletin 17B Analysis Editor for FFA Test 6. 

 

Shown in Figure B-39 are the general settings that were used to perform 

this frequency analysis.  As shown, the Skew option was set to use the 

Weighted Skew.  To use the weighted skew option, the user must enter a 

value for the Regional Skew and the Regional Skew Mean Square Error 

(MSE).  This selection requires the user to either look up a value from the 

generalized skew map of the United States, which is provided with 

Bulletin 17B, or develop a value from a regional analysis of nearby gages.  

In this example a value of 0.4 was taken from the generalized skew map of 

the U.S. from Bulletin 17B.  Bulletin 17B suggests using a Regional Skew 

MSE of 0.302 whenever regional skew values are taken from the map. 

Also for this example, the Expected Probability Curve option was 

selected to be computed in addition to the Log Pearson III computed 

curve.  The Median plotting position method was selected, as well as the 

default Confidence Limits of 0.05 (5 percent chance exceedance) and 

0.95 (95% chance exceedance).  Shown in Figure B-40 is the Bulletin 17B 

editor with the Options Tab selected. 
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Figure B-40.  Bulletin 17B Analysis Editor with Options Tab Shown for FFA 

Test 6. 

 

As shown in Figure B-40, the Historic Period Data option has been 

selected to reflect a historical flood event of 15,000 cfs in 1843 and an 

analysis period from 1843 to 1974.  Historic data is used to account for 

historic flood events large enough to be relevant to the analysis and not 

contained in the systematic data record.  The additional information 

provided by historic data can improve the flood frequency analysis, 

especially when the data collection period for a given area is relatively 

short. Information for a Historic Flood Peak has been entered to account 

for a peak flow of 15,000 cfs in the 1843 water year.  The Historic Period 

Start Year has been left blank.  By default this value will be the earliest 

year found in the historic flood peak data or the systematic record.  

Therefore for this example, 1843 will automatically be used for the Start 

Year of the Historic Period.  An End Year of 1974 has been entered.  The 

systematic record for the gage ended in 1955, however when this analysis 
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was performed in 1974, no other flood peaks of consequence had been 

observed between 1955 and 1974.  Therefore, 1974 is set as the End Year 

for the historic period analysis. 

Other features on this tab include the Low Outlier Threshold and the 

option to override the default Frequency Ordinates.  Neither option is 

selected in this example. 

Once all of the General and Optional settings are set or selected, the user 

can press the Compute button to perform the analysis.  Once the 

computations have been completed a message window will open stating 

Compute Complete.  Close this window and then select the Tabular 

Results tab from the analysis window.  The analysis window should look 

Figure B-41. 

 

Figure B-41.  Bulletin 17B Editor with the Results Tab Selected for FFA Test 6. 
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As shown in Figure B-41, the Frequency Curve table contains the 

following results: 

 Percent Chance Exceedance 

 Computed Curve (Log-Pearson III results) 

 Expected Probability Curve 

 Confidence Limits (5% and 95% chance exceedance curves) 

On the bottom left-hand side of the results tab is a table of Statistics for 

the observed station data (mean, standard deviation, station skew) and 

regional adjustment (regional skew, weighted skew, and adopted skew).  

Also on the bottom right-hand side of the results tab is a table of Number 

of Events showing the number of historic events used in the analysis, 

number of high outliers found, number of low outliers, number of zero or 

missing data years, number of systematic events in the gage record, and 

the historic record length (if historic data was entered). 

This example reports one historical flood event, and a historical period of 

132 years, between 1843 and 1974.  The reported statistics reflect the use 

of the historical data adjustment outlined in Bulletin 17B Appendix 6.  

The report file (described below) shows the initial computation of the 

statistics and frequency curve before the historical data was used, and the 

resulting statistics and frequency curve after the historical data is taken 

into account. 

In addition to the tabular results, a graphical plot of the computed 

frequency curves can be obtained by pressing the Plot Curve button at the 

bottom of the analysis window.  A plot of the results for this example is 

shown in Figure B-42. 
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Figure B-42.  Plot of the Frequency Curve Results for FFA Test 6. 

 

The tabular and graphical results can be sent to the printer or the windows 

clipboard for transfer into another piece of software.  To print the tabular 

results, select Print from the bottom of the analysis window.  To send the 

tabular results to the windows clipboard, highlight the data you want to 

send to the clipboard and then press the Control-C key sequence.  To print 

the graphical results, first bring up the graphical plot and then select Print 

from the File menu.  To send the graphic to the windows clipboard, select 

Copy to Clipboard from the File menu. 

In addition to the tabular and graphical results, there is a report file that 

shows the order in which the calculations were performed.  To review the 

report file, press the View Report button at the bottom of the analysis 

window.  When this button is selected a text viewer will open the report 

file and display it on the screen.  Shown in Figure B-43 is the report file 

for FFA Test 6. 



HEC-SSP User's Manual Appendix B – Example Data Sets 

 

 B-49 

The report file contains a listing of the input data, preliminary results, 

outlier and historical data tests, additional calculations needed, and the 

final frequency curve results.  Different types and amounts of information 

will show up in the report file depending on the data and the options that 

have been selected for the analysis. 

 

Figure B-43.  HEC-SSP Report File for FFA Test 6. 
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Example 7: Analyzing Stage Data 

This example demonstrates how to use the General Frequency analysis to 

analyze stage data.  The data for this example is annual maximum stage 

data for a reservoir.  The period of record used for this example is from 

1948 to 2004.  To view the data, right-click on the data record labeled 

"Reservoir Stage" in the study explorer and then select Tabulate.  The 

data will appear as shown in Figure B-44. 

 
Figure B-44.  Tabulation of the Peak Stage Data for Example 7. 

 

To plot the data for this example, right-click on the data record and then 

select Plot.  A plot of the data will appear as shown in Figure B-45. 
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Figure B-45.  Plot of the Reservoir Stage Data. 

 

A General Frequency analysis has been developed for this example.  To 

open the General Frequency analysis editor for this example, either 

double-click on the analysis labeled Stage Analysis Test 7 from the study 

explorer, or from the Analysis menu select open, then select Stage 

Analysis Test 7 from the list of available analyses.  When test 7 is opened, 

the General Frequency analysis editor will appear as shown in Figure B-

46.  For this analysis, the Do Not Use Log Transform option was 

selected, the Weibull plotting position method was selected, the default 

Confidence Limits were selected, and no modification was made to the 

time window. 
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Figure B-46.  General Frequency Analysis Editor for Stage Analysis Test 7. 

 

Shown in Figure B-47 is the General Frequency analysis editor with the 

Options Tab selected.  Features on this tab include the Low Outlier 

Threshold, adding Historic Date to the analysis, an option to override the 

default Frequency Ordinates, and Output Labeling.  The 0.1 percent 

frequency ordinate was added to the User Specified Frequency 

Ordinates table.    
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Figure B-47.  General Frequency Analysis Editor with Options Tab Shown for 

Stage Analysis Test 7. 

 

Once all of the General and Optional settings are set or selected, the user 

can choose to perform an Analytical or Graphical analysis.  In this 

example, a graphical analysis was performed on the peak stage data.  

Shown in Figure B-48 is the Graphical tab.  The frequency curve was 

entered manually into the User-Defined Graphical Curve table.  When 

the Compute button is pressed, the program plots the graphical frequency 

curve along with the annual maximum peak stage values.   
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Figure B-48.  General Frequency Graphical Tab Shown for Stage Analysis Test 

7. 

 

In addition to the table and plot available on the Graphical tab, a plot of 

the graphical frequency curves can be obtained by pressing the Plot 

Graphical Curve button at the bottom of the analysis window.  A plot of 

the results for this example is shown in Figure B-49. 
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Figure B-49.  Plot of the Frequency Curve Results for Stage Analysis Test 7. 

 

Graphical results can be sent to the printer or the windows clipboard for 

transfer into another piece of software.  To print the graphical results, first 

bring up the graphical plot and then select Print from the File menu.  To 

send the graphic to the windows clipboard, select Copy to Clipboard 

from the File menu. 

In addition to the tabular and graphical results, there is a report file that 

shows the order in which the calculations were performed.  To review the 

report file, press the View Report button at the bottom of the analysis 

window.  When this button is selected a text viewer will open the report 

file and display it on the screen.  Shown in Figure B-50 is the report file 

for Stage Analysis Test 7. 

The report file contains a listing of the input data, preliminary results, 

outlier and historical data tests, additional calculations needed, the final 

computed frequency curve results, and the user-defined graphical 

frequency curve.  Different types and amounts of information will show 
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up in the report file depending on the data and the options that have been 

selected for the analysis. 

 

Figure B-50.  Report File for Stage Analysis Test 7. 
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Example 8: Using User-Adjusted Statistics 

This example demonstrates how to use the General Frequency analysis 

and enter user-adjusted statistics.  The data for this example is from an 

analysis that computed local runoff for the Rio Grande at Albuquerque.  

The data includes unregulated daily average flows generated by rainfall-

runoff from areas downstream of upstream reservoirs.  The period of 

record used for this example is from 1944 to 2000.  To view the data, 

right-click on the data record labeled "Rio Grande at Alb Local Runoff" 

in the study explorer and then select Tabulate.  The data will appear as 

shown in Figure B-51. 

 
Figure B-51.  Tabulation of the Peak Flow Data for Example 8. 

 

To plot the data for this example, right-click on the data record and then 

select Plot.  A plot of the data will appear as shown in Figure B-52. 
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Figure B-52.  Plot of Data for Example 8. 

 

A General Frequency analysis has been developed for this example.  To 

open the General Frequency analysis editor for this example, either 

double-click on the analysis labeled Local Runoff at Alb Test 8 from the 

study explorer, or from the Analysis menu select open, then select Local 

Runoff at Alb Test 8 from the list of available analyses.  When test 8 is 

opened, the General Frequency analysis editor will appear as shown in 

Figure B-53. 



HEC-SSP User's Manual Appendix B – Example Data Sets 

 

 B-59 

 

Figure B-53.  General Frequency Analysis Editor for Local Runoff at Alb Test 8. 

 

Shown in Figure B-53 are the general settings that were used to perform 

this frequency analysis.  For this analysis, the Use Log Transform option 

was selected, the Weibull plotting position method was selected, the 

default Confidence Limits were selected, and no modification was made 

to the Time Window.   

Shown in Figure B-54 is the General Frequency analysis editor with the 

Options Tab selected.  Features on this tab include the Low Outlier 

Threshold, an option to use Historic Data, an option to override the 

default Frequency Ordinates, and Output Labeling.  All defaults 

settings were selected for this example.     
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Figure B-54.  General Frequency Analysis Editor with Options Tab Shown for 

Local Runoff at Alb Test 8. 

 

Once all of the General and Optional settings are set or selected, the user 

can choose to perform an Analytical or Graphical analysis.  In this 

example, an analytical analysis was performed.  Shown in Figure B-55 is 

the Settings tab for the analytical analysis.  As shown, the distribution 

selected for this example is LogPearsonIII.  The Skew option was set to 

Use Station Skew and the Do Not Compute Excepted Probability 

option was selected.  
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Figure B-55.  General Frequency Analysis Editor with Settings Tab Shown for 

Local Runoff at Alb Test 8. 

 

Press the Compute button to perform the analysis.  Once the computations 

have been completed, a message window will open stating Compute 

Complete.  Close this window and then select the Plot tab within the 

analytical analysis.  The analytical plot window should look Figure B-56. 
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Figure B-56.  The Plot Tab for Local Runoff at Alb Test 8. 

 

As shown in Figure B-56, the Plot tab contains a graph of the systematic 

data, the computed frequency curve, and the confidence limits.  The right 

side of the plot tab contains a table of Computed Statistics and User 

Statistics.  The user has the option to enter a mean, standard deviation, 

adopted skew, and equivalent years of record in the User Statistics table.  

The Compute button must be pressed after User Statistics have been 

entered in order for the program to compute a frequency curve using the 

user statistics.   

As mentioned at the beginning of this example, the annual peak flows 

were based on daily averaged flows.  In order to compute an instantaneous 

peak flow frequency curve, a relationship between daily averaged flows 

and the corresponding instantaneous peak flows was developed.  This was 

done by plotting daily averaged flow and the corresponding instantaneous 

peak flow for selected flood events.  Using this relationship, a Mean of 

3.371 was computed and entered in the User Statistics table and the 

analytical analysis was recomputed.   
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Figure B-57 shows that the frequency curve computed from the user-

adjusted statistics is added to the graph.  This figure also shows that the 

user does not have to enter values for all statistics in order for the program 

to compute a user-adjusted frequency curve.  The program will use 

statistics computed from the systematic and historic data if the statistics 

are not defined in the User Statistics table.  In this example, the program 

used the computed statistics for standard deviation, adopted skew, 

equivalent years of record and the user-defined mean of 3.371 when 

computing the user-adjusted frequency curve.  

 

Figure B-57.  Plot Tab with User Adjusted Statistics and Frequency Curves for 

Local Runoff at Alb Test 8. 

 

Select the Tabular Results tab to see information for both the computed 

and user-adjusted frequency curves.  As shown in Figure B-58, the 

Frequency Curve table contains the percent chance exceedance, computed 

curves (Log-Pearson III results), and the Confidence Limits (5% and 95% 

chance exceedance curves) for both the computed and user-adjusted 

statistics.  

On the bottom left-hand side of the results tab is a table of Statistics for 

the observed station data (mean, standard deviation, station skew) and 

regional adjustment (regional skew, weighted skew, and adopted skew).  

Also on the bottom right-hand side of the results tab is a table of Number 
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of Events showing the number of historic events used in the analysis, 

number of high outliers found, number of low outliers, number of zero or 

missing data years, number of systematic events in the gage record, and 

the historic record length (if historic data was entered). 

 

Figure B-58.  General Frequency Editor with Results Tab Selected for Local 

Runoff at Alb Test 8. 

 

In addition to the tabular results, a graphical plot of the computed 

frequency curves can be obtained by pressing the Plot Analytical Curve 

button at the bottom of the analysis window.  A plot of the results for this 

example is shown in Figure B-59. 
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Figure B-59.  Plot of the Frequency Curve Results for Local Runoff at Alb Test 

8. 

 

The tabular and graphical results can be sent to the printer or the windows 

clipboard for transfer into another piece of software.  To print the tabular 

results, select Print from the bottom of the analysis window.  To send the 

tabular results to the windows clipboard, highlight the data you want to 

send to the clipboard and then press the Control-C key sequence.  To print 

the graphical results, first bring up the graphical plot and then select Print 

from the File menu.  To send the graphic to the windows clipboard, select 

Copy to Clipboard from the File menu. 

In addition to the tabular and graphical results, there is a report file that 

shows the order in which the calculations were performed.  To review the 

report file, press the View Report button at the bottom of the analysis 

window.  When this button is selected a text viewer will open the report 

file and display it on the screen.  Shown in Figure B-60 is the report file 

for Local Runoff at Alb Test 8. 
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The report file contains a listing of the input data, preliminary results, 

outlier and historical data tests, additional calculations needed, and the 

final frequency curve results.  Different types and amounts of information 

will show up in the report file depending on the data and the options that 

have been selected for the analysis. 

 

Figure B-60.  Report File for Local Runoff at Alb Test 8. 
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Example 9: General Frequency – Graphical Analysis 

This example demonstrates how to create a Graphical Analysis within a 

General Frequency analysis.  The data for this example is from an analysis 

that computed regulated flow for the Rio Grande at Albuquerque.  The 

data includes regulated daily average flows from upstream reservoirs 

routed downstream to Albuquerque.  The period of record used for this 

example is from 1974 to 2002.  To view the data, right-click on the data 

record labeled "Rio Grande at Alb Reg Flow" in the study explorer and 

then select Tabulate.  The data will appear as shown in Figure B-61. 

 
Figure B-61.  Tabulation of the Peak Flow Data for Example 9. 
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To plot the data for this example, right-click on the data record and then 

select Plot.  A plot of the data will appear as shown in Figure B-62. 

 

Figure B-62.  Plot of Data for Example 9. 

 

A General Frequency analysis has been developed for this example.  To 

open the General Frequency analysis editor for this example, either 

double-click on the analysis labeled Reg Flow Rio Grande Test 9 from 

the study explorer, or from the Analysis menu select open, then select Reg 

Flow Rio Grande Test 9 from the list of available analyses.  When Test 9 

is opened, the General Frequency analysis editor will appear as shown in 

Figure B-63. 
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Figure B-63.  General Frequency Analysis Editor for Reg Flow Rio Grande Test 

9. 

 

Shown in Figure B-63 are the general settings that were used to perform 

this frequency analysis.  For this analysis, the Use Log Transform option 

was selected, the Weibull plotting position method was selected, the 

default Confidence Limits were selected, and no modification was made 

to the Time Window.   

Shown in Figure B-64 is the General Frequency analysis editor with the 

Options Tab selected.  Features on this tab include the Low Outlier 

Threshold, an option to use Historic Data, an option to override the 

default Frequency Ordinates, and Output Labeling.  All defaults 

settings were selected for this example.     



 Appendix B – Example Data Sets HEC-SSP User's Manual 

 

B-70 

 

Figure B-64.  General Frequency Analysis Editor with Options Tab Shown for 

Reg Flow Rio Grande Test 9. 

 

Once all of the General and Optional settings are set or selected, the user 

can choose to perform an Analytical or Graphical analysis.  In this 

example, a graphical analysis was performed.  Shown in Figure B-65 is 

the Graphical analysis tab.  As shown, a graph containing the systematic 

data and graphical curve is on the left side and a table containing the user-

entered frequency curve is on the right side of the window.  The frequency 

curve was entered manually into the User-Defined Graphical Curve 

table.  When the Compute button is pressed, the program plots the 

graphical frequency curve along with the annual maximum flow values.  

For this example, a reservoir model was used to route synthetic 

hydrographs through the reservoir network upstream of Albuquerque 

using current operating criteria.  This was done for the 0.2, 0.5, 1.0, 2.0, 

10, 20, and 50 percent events.  Output from the model was input into the 

Frequency Ordinates table.  For the more frequent events (10 year and 

below), the graphical curve was fit to the data visually.  This example 

shows how a reservoir network can influence the frequency curve.  Notice 
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how the frequency curve is flat for the 20 through the 1 percent chance 

events.  The reservoir network is able to control flooding in this range.  

This example also shows that as flood events become larger, the reservoir 

network has less influence on controlling downstream flooding.  

 

Figure B-65.  Graphical Tab Shown for Reg Flow Rio Grande Test 9. 

 

A graphical plot of the graphical frequency curve can be obtained by 

pressing the Plot Graphical Curve button at the bottom of the analysis 

window.  A plot of the results for this example is shown in Figure B-66. 
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Figure B-66.  Plot of the Frequency Curve Results for Reg Flow Rio Grande Test 

9. 

 

The graphical results can be sent to the printer or the windows clipboard 

for transfer into another piece of software.  To print the graphical results, 

first bring up the graphical plot and then select Print from the File menu.  

To send the graphic to the windows clipboard, select Copy to Clipboard 

from the File menu. 

In addition to the tabular and graphical results, there is a report file that 

shows the order in which the calculations were performed.  To review the 

report file, press the View Report button at the bottom of the analysis 

window.  When this button is selected a text viewer will open the report 

file and display it on the screen.  Shown in Figure B-67 is the report file 

for Reg Flow Rio Grande Test 9. 

The report file contains a listing of the input data, preliminary results, 

outlier and historical data tests, and additional calculations needed.  

Different types and amounts of information will show up in the report file 
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depending on the data and the options that have been selected for the 

analysis. 

 

Figure B-67.  Report File for Reg Flow Rio Grande Test 9. 
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Example 10: Volume Frequency Analysis, Maximum 
Flows 

This example demonstrates how to perform a Volume Frequency analysis 

for maximum flows.  The data for this example was derived from an 

analysis where a time-series of daily average unregulated flows were 

computed for the Rio Grande at Albuquerque.  The period of record for 

this example is from 1941 to 2002.  To view the data, right-click on the 

data record labeled "Rio Grande at Alb Unreg Daily" in the study 

explorer and then select Plot.  The data will appear as shown in Figure B-

68. 

 

Figure B-68.  Plot of Daily Average Flow for Example 10. 

 

A Volume Frequency analysis has been developed for this example.  To 

open the Volume Frequency Analysis editor for this example, either 

double-click on the analysis labeled Unreg Flow Rio Grande Test 10 

from the study explorer, or from the Analysis menu select open, then 
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select Unreg Flow Rio Grande Test 10 from the list of available 

analyses.  When test 10 is opened, the Volume Frequency Analysis editor 

will appear as shown in Figure B-69. 

 

Figure B-69.  Volume Frequency Analysis Editor for Unreg Flow Rio Grande 

Test 10. 

 

Shown in Figure B-69 are the general settings that were used to perform 

this frequency analysis.  For this analysis, the Use Log Transform option 

was selected, the Weibull plotting position method was selected, Analyze 

Maximums was selected, the Calendar Year option was selected, and no 

modification was made to the Time Window.   

Shown in Figure B-70 is the Volume Frequency Analysis editor with the 

Options Tab selected.  Features on this tab include an option to override 

the default Flow Duration values, an option to override the default 
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Frequency Ordinates, and Output Labeling.  Both the flow-duration 

and frequency ordinate tables were modified. 

 

Figure B-70.  Options Tab Shown for Unreg Flow Rio Grande Test 10. 

 

Once all of the General and Optional settings are set or selected, the user 

can extract the volume-duration data from the time-series of daily flows.  

Select the Duration Data tab and press the Extract Volume-Duration 

Data button at the bottom of the table.  The table should then fill with the 

flow-duration values, as shown in Figure B-71. 
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Figure B-71.  Volume-Duration Data Table for Unreg Flow Rio Grande Test 10. 

 

Once the data has been extracted, the user must choose to perform an 

Analytical or Graphical analysis.  In this example, an analytical analysis 

was performed.  Shown in Figure B-72 is the Settings tab for the 

analytical analysis.  As shown, the distribution selected for this example is 

LogPearsonIII.  The Skew option was set to Use Station Skew and the Do 

Not Compute Excepted Probability option was selected.  
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Figure B-72.  Settings Tab Shown for Unreg Flow Rio Grande Test 10. 

 

Press the Compute button to perform the analysis.  A message window 

will open stating that a few of the annual maximums occurred during the 

beginning of the year.  The message suggests that the user change the 

year/season specification to capture independent events.  You want to 

minimize the possibility that the same flood event is used for consecutive 

years.  Press the OK button to finish the compute.  Once the computations 

have been completed, a message window will open stating Compute 

Complete.  Close this window and then select the Tabular Results tab 

within the analytical analysis.  The results table should look Figure B-73.  

The top portion of the results table contains the percent chance exceedance 

for all durations (the report contains confidence limits).  The bottom 

portion of the results table contains the statistics for all duration. 
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Figure B-73.  Tabular Results Tab for Unreg Flow Rio Grande Test 10. 

Note: These tabular results use the default computed statistics. 

 

 

As shown in Figure B-74, the Plot tab contains a graph of the systematic 

data and the computed frequency curves.  Notice how some of the 

frequency curves look like they might cross if the lines were extended.  

The Statistics tab can be used to modify the computed statistics to ensure 

that the frequency curves are consistent. 
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Figure B-74.  Plot Tab for Unreg Flow Rio Grande Test 10. 

 

For this example, the standard deviation and the adopted skew values were 

modified to make sure the volume frequency curves were consistent.  As 

shown in Figure B-75, the check boxes next to mean, standard deviation, 

and adopted skew were checked and then user-adjusted statistics were 

entered into the table for all durations.  The Compute button must be 

pressed after adjusted statistics have been entered in order for the program 

to recompute the frequency curves using the user-adjusted statistics.  

Figure B-76 shows the Plot tab after the user-adjusted statistics were 

entered on the Statistics tab.  Results on the Tabular Results tab will also 

update when user-adjusted statistics are entered on the Statistics tab.    
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Figure B-75.  Statistics Tab for Unreg Flow Rio Grande Test 10. 
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Figure B-76.  Plot Tab for Unreg Flow Rio Grande Test 10 After the Statistics 

were Adjusted on the Statistics Tab.  

 

In addition to the Tabular Results and Plot tabs, graphical plots can be 

opened by selecting the Plot Duration Data or Plot Analytical Curve 

buttons at the bottom of the analysis window.  A plot of the results for this 

example is shown in Figure B-77. 
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Figure B-77.  Plot of the Frequency Curve Results for Unreg Flow Rio Grande 

Test 10. 

 

The tabular and graphical results can be sent to the printer or the windows 

clipboard for transfer into another piece of software.  To print the tabular 

results, select Print from the bottom of the analysis window.  To send the 

tabular results to the windows clipboard, highlight the data you want to 

send to the clipboard and then press the Control-C key sequence.  To print 

the graphical results, first bring up the graphical plot and then select Print 

from the File menu.  To send the graphic to the windows clipboard, select 

Copy to Clipboard from the File menu. 

In addition to the tabular and graphical results, there is a report file that 

shows the order in which the calculations were performed.  To review the 

report file, press the View Report button at the bottom of the analysis 

window.  When this button is selected a text viewer will open the report 

file and display it on the screen.  Shown in Figure B-78 is the report file 

for Unreg Flow Rio Grande Test 10. 

The report file contains a listing of the input data, preliminary results, 

outlier and historical data tests, additional calculations needed, and the 

final frequency curve results.  Different types and amounts of information 
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will show up in the report file depending on the data and the options that 

have been selected for the analysis. 

 

Figure B-78.  Report File for Unreg Flow Rio Grande Test 10. 
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Example 11: Volume Frequency Analysis, Minimum 
Flows 

This example demonstrates how to create a low flow Volume Frequency 

analysis.  The data for this example was downloaded from the USGS.  It is 

comprised of daily average flow for the Chattahoochee River at Cornelia, 

Georgia.  Drought conditions were occurring in the region at the time of 

this analysis.  Among other things, a low flow analysis can be used to 

determine the severity of a drought.  The period of record for this example 

is from 1957 to 2007.  To view the data, right-click on the data record 

labeled "Chattahoochee River" in the study explorer and then select Plot.  

The data will appear as shown in Figure B-79.   

 

Figure B-79.  Plot of Daily Average Flow for Example 11. 

 

A Volume Frequency analysis has been developed for this example.  To 

open the Volume Frequency Analysis editor for this example, either 

double-click on the analysis labeled Low Flow Analysis Test 11 from the 
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study explorer, or from the Analysis menu select open, then select Low 

Flow Analysis Test 11 from the list of available analyses.  When test 11 is 

opened, the Volume Frequency Analysis editor will appear as shown in 

Figure B-80. 

 

Figure B-80.  Volume Frequency Analysis Editor for Low Flow Analysis Test 

11. 

 

Shown in Figure B-80 are the general settings that were used to perform 

this frequency analysis.  For this analysis, the Use Log Transform option 

was selected, the Weibull plotting position method was selected, Analyze 

Minimums was selected, and the Calendar Year option was selected.  

The Calendar Year option was selected because low flows are possible in 

late September, early November.  Starting the year on January 1 
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minimizes the possibility of using the same low flow event in multiple 

years.  An end date of 31 December 2007 was entered in the Time 

Window Modification.  This end date was specified because not all the 

data for the summer of 2008 was available at the time of the analysis.    

Shown in Figure B-81 is the Volume Frequency Analysis editor with the 

Options Tab selected.  Features on this tab include an option to override 

the default Flow Duration values, an option to override the default 

Frequency Ordinates, and Output Labeling.     

 

Figure B-81.  Options Tab Shown for Low Flow Analysis Test 11. 

 

Once all of the General and Optional settings are set or selected, the user 

can extract the volume-duration data.  Select the Duration Data tab and 

press the Extract Volume-Duration Data button at the bottom of the 
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table.  The table should then fill with the flow-duration values, as shown 

in Figure B-82. 

 

Figure B-82.  Volume-Duration Data Table for Low Flow Analysis Test 11. 

 

Once the data has been extracted, the user must choose to perform an 

Analytical or Graphical analysis.  In this example, an analytical analysis 

was performed.  Shown in Figure B-83 is the Settings tab for the 

analytical analysis.  As shown, the distribution selected for this example is 

LogPearsonIII.  The Skew option was set to Use Station Skew and the Do 

Not Compute Excepted Probability option was selected.  



HEC-SSP User's Manual Appendix B – Example Data Sets 

 

 B-89 

 

Figure B-83.  Settings Tab Shown for Low Flow Analysis Test 11. 

 

Press the Compute button to perform the analysis.  A message window 

will open stating that a few of the annual maximums occurred during the 

beginning of the year.  The message suggests that the user change the 

year/season specification to capture independent events.  You want to 

minimize the possibility that the same flood event is used for consecutive 

years.  Press the OK button to finish the computation.  Once the 

computations have been completed, a message window will open stating 

Compute Complete.  Close this window and then select the Tabular 

Results tab within the analytical analysis.  The results table should look 

Figure B-84.  The top portion of the results table contains the percent 

chance exceedance for all durations (the report contains confidence 
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limits).  The bottom portion of the results table contains the statistics for 

all durations. 

 

Figure B-84.  Tabular Results Tab for Low Flow Analysis Test 11. 

Note: These tabular results use the default computed statistics. 

 

As shown in Figure B-85, the Plot contains a graph of the systematic data 

and the computed frequency curves.  Notice how some of the frequency 

curves look like they might cross if the lines were extended.  The 

Statistics tab can be used to modify the computed statistics to ensure that 

the frequency curves are consistent.   



HEC-SSP User's Manual Appendix B – Example Data Sets 

 

 B-91 

 

Figure B-85.  Plot for Low Flow Analysis Test 11. 

 

For this example, the standard deviation and the adopted skew were 

modified to make sure the volume frequency curves were consistent.  As 

shown in Figure B-86, the check boxes next to mean, standard deviation, 

and adopted skew were checked and then user-adjusted statistics were 

entered into the table for all durations.  The Compute button must be 

pressed after adjusted statistics have been entered in order for the program 

to recompute the frequency curves using the user-adjusted statistics.  

Figure B-87 shows the Plot tab after the user-adjusted statistics were 

entered on the Statistics tab.  Results in the Tabular Results table will 

also update when user-adjusted statistics are entered on the Statistics tab.    
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Figure B-86.  Statistics Tab for Low Flow Analysis Test 11. 
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Figure B-87.  Plot Tab for Low Flow Analysis Test 11. 

 

In addition to the Tabular Results and Plot tabs, graphical plots can be 

opened by selecting the Plot Duration Data or Plot Analytical Curve 

buttons at the bottom of the analysis window.  A plot of the results for this 

example is shown in Figure B-88. 
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Figure B-88.  Plot of the Frequency Curve Results for Low Flow Analysis Test 

11. 

 

The tabular and graphical results can be sent to the printer or the windows 

clipboard for transfer into another piece of software.  To print the tabular 

results, select Print from the bottom of the analysis window.  To send the 

tabular results to the windows clipboard, highlight the data you want to 

send to the clipboard and then press the Control-C key sequence.  To print 

the graphical results, first bring up the graphical plot and then select Print 

from the File menu.  To send the graphic to the windows clipboard, select 

Copy to Clipboard from the File menu. 

In addition to the tabular and graphical results, there is a report file that 

shows the order in which the calculations were performed.  To review the 

report file, press the View Report button at the bottom of the analysis 

window.  When this button is selected a text viewer will open the report 

file and display it on the screen.  Shown in Figure B-89 is the report file 

for Low Flow Analysis Test 11. 

The report file contains a listing of the input data, preliminary results, 

outlier and historical data tests, additional calculations needed, and the 

final frequency curve results.  Different types and amounts of information 

will show up in the report file depending on the data and the options that 

have been selected for the analysis. 
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Figure B-89.  Report File for Low Flow Analysis Test 11. 
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Example 12: Duration Analysis, BIN (STATS) Method 

This example demonstrates how to use the Duration analysis.  The data for 

this example is daily average flow from the Fishkill Creek (Beacon NY) 

USGS stream gage.  The period of record used for this example is from 01 

Oct, 1944 to 30 Sep, 1968.  To view the data, right-click on the data 

record labeled "Fishkill Creek-Daily Flow" in the study explorer and then 

select Plot.  The data will appear as shown in Figure B-90. 

 
Figure B-90.  Plot of the Daily Average Flow for Example 12. 

 

A Duration analysis has been developed for this example.  To open the 

analysis editor for this example, either double-click on the analysis labeled 

Fishkill Creek Test 12 from the study explorer, or from the Analysis 

menu select open, then select Fishkill Creek Test 12 from the list of 

available analyses.  When Test 12 is opened, the duration analysis editor 

will appear as shown in Figure B-91. 
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Figure B-91.  Duration Analysis Editor for Fishkill Creek Test 12. 

 

Shown in Figure B-91 are the general settings that were used to perform 

this duration analysis.  For this analysis, the Bin (STATS) method was 

selected, the x-axis scale was set to Linear, the y-axis scale was set to 

Linear, and the Annual duration period was selected.   

The Options Tab is shown in Figure B-92.  Features on this tab include 

Output Labeling, the Percent of Time Exceeded ordinates, and Bin 

Limits.  The Bin Limits panel is active in this example because the Bin 

(STATS) method was selected on the General tab.  The User-Defined bin 

limits method was selected and the bin limits were entered manually.   
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Figure B-92.  Duration Analysis Editor with Options Tab Shown for Fishkill 

Creek Test 12. 

 

Once all of the General and Optional settings are set or selected, the user 

can choose to compute the analysis by pressing the Compute button.  

Once the computations have been completed, a message window will open 

stating Compute Complete.  Close this window and then select the 

Results tab, shown in Figure B-93. 
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Figure B-93.  The Results Tab for Fishkill Creek Test 12. 

 

As shown in Figure B-93, the Result tab contains both tabular and 

graphical results.  The Tabular Results tab contains a table with 

information about the bins, like the lower bin limit, the number of values 

in the bin, the accumulated number of values greater than or equal to the 

lower bin limit, and the percent of time equaled or exceeded for each bin.  

Tabular results also include a table of the duration curve interpolated to 

the percent of time exceeded ordinates defined on the Options tab.  The 

Plot tab contains a graph of the duration curve, shown in Figure B-94.  

The plot includes the computed duration curve and the duration curve 

interpolated to the user-defined percent of time exceeded ordinates.  The 

duration curve plot can also be opened by pressing the Plot Duration 

Curve button at the bottom of the analysis window.   
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Figure B-94.  Plot Tab for Fishkill Creek Test 12. 

 

The tabular and graphical results can be sent to the printer or the windows 

clipboard for transfer into another piece of software.  To print the tabular 

results, select Print from the bottom of the analysis window.  To send the 

tabular results to the windows clipboard, highlight the data you want to 

send to the clipboard and then press the Control-C key sequence.  To print 

the graphical results, first bring up the graphical plot and then select Print 

from the File menu.  To send the graphic to the windows clipboard, select 

Copy to Clipboard from the File menu. 

In addition to the tabular and graphical results, there is a report file that 

shows the input data and results for the analysis.  To review the report file, 

press the View Report button at the bottom of the analysis window.  

When this button is selected a text viewer will open the report file and 

display it on the screen.  Shown in Figure B-95 is the report file for 

Fishkill Creek Test 12. 
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Figure B-95.  Report File for Fishkill Creek Test 12. 
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Example 13: Duration Analysis, Rank All Data Method 

This example demonstrates how to use the Duration analysis.  The data for 

this example is daily average flow and the period of record is from 01 Apr, 

1899 to 28 Jan, 2010.  To view the data, right-click on the data record 

labeled "Wondering River-Franklin" in the study explorer and then 

select Plot.  The data will appear as shown in Figure B-96. 

 
Figure B-96.  Plot of the Daily Average Flow for Example 13. 

 

A Duration analysis has been developed for this example.  To open the 

analysis editor for this example, either double-click on the analysis labeled 

Duration Curve Test 13 from the study explorer, or from the Analysis 

menu select open, then select Duration Curve Test 13 from the list of 

available analyses.  When Duration Curve Test 13 is opened, the 

duration analysis editor will appear as shown in Figure B-97. 
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Figure B-97.  Duration Analysis Editor for Duration Curve Test 13. 

 

Shown in Figure B-97 are the general settings that were used to perform 

this duration analysis.  For this analysis, the Rank All DataValues 

method was selected, x-axis scale was set to Linear, the y-axis scale was 

set to Log, and the Annual duration period was selected.   

The Options Tab is shown in Figure B-98.  Features on this tab include 

Output Labeling, the Percent of Time Exceeded ordinates, and Bin 

Limits.  The Bin Limits panel is not active in this example because the 

Bin (STATS) method was not selected on the General tab. 
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Figure B-98.  Duration Analysis Editor with Options Tab Shown for Duration 

Curve Test 13. 

 

Once all of the General and Optional settings are set or selected, the user 

can choose to compute the analysis by pressing the Compute button.  

Once the computations have been completed, a message window will open 

stating Compute Complete.  Close this window and then select the 

Results tab, shown in Figure B-99. 
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Figure B-99.  The Results Tab for Duration Curve Test 13. 

 

As shown in Figure B-99, the Result tab contains both tabular and 

graphical results.  The Tabular Results tab contains a table of the 

duration curve interpolated to the percent of time exceeded ordinates 

defined on the Options tab.  The Plot tab contains a graph of the duration 

curve.  The plot includes the computed duration curve and the duration 

curve interpolated to the user-defined percent of time exceeded ordinates.  

The duration curve plot can also be opened by pressing the Plot Duration 

Curve button at the bottom of the analysis window, shown in Figure B-

100.   
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Figure B-100.  Plot Tab for Duration Curve Test 13. 

 

The tabular and graphical results can be sent to the printer or the windows 

clipboard for transfer into another piece of software.  To print the tabular 

results, select Print from the bottom of the analysis window.  To send the 

tabular results to the windows clipboard, highlight the data you want to 

send to the clipboard and then press the Control-C key sequence.  To print 

the graphical results, first bring up the graphical plot and then select Print 

from the File menu.  To send the graphic to the windows clipboard, select 

Copy to Clipboard from the File menu. 

In addition to the tabular and graphical results, there is a report file that 

shows the input data and results for the analysis.  To review the report file, 

press the View Report button at the bottom of the analysis window.  

When this button is selected a text viewer will open the report file and 

display it on the screen.  Shown in Figure B-101 is the report file for 

Duration Curve Test 13. 
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Figure B-101.  Report File for Duration Curve Test 13. 
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Example 14: Duration Analysis, Manual Entry 

This example demonstrates how to use the Duration analysis and enter the 

duration curve manually.  To open the analysis editor for this example, 

either double-click on the analysis labeled Manual Duration Curve Test 

14 from the study explorer, or from the Analysis menu select open, then 

select Manual Duration Curve Test 14 from the list of available 

analyses.  As shown in Figure B-102, the “None” data set was selected for 

this analysis.  The Manual Entry tab becomes active when the “None” 

data set is selected (the Result tab will become inactive).    

 

Figure B-102.  Duration Analysis Editor for Manual Duration Curve Test 14. 

 

The y-axis scale was set to Log while all other default options were 

selected on the General and Options tabs.  Figure B-103 shows the 

Manual Entry tab for Manual Duration Curve Test 14.  A variable 

name of “FLOW” and units of “cfs” were entered as well as the duration 

curve.  The program will plot the duration curve when the Compute 

button is pressed.         
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Figure B-103.  Duration Analysis Editor with Options Tab Shown for Manual 

Duration Curve Test 14. 

 

The duration curve plot can also be opened by pressing the Plot Duration 

Curve button at the bottom of the analysis window, shown in Figure B-

104.   

 



 Appendix B – Example Data Sets HEC-SSP User's Manual 

 

B-110 

 

Figure B-104.  Plot Tab for Manual Duration Curve Test 14. 
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Example 15: Coincident Frequency Analysis, A and B 
can be Assumed Independent 

This example demonstrates how to create a coincident frequency analysis.  

Figure B-105 illustrates the scenario for Coincident Freq Test 15.  The 

goal of this example is to develop a stage-frequency curve at a point along 

the tributary (variable C) given flows on the tributary (variable A) and 

flows in the mainstem (variable B).  Large flows on the mainstem do 

cause backwater along the tributary and thus affect the stage at the point of 

interest.  The data for this example comes from an existing flow frequency 

curve for Variable A and an existing flow duration curve for Variable B.  

An HEC-RAS model was used to simulate the response of Variable C 

(stage at the point of interest) for multiple combinations of flow on the 

tributary and flow in the mainstem.   

 

 
Figure B-105.  Scenario for Coincident Freq Test 15.  

 

A Coincident Frequency analysis has been developed for this example.  To 

open the Coincident Frequency Analysis editor for this example, either 

double-click on the analysis labeled Coincident Freq Test 15 from the 

study explorer, or from the Analysis menu select open, then select 

Coincident Freq Test 15 from the list of available analyses.  When 

Coincident Freq Test 15 is opened, the Coincident Frequency Analysis 

editor will appear as shown in Figure B-106. 
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Figure B-106.  General Tab Shown for Coincident Freq Test 15.  

 

Shown in Figure B-106 are the general settings for this coincident 

frequency analysis.  For this analysis, the A and B can be Assumed 

Independent (Marginal Frequency Curve for A) option was selected.  

This would be determined by performing a correlation analysis between 

variables A and B; little correlation would indicate that variables A and B 

could be assumed independent.  The number of variable B index values 

was set to 9, the Data Name was set to “Stage” and the Data Units to 

“feet”, and the y-axis scale was set to Linear.   

Shown in Figure B-107 is the Coincident Frequency Analysis editor with 

the Variable A Tab selected.  The Manual Entry option was selected 

and a Data Name of “Flow” and Data Units of “cfs” were entered.  The 

frequency curve values were manually entered into the Variable A 

Frequency Curve table.  
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Figure B-107.  Variable A Tab for Coincident Freq Test 15. 

 

Shown in Figure B-108 is the Coincident Frequency Analysis editor with 

the Variable B tab selected.  The Duration Curve from Test 13 was 

selected in the drop-down list.  Once selected, the duration curve table 

automatically fills with the computed ordinates from the duration curve.  

In the Develop Probabilities from Duration Curve panel, the Define 

Automatically option was selected.  This option uses a predefined 

probability pattern to discretize the duration curve into index points.  The 

Generate Table button was pressed in order activate the predefined 

probability pattern.  In this example, the first index value is 3005.92 (cfs).  

This value is taken at the midpoint between percent of time exceeded 

values at 100 and 60 percent (from Duration Curve Test 13).  This index 

value is assigned a probability of 40 percent; this flow value could be 

expected 40 percent of the time.  The second index value is 8095.9.  This 

value is taken at the midpoint between percent of time exceeded values at 

60 and 40 percent and is assigned a probability of 20 percent.        
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Figure B-108.  Variable B Tab for Coincident Freq Test 15. 

 

Once the Variable A and Variable B tabs have been completed, the user 

can populate the response curves table.  Figure B-109 shows the Response 

Curves tab for Coincident Freq Test 15.  The Same Variable A for 

Each Index option was selected and the Import Variable A button was 

pressed to automatically copy values from the Variable A tab and fill in 

the Variable A column.  The remaining columns in the table were 

populated with results from a hydraulics model.  For example, the first 

value in the second column is 479.16.  This value is the stage at the point 

of interest given a flow of 60219.18 (cfs) on the tributary (variable A) and 

a flow of 3005.92 (cfs) on the mainstem (variable B).  A total of 108 

simulations were required from the hydraulics model to fill in the response 

curves table.  Figure B-110 shows a plot of the response surface.  The plot 

shows variable A (x-axis) and variable C (y-axis).  For this example, the 

response surface shows that flows greater than 53000 (7th index point) on 

the mainstem affect the stage at the point of interest on the tributary.  

When the flow in the mainstem is below 53000 (cfs), only the flow on the 

tributary affects the stage at the point of interest.  
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Figure B-109.  Response Curves Tab for Coincident Freq Test 15. 

 

 
Figure B-110.  Response Curves Plot for Coincident Freq Test 15. 
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Press the Compute button to perform the analysis.  Once the computations 

have been completed, a message window will open stating Compute 

Complete.  Close this window and then select the Results tab.  The results 

tab should look Figure B-111.  The left portion of the results tab contains 

the computed variable C frequency curve and the right portion of the 

results tab contains a plot of the computed variable C frequency curve.   

 

Figure B-111.  Results Tab for Coincident Freq Test 15. 

 

The tabular and graphical results can be sent to the printer or the windows 

clipboard for transfer into another piece of software.  To print the tabular 

results, select Print from the bottom of the analysis window.  To send the 

tabular results to the windows clipboard, highlight the data you want to 

send to the clipboard and then press the Control-C key sequence.  To print 

the graphical results, first bring up the graphical plot by pressing the Plot 

button from the bottom of the analysis.  Then select Print from the File 

menu.  To send the graphic to the windows clipboard, select Copy to 

Clipboard from the File menu. 
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In addition to the tabular and graphical results, there is a report file that 

shows input data and results.  To review the report file, press the View 

Report button at the bottom of the analysis window.  When this button is 

selected a text viewer will open the report file and display it on the screen.  

Shown in Figure B-112 is the report file for Coincident Freq Test 15. 

 

Figure B-112.  Report File for Coincident Freq Test 15. 
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Example 16: Coincident Frequency Analysis, A and B 
can not be Assumed Independent 

This example demonstrates how to create a coincident frequency analysis 

when variables A and B are not independent.  Figure B-113 illustrates the 

scenario for Coincident Freq Test 16.  The goal of this example is to 

develop a stage-frequency curve at a point along the tributary (variable C) 

given flows on the tributary (variable A) and flows in the mainstem 

(variable B).  Large flows on the mainstem do cause backwater along the 

tributary and thus affect the stage at the point of interest.  The data for this 

example comes from existing conditional flow frequency curves for 

Variable A and an existing flow duration curve for variable B.  An HEC-

RAS model was used to simulate the response of variable C (stage at the 

point of interest) for multiple combinations of flow on the tributary and 

flow in the mainstem.   

 

 
Figure B-113.  Scenario for Coincident Freq Test 16.  

 

A Coincident Frequency analysis has been developed for this example.  To 

open the Coincident Frequency analysis editor for Coincident Freq Test 

16, either double-click on the analysis labeled Coincident Freq Test 16 

from the study explorer, or from the Analysis menu select open, then 

select Coincident Freq Test 16 from the list of available analyses.  When 

Coincident Freq Test 16 is opened, the Coincident Frequency analysis 

editor will appear as shown in Figure B-114. 
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Figure B-114.  General Tab Shown for Coincident Freq Test 16.  

 

Shown in Figure B-114 are the general settings for this coincident 

frequency analysis.  For this analysis, the A and B can not be Assumed 

Independent (Conditional Frequency Curve for A) option was selected.  

This would be determined by performing a correlation analysis between 

variables A and B; a correlation coefficient in the range of 0.3 – 0.7 would 

indicate that variables A and B could not be assumed independent.  The 

number of variable B index values was set to 9, the Data Name was set to 

“Stage” and the Data Units to “feet”, and the Y-Axis scale was set to 

Linear.   

Shown in Figure B-115 is the Coincident Frequency Analysis editor with 

the Variable A Tab selected.  A Data Name of “Flow” and Data Units 

of “cfs” were entered.  A separate frequency curve for variable A was 

developed for each index value defined on the Variable B tab.  For 

example, the frequency curve in the “Flow P(A|B1)” column is the 

variable A frequency curve for the 1st variable B index value.  The 

variable B tab shows the 1st index value, 3005.92, is assigned a proportion 

of time of 40 percent.  Therefore, the 1st variable A frequency curve was 
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developed using annual peak flows on the tributary when flows in the 

mainstem were in the range of the 1st variable B index value.  For this 

example, a multivariate lognormal  random number generator was used to 

develop a large enough data set so that variable A frequency curves could 

be computed for each variable B index value.  The random numbers were 

generated using statistics from the annual peak flows occurring on the 

tributary, statistics from the coincident (same day) flows occurring on the 

main stem, and the covariance between the two datasets.    

 

Figure B-115.  Variable A Tab for Coincident Freq Test 16. 

 

Shown in Figure B-116 is the Coincident Frequency analysis editor with 

the Variable B Tab selected.  No duration curve was selected for this 

example.  In the Develop Probabilities from Duration Curve panel, the 

User-Specified Index Points and Probability Ranges option was 

selected.  The probabilities and index values were defined manually and 

the Generate Table button was pressed in order to compute the Break 

Points.   

http://www.google.com/search?hl=en&&sa=X&ei=Ktp2TObFDI-isQPRmtWgDQ&ved=0CBEQBSgA&q=multivariate+lognormal&spell=1
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Figure B-116.  Variable B Tab for Coincident Freq Test 16. 

 

Once the Variable A and Variable B tabs have been completed, the user 

can populate the response curves table.  Figure B-117 shows the Response 

Curves tab for Coincident Freq Test 16.  The Different Variable A for 

Each Index option was selected.  When selected, a separate Variable A 

column is added for each variable B index value.   For example, the first 

Variable A column is linked to the C = f(A,B1) column.  The second 

variable A column is lined to the C = f(A,B2), and so on.  The Import 

Variable A button was pressed to automatically copy values from the 

Variable A tab to fill in appropriate Variable A column.  The remaining 

columns in the table were populated with results from the hydraulics 

model.  For example, the first value in the second column is 473.95.  This 

value is the stage at the point of interest given a flow of 42464 (cfs) on the 

tributary (variable A) and a flow of 3005.92 (cfs) on the mainstem 

(variable B).  A total of 108 simulations were required from the hydraulics 

model to fill in the response curves table.   
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Figure B-117.  Response Curves Tab for Coincident Freq Test 16. 

 

Press the Compute button to perform the analysis.  Once the computations 

have been completed, a message window will open stating Compute 

Complete.  Close this window and then select the Results tab.  The 

Results tab should look Figure B-118.  The left portion of the results tab 

contains the computed variable C frequency curve and the right portion of 

the results tab contains a plot of the computed variable C frequency curve.   
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Figure B-118.  Results Tab for Coincident Freq Test 16. 

 

The tabular and graphical results can be sent to the printer or the windows 

clipboard for transfer into another piece of software.  To print the tabular 

results, select Print from the bottom of the analysis window.  To send the 

tabular results to the windows clipboard, highlight the data you want to 

send to the clipboard and then press the Control-C key sequence.  To print 

the graphical results, first bring up the graphical plot by pressing the Plot 

button from the bottom of the analysis.  Then select Print from the File 

menu.  To send the graphic to the windows clipboard, select Copy to 

Clipboard from the File menu. 

In addition to the tabular and graphical results, there is a report file that 

shows input data and results.  To review the report file, press the View 

Report button at the bottom of the analysis window.  When this button is 

selected a text viewer will open the report file and display it on the screen.  

Shown in Figure B-119 is the report file for Coincident Freq Test 16. 
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Figure B-119.  Report File for Coincident Freq Test 16. 
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Example 17: Balanced Hydrograph Analysis, Using an 
Historical Event Hydrograph 

This example demonstrates how to create a Balanced Hydrograph 

analysis using an historical event hydrograph shape.  In this example, 

information from previously-computed Bulletin 17 and Volume 

Frequency analyses will be used along with an historical event to create 

numerous balanced hydrographs which are “balanced” across multiple 

durations. 

A Balanced Hydrograph analysis has been developed for this example.  To 

open the Balanced Hydrograph analysis editor for this example, either 

double-click on the analysis labeled Balanced Hydrograph Test 17 from 

the study explorer, or from the Analysis menu select open, then select 

Balanced Hydrograph Test 17 from the list of available analyses.  When 

test 17 is opened, the Balanced Hydrograph Analysis editor will appear as 

shown in Figure B-120. 

 
Figure B-120.  General Tab Shown for Balanced Hydrograph Test 17. 

 

Shown in Figure B-120 are the general settings for this curve combination 

analysis.  The Number of Durations was set to three: 0.0417-days (1-
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hour), 1-day, and 3-days.  These three durations are those which will be 

used to “balance” throughout the analysis.  The DSS Range was set to 

16Sep2004 through 29Sep2004, which corresponded to the passage of the 

remnants of Tropical Storm Ivan, as shown in Figure B-121. 

 

Figure B-121.  DSS Time Window Used within Balanced Hydrograph 

Test 17. 

 

The number of probabilities was set to six: 0.2, 0.5, 1, 2, 5, and 10 percent 

frequencies.  Using six probabilities will result in the creation of six 

balanced hydrographs.  The frequency ordinates were left as the default 

values. 

Shown in Figure B-122 is the Balanced Hydrograph analysis editor with 

the Frequency Curves tab selected.  Frequency Curve Duration 1 was 

manually defined using results from the Bulletin 17 analysis named 

“Sinnemahoning_B17C”.  Frequency Curve Duration 1 corresponds to a 

duration of 0.0417-days or 1-hour.  It is assumed that the Log Pearson 

Type III distribution that was fit within the “Sinnemahoning_B17C” 

Bulletin 17 analysis is indicative of a 0.0417-day duration.  Log Pearson 

Type III parameters were entered for both Frequency Curve Duration 2 

and Frequency Curve Duration 3 using results from the Volume 

Frequency analysis named “Sinnemahoning_VolumeFrequency”.  

Frequency Curve Duration 2 uses the 1-day results while Frequency Curve 

Time Window
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Duration 3 uses the 3-day statistics from the Volume Frequency analysis.  

Figure B-123 shows the plotted frequency curves for this analysis. 

 

Figure B-122.  Frequency Curves Tab for Balanced Hydrograph Test 17. 
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Figure B-123.  Plotted Frequency Curves for Balanced Hydrograph Test 17. 

 

Press the Compute button to perform the analysis.  Once the computations 

have been completed, a message window will open stating Compute 

Complete.  Close this window and then select the Results tab.  The results 

tab should look Figure B-124.  The left portion of the Results tab window 

displays the computed balanced hydrographs in a table using the six 

frequencies that were previously defined on the General tab.  The right 

portion of the Results tab displays all six balanced hydrographs in a plot.  

To view the balanced hydrographs in a separate window, either click Plot 

Balanced Hydrograph or double click on the plot within the Results tab. 
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Figure B-124.  Results Tab for Balanced Hydrograph Test 17. 

 

In addition to the tabular and graphical results, there is a report file that 

shows input data and results.  To review the report file, press the View 

Report button at the bottom of the analysis window.  When this button is 

selected a text viewer will open the report file and display it on the screen.  

Shown in Figure B-125 is the report file for Balanced Hydrograph Test 

17. 
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Figure B-125.  Report File for Balanced Hydrograph Test 17. 

 

 

 

 

 

 

 

 

  



HEC-SSP User's Manual Appendix B – Example Data Sets 

 

 B-131 

Example 18: Balanced Hydrograph Analysis, Using a 
Triangular-shaped Hydrograph 

This example demonstrates how to create a Balanced Hydrograph 

analysis using a hypothetical triangular hydrograph shape.  In this 

example, information from previously-computed Bulletin 17 and Volume 

Frequency analyses will be used along with an historical event to create 

numerous balanced hydrographs which are “balanced” across multiple 

durations. 

A Balanced Hydrograph analysis has been developed for this example.  To 

open the Balanced Hydrograph analysis editor for Balanced Hydrograph 

Test 18, either double-click on the analysis labeled Balanced 

Hydrograph Test 18 from the study explorer, or from the Analysis menu 

select open, then select Balanced Hydrograph Test 18 from the list of 

available analyses.  When test 18 is opened, the Balanced Hydrograph 

Analysis editor will appear as shown in Figure B-126. 

 
Figure B-126.  General Tab Shown for Balanced Hydrograph Test 18. 

 

Shown in Figure B-126 are the general settings for this curve combination 

analysis.  The Number of Durations was set to six: 0.0417-days (1-hour), 

1-day, 2-days, 3-days, 5-days, and 10-days.  These six durations are those 

which will be used to “balance” throughout the analysis.  The DSS Range 

was set to 31Jan2099 through 12Feb2099, which is used to signify the 
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hypothetical nature of the triangular hydrograph shape.  This triangular 

hydrograph was created using HEC-DSSVue and initially starts at 100 cfs 

and increases to a peak of 101 cfs and then decreases to 100 cfs over the 

course of 10 days, as shown in Figure B-127. 

 

Figure B-127.  Hypothetical Triangular Hydrograph Used within Balanced 

Hydrograph Test 18. 

 

The number of probabilities was set to four: 0.2, 0.5, 1, and 2 percent 

frequencies.  Using four probabilities will result in the creation of four 

balanced hydrographs.  The frequency ordinates were left as the default 

values. 

Shown in Figure B-128 is the Balanced Hydrograph analysis editor with 

the Frequency Curves tab selected.  Frequency Curve Duration 1 was 

manually defined using results from the Bulletin 17 analysis named 

“Sinnemahoning_B17C”.  Frequency Curve Duration 1 corresponds to a 

duration of 0.0417-days or 1-hour.  It is assumed that the Log Pearson 

Type III distribution that was fit within the “Sinnemahoning_B17C” 

Bulletin 17 analysis is indicative of a 0.0417-day duration.  Log Pearson 

Type III parameters were entered for Frequency Curve Duration 2, 

Frequency Curve Duration 3, Frequency Curve Duration 4, Frequency 

Curve Duration 5, and Frequency Curve Duration 6 using results from the 

Volume Frequency analysis named “Sinnemahoning_VolumeFrequency”.  
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Frequency Curve Duration 2 uses the 1-day results, Frequency Curve 

Duration 3 uses the 2-day results, Frequency Curve Duration 4 uses the 3-

day results, Frequency Curve Duration 5 uses the 5-day results, and 

Frequency Curve Duration 6 uses the 10-day results from the Volume 

Frequency analysis.  Figure B-129 shows the plotted frequency curves for 

this analysis. 

 

 

Figure B-128.  Frequency Curves Tab for Balanced Hydrograph Test 18. 
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Figure B-129.  Plotted Frequency Curves for Balanced Hydrograph Test 18. 

 

Press the Compute button to perform the analysis.  Once the computations 

have been completed, a message window will open stating Compute 

Complete.  Close this window and then select the Results tab.  The results 

tab should look Figure B-130.  The left portion of the Results tab window 

displays the computed balanced hydrographs in a table using the four 

frequencies that were previously defined on the General tab.  The right 

portion of the Results tab displays all four balanced hydrographs in a plot.  

To view the balanced hydrographs in a separate window, either click Plot 

Balanced Hydrograph or double click on the plot within the Results tab. 
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Figure B-130.  Results Tab for Balanced Hydrograph Test 18. 

 

In addition to the tabular and graphical results, there is a report file that 

shows input data and results.  To review the report file, press the View 

Report button at the bottom of the analysis window.  When this button is 

selected a text viewer will open the report file and display it on the screen.  

Shown in Figure B-131 is the report file for Balanced Hydrograph Test 

18. 
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Figure B-131.  Report File for Balanced Hydrograph Test 18. 
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A P P E N D I X  C   

Bulletin 17C / Expected Moments 

Algorithm Examples 

This Appendix provides six examples using the Expected Moments 

Algorithm (EMA) to fit the Log Pearson Type III distribution to annual 

maximum flow data sets.  The multiple inputs and outputs are provided to 

illustrate the use of selected options and to assist in verifying the correct 

execution of the program.     

These examples use the same data sets that are provided with the Bulletin 

17C document (England, et al., 2015) which emphases the use of the 

USGS PeakFQ Software (Veilleux, Cohn, Flynn, Mason, & Hummel, 

2013).  As shown in the example data sets, the HEC-SSP software 

produces the same results as PeakFQ for these six data sets.  In fact, the 

current EMA implementation within HEC-SSP makes use of the same 

computational code inherent within PeakFQ. 

All of these test examples are provided with the software as a single HEC-

SSP study labeled "Bulletin 17C Examples".  You can install this study on 

your computer by selecting the HelpInstall Example Data menu 

option.  After opening this study for the first time on your computer, you 

must compute each example before viewing tabular and graphical results. 

A brief description of each example is provided.  In most cases the 

computed at-site station skew is used in lieu of a weighted skew to more 

clearly illustrate the effects of EMA and the other procedures outlined 

within Bulletin 17C. 

The example problems shown in this section are entitled: 

1. Systematic Record – Moose River at Victory, VT 

2. Analysis with Low Outliers – Orestimba Creek near Newman, CA 

3. Broken Record – Back Creek near Jones Springs, WV 

4. Historical and Data – Arkansas River at Pueblo, CO 

5. Crest Stage Gage Censored Data – Bear Creek at Ottumwa, IA 

6. Historic Data and Low Outliers – Santa Cruz River at Lochiel, AZ 
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When the "Bulletin 17C Examples" study file is open, the screen will 

appear as shown in Figure C-1.  The following sections document each of 

the example data sets. 

 

 
Figure C-1.  Bulletin 17C Examples Study. 
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Example 1: Systematic Record – Moose River at 
Victory, VT 

Example 1 illustrates the computation of a peak flow frequency curve 

using EMA and Bulletin 17C procedures with an annual maximum series 

comprised of systematic flood peaks.  For this example, USGS gage 

01134500 Moose River at Victory, Vermont is used. The Moose River is 

located in the northeastern part of the state and flows mostly from north to 

south through very hilly terrain. The Moose River basin is approximately 

75 square miles of nearly all forest (England, et al., 2015). Historically, it 

was an important logging area and some logging still continues today. 

Attempts at farming in the basin have generally failed due to the presence 

of shallow rocky soil. There are a small number of villages in the basin, 

but overall it is sparsely populated with only a few miles of paved 

roadway. There is also a large bog approximately a third of a mile 

upstream from the gage. The bog is part of the 5,000 acre Victory Basin 

Wildlife management area.  While there is no streamflow regulation in the 

basin, the bog attenuates peaks in the basin.  The Moose River at Victory, 

VT stream gage has an annual peak record consisting of 68 peaks 

beginning in 1947 and ending in 2014, as shown in Figure C-2.  The 

annual peak flow record is tabulated within Table C-. 

 
Figure C-2.  Moose River at Victory, VT Annual Peak Flow Record. 

 

  



 Appendix C – Bulletin 17C / EMA Examples HEC-SSP User's Manual 

 

C-4 

Table C-1.  Moose River at Victory, VT Annual Peak Flow Record. 
Date Flow (cfs)    Date Flow (cfs) 

13 Apr 1947 2080     21 Feb 1981 1570  

28 Mar 1948 1670     18 Apr 1982 2890  

28 Mar 1949 1480     04 May 1983 1840  

21 Apr 1950 2940     31 May 1984 2950  

05 Dec 1950 1560     17 Apr 1985 1380  

02 Jun 1952 2380     31 Mar 1986 2350  

27 Mar 1953 2720     31 Mar 1987 4180  

23 Apr 1954 2860     06 Apr 1988 1700  

15 Apr 1955 2620     06 Apr 1989 2200  

30 Apr 1956 1710     18 Mar 1990 3430  

22 Apr 1957 1370     24 Dec 1990 2270  

21 Dec 1957 2180     23 Apr 1992 2180  

04 Apr 1959 1160     17 Apr 1993 1900  

29 Nov 1959 2780     17 Apr 1994 2760  

24 Apr 1961 1580     06 Aug 1995 4536  

08 Apr 1962 2110     24 Apr 1996 2160  

22 Apr 1963 2160     02 Dec 1996 1860  

15 Apr 1964 2750     31 Mar 1998 2680  

14 Jun 1965 1190     18 Sep 1999 1540  

26 Mar 1966 1560     11 May 2000 2110  

03 Apr 1967 1800     25 Apr 2001 2950  

24 Mar 1968 1600     14 Apr 2002 2410  

29 Apr 1969 2400     30 Mar 2003 2230  

25 Apr 1970 3010     28 Oct 2003 1980  

04 May 1971 1490     04 Apr 2005 1610  

05 May 1972 2920     17 Oct 2005 2640  

01 Jul 1973 4940     24 Apr 2007 1930  

22 Dec 1973 2550     20 Apr 2008 1940  

20 Apr 1975 1250     04 Apr 2009 1810  

02 Apr 1976 2670     24 Mar 2010 1900  

31 Mar 1977 2020     01 Oct 2010 3140  

10 May 1978 1460     20 Mar 2012 1370  

26 Mar 1979 1620     20 Apr 2013 2180  

10 Apr 1980 1460     16 Apr 2014 4250  

 

A Bulletin 17 Analysis using EMA and Bulletin 17C procedures has been 

developed for this example.  To open the analysis, either double-click on 

the analysis labeled “B17C Example 1” from the Study Explorer or from 

the Analysis menu select open, then select “B17C Example 1” from the 

list of available analyses.  When “B17C Example 1” is selected, the 

Bulletin 17 analysis editor will appear as shown in Figure C-3. 

Shown in Figure C-3 are the general settings that were used to perform 

this Bulletin 17 Analysis.  As shown, the Skew option was set to use the 

Weighted Skew.  To use the weighted skew option, the user must enter a 

value for the Regional Skew and the Regional Skew Mean Square Error 
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(MSE).  In this example, a regional skew of 0.44 was used along with a 

Regional Skew MSE of 0.078.   

 
Figure C-3.  Bulletin 17 Analysis General Tab for “B17C Example 1”. 

 

No changes to the Options tab are necessary. 

The EMA Data tab for this example is shown in Figure C-4.  Since this 

example uses an annual maximum series consisting entirely of systematic 

data with a complete record, a single zero – inf perception threshold is 

adequate.  No modifications to the default flow ranges and data types are 

necessary. 
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Figure C-4.  Bulletin 17 Analysis EMA Data Tab for “B17C Example 1”. 

 

Once all of the General and EMA Data tab settings are set or selected, 

the user can press the Compute button to perform the analysis.  Once the 

computations have been completed, a message window will open stations 

Compute Complete.  Close this window and then select the Tabular 

Results tab.  The analysis window should look like Figure C-5. 

As shown in Figure C-5, the Frequency Curve table contains the following 

results: 

 Percent Chance Exceedance 

 Computed Curve (Log Pearson Type III results) 

 Confidence Limits (5% and 95% chance exceedance) 

On the bottom, left side of the results tab is a table of Statistics for the 

observed station data (mean, standard deviation, and station skew) and 

regional adjustment (regional skew, weighted skew, and adopted skew).  

Also on the bottom, right side of the results tab is a Number of Events 

table showing the number of historic events used in the analysis, number 

of high outliers found, number of low outliers and zero flows found, 

number of missing flows, number of systematic events, and the historic 

period in years.  In addition to the tabular results, a graphical plot of the 
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computed frequency curves can be obtained by pressing the Plot Curve 

button at the bottom of the analysis window.  The Log Pearson Type III 

distribution fit using EMA and Bulletin 17C procedures to the input 

annual maximum flow data set, the 5% and 95% confidence limits, and the 

annual maximum flow data set Hirsch/Stedinger plotting positions are 

shown in Figure C-6. 

 
Figure C-5.  Bulletin 17 Analysis Tabular Results Tab for “B17C Example 1”. 
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Figure C-6.  Plotted Frequency Curves for “B17C Example 1”. 

 

 

Because the annual peak flow record contains only systematic peaks with 

no historic information, no censored peaks, and no low outliers identified 

using the Multiple Grubbs-Beck Test, the fitted peak flow frequency curve 

using EMA and Bulletin 17C procedures is the same as that obtained using 

Bulletin 17B procedures.  However, due to the appropriate use of diverse 

information within the Bulletin 17C procedures, the 5% and 95% 

confidence limits are different when compared against results obtained 

using Bulletin 17B procedures. 

In addition to the tabular and graphical results, there is a report file that 

shows the order in which the calculations were performed.  To review the 

report file, press the View Report button at the bottom of the analysis 

window.  When this button is selected, a text viewer will open the file and 

display it on the screen.  Shown in Figure C-7 is the report file. 

The report file contains a listing of the input data, preliminary results, 

outlier and historical data tests, additional calculations needed, and the 

final frequency curve results. Different types and amounts of information 

will show up in the report file depending on the data and the options that 

have been selected for the analysis. The user should review the report file 

to understand how the Bulletin 17C procedures were applied. 
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Figure C-7.  Report File for “B17C Example 1”. 
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Example 2: Analysis with Low Outliers – Orestimba 
Creek near Newman, CA 

 

Example 2 illustrates the computation of a peak flow frequency curve 

using EMA and Bulletin 17C procedures with an annual maximum series 

comprised of systematic flood peaks when low outliers (a.k.a. Potentially 

Influential Low Flows, PILFs) are present. 

For this example, USGS gage 11274500 Orestimba Creek near Newman, 

CA is used.  Orestimba Creek is a tributary to the San Joaquin River, 

whose 134 sq. mi. drainage area lies on the eastern slope of the Diablo 

Range section of the Coast Range Mountains of California.  The drainage 

basin has an average basin elevation of approximately 1,550 feet with 

peak flows usually occurring in late winter.  Orestimba Creek is one of the 

few tributaries in the area to maintain a definite stream channel from the 

foothills to the San Joaquin River (England, et al., 2015) 

The Orestimba Creek near Newman, CA stream gage has an annual peak 

record consisting of 82 peaks beginning in 1932 and ending in water year 

2013.  Of the 82 annual peaks, there are 12 years for which the annual 

peak is 0 cfs.  The annual maximum series is plotted in Figure C-8 and 

tabulated in Table C-. 

 
Figure C-8.  Orestimba Creek near Newman, CA Annual Peak Flow Record. 
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Table C-2.  Orestimba Creek near Newman, CA Annual Peak Flow Record. 
Date Flow (cfs)    Date Flow (cfs)    Date Flow (cfs) 

08 Feb 1932 4260    10 Feb 1960 448    30 Nov 1987 0 

29 Jan 1933 345    30 Nov 1960 0    30 Nov 1988 0 

01 Jan 1934 516    15 Feb 1962 1740    28 May 1990 4 

08 Apr 1935 1320    01 Feb 1963 8300    24 Mar 1991 1260 

13 Feb 1936 1200    22 Jan 1964 156    15 Feb 1992 888 

13 Feb 1937 2180    06 Jan 1965 560    13 Jan 1993 4190 

11 Feb 1938 3230    30 Dec 1965 128    20 Feb 1994 12 

09 Mar 1939 115    24 Jan 1967 4200    10 Mar 1995 12000 

27 Feb 1940 3440    30 Nov 1967 0    19 Feb 1996 3130 

04 Apr 1941 3070    25 Jan 1969 5080    23 Jan 1997 3320 

24 Jan 1942 1880    01 Mar 1970 1010    03 Feb 1998 9470 

21 Jan 1943 6450    21 Dec 1970 584    09 Feb 1999 833 

29 Feb 1944 1290    30 Nov 1971 0    14 Feb 2000 2550 

02 Feb 1945 5970    11 Feb 1973 1510    05 Mar 2001 958 

25 Dec 1945 782    03 Mar 1974 922    03 Jan 2002 425 

30 Nov 1946 0    08 Mar 1975 1010    16 Dec 2002 2790 

30 Nov 1947 0    30 Nov 1975 0    25 Feb 2004 2990 

12 Mar 1949 335    30 Nov 1976 0    16 Feb 2005 1820 

05 Feb 1950 175    17 Jan 1978 4360    02 Jan 2006 1630 

03 Dec 1950 2920    21 Feb 1979 1270    30 Nov 2006 0 

12 Jan 1952 3660    16 Feb 1980 5210    25 Jan 2008 2110 

07 Dec 1952 147    29 Jan 1981 1130    17 Feb 2009 310 

30 Nov 1953 0    05 Jan 1982 5550    20 Jan 2010 4400 

19 Jan 1955 16    24 Jan 1983 6360    24 Mar 2011 4440 

23 Dec 1955 5620    25 Dec 1983 991    30 Nov 2011 0 

24 Feb 1957 1440    09 Feb 1985 50    24 Dec 2012 6250 

02 Apr 1958 10200    19 Feb 1986 6990      
16 Feb 1959 5380    06 Mar 1987 112        

 

A Bulletin 17 Analysis using EMA and Bulletin 17C procedures has been 

developed for this example.  To open the analysis, either double-click on 

the analysis labeled “B17C Example 2” from the Study Explorer or from 

the Analysis menu select open, then select “B17C Example 2” from the 

list of available analyses.  When “B17C Example 2” is selected, the 

Bulletin 17 analysis editor will appear as shown in Figure C-9. 

Shown in Figure C-9 are the general settings that were used to perform 

this Bulletin 17 Analysis.  As shown, the Skew option was set to use the 

Station Skew. 
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Figure C-9.  Bulletin 17 Analysis General Tab for “B17C Example 2”. 

 

No changes to the Options tab are necessary. 

The EMA Data tab for this example is shown in Figure C-10.  Since this 

example uses an annual maximum series consisting entirely of systematic 

data with a complete record, a single zero – inf perception threshold is 

adequate.  No modifications to the default flow ranges and data types are 

necessary. 
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Figure C-10.  Bulletin 17 Analysis EMA Data Tab for “B17C Example 2”. 

 

Once all of the General and EMA Data tab settings are set or selected, 

the user can press the Compute button to perform the analysis.  Once the 

computations have been completed, a message window will open stations 

Compute Complete.  Close this window and then select the Tabular 

Results tab.  The analysis window should look like Figure C-11. 

In addition to the tabular results, a graphical plot of the computed 

frequency curves can be obtained by pressing the Plot Curve button at the 

bottom of the analysis window.  The Log Pearson Type III distribution fit 

using EMA to the input annual maximum flow data set, the 5% and 95% 

confidence limits, and the annual maximum flow data set Hirsch/Stedinger 

and Median (for low outliers) plotting positions are shown in Figure C-12. 
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Figure C-11.  Bulletin 17 Analysis Tabular Results Tab for “B17C Example 2”. 

 

 
Figure C-12.  Plotted Frequency Curves for “B17C Example 2”. 
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As shown in Figure C-12, the Multiple Grubbs-Beck Test identified a low 

outlier threshold of 782 cfs.  Thirty annual peak flows were identified as 

being less than this threshold, as shown in Figure C-13.  These annual 

peak flows were then recoded to have a flow interval of zero – 782.  The 

perception threshold for the entire historical period was also adjusted to 

correspond with the Multiple Grubbs-Beck Test low outlier threshold.  

Consequently, the perception threshold was changed from zero – inf to 

782 – inf, as shown in Figure C-14. 

 

 
Figure C-13.  Report File for “B17C Example 2” showing censored low outliers 

and zero flows. 
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Figure C-14.  Report File for “B17C Example 2” showing recoded perception 

threshold.  
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Example 3: Broken Record – Back Creek near Jones 
Springs, WV 

 

Example 3 illustrates the computation of a peak flow frequency curve 

using EMA and Bulletin 17C procedures with an annual maximum series 

comprised of a broken record of systematic flood peaks. 

For this example, USGS gage 01614000 Back Creek near Jones Springs, 

West Virginia is used. Back Creek is a tributary to the Potomac River; the 

235 square mile watershed lies within the Valley and Ridge province in 

West Virginia (England, et al., 2015).  Gage 01614000 has an annual peak 

record consisting of 56 peaks beginning in 1929 and ending in 2012.  

There are three “broken record” periods where the gage was discontinued: 

1932-1937, 1976-1991, and 1999-2003. Thus, there are 28 years of 

missing data at this gage during the period 1929-2012. There is a historic 

flood that occurred outside the period of gaging record on March 17, 1936. 

This flood is noted in the USGS Annual Water Data Report for this gage, 

available in the peak-flow file, and there is historical information available 

for this large flood (Grover, 1937). 

The Back Creek near Jones Springs, WV stream gage has an annual peak 

record consisting of 56 annual peaks.  Of the 56 annual peaks, the October 

1942 flood slightly exceeds the March 1936 historic flood peak. Based on 

the historical flood information in Grover (1937) for the 1936 flood, and 

the large regional floods and historical floods described by Wiley and 

Atkins (2010) in West Virginia for the period 1888-1996, information 

from the March 1936 flood can be used as a perception threshold to 

represent the 28 years of missing information.  The annual maximum 

series is plotted in Figure C-15 and tabulated in Table C-. 
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Figure C-15.  Back Creek near Jones Springs, WV Annual Peak Flow Record. 

 

Table C-3.  Back Creek near Jones Springs, WV Annual Peak Flow Record. 
Date Flow (cfs)    Date Flow (cfs) 

17 Apr 1929 8750    20 Mar 1963 5190 

23 Oct 1929 15500    10 Jan 1964 3960 

08 May 1931 4060    06 Mar 1965 5600 

17 Mar 1936 22000    21 Sep 1966 4670 

04 Feb 1939 6300    08 Mar 1967 7080 

20 Apr 1940 3130    17 Mar 1968 4640 

06 Apr 1941 4160    02 Feb 1969 536 

22 May 1942 6700    10 Jul 1970 6680 

15 Oct 1942 22400    13 Nov 1970 8360 

24 Mar 1944 3880    22 Jun 1972 18700 

18 Sep 1945 8050    09 Dec 1972 5210 

03 Jun 1946 4020    27 Dec 1973 4680 

15 Mar 1947 1600    20 Mar 1975 7940 

14 Apr 1948 4460    05 Mar 1993 11800 

31 Dec 1948 4230    08 May 1994 8730 

02 Feb 1950 3010    16 Jan 1995 2300 

05 Dec 1950 9150    19 Jan 1996 13900 

28 Apr 1952 5100    09 Nov 1996 4190 

22 Nov 1952 9820    21 Mar 1998 6370 

02 Mar 1954 6200    29 Sep 2004 9460 

19 Aug 1955 10700    29 Mar 2005 6560 

15 Mar 1956 3880    30 Nov 2005 2000 

10 Feb 1957 3420    16 Apr 2007 5040 

27 Mar 1958 3240    21 Apr 2008 7670 

03 Jun 1959 6800    05 May 2009 4830 

09 May 1960 3740    14 Mar 2010 9070 

19 Feb 1961 4700    17 Apr 2011 10300 

22 Mar 1962 4380    01 Mar 2012 4650 
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A Bulletin 17 Analysis using EMA and Bulletin 17C procedures has been 

developed for this example.  To open the analysis, either double-click on 

the analysis labeled “B17C Example 3” from the Study Explorer or from 

the Analysis menu select open, then select “B17C Example 3” from the 

list of available analyses.  When “B17C Example 3” is selected, the 

Bulletin 17 analysis editor will appear as shown in Figure C-16. 

Shown in Figure C-16 are the general settings that were used to perform 

this Bulletin 17 Analysis.  As shown, the Skew option was set to use the 

Station Skew. 

 
Figure C-16.  Bulletin 17 Analysis General Tab for “B17C Example 3”. 

 

No changes to the Options tab are necessary. 

The EMA Data tab for this example is shown in Figure C-17.  This 

example uses an annual maximum series consisting of both systematic 

data along with an historical event in March 1936.  Also, the record is 

broken with multiple periods of missing with a complete record.  Since 

17C EMA requires a non zero – inf perception threshold for all periods of 

missing data, a total of five perception thresholds are required.  In this 

case, the March 1936 event can be used to inform the perception 
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thresholds for the periods of missing annual peak flow data.  The use of a 

perception threshold of 21000 – inf for these periods of missing data 

implies that had a flood event occurred with a peak flow greater than 

21,000 cfs, someone would have measured and recorded it.  Once all five 

perception thresholds have been entered as shown in Figure C-17, click 

the Apply Thresholds button to assign the complementary flow ranges for 

the periods of missing data. 

Finally, the March 1936 Event should be set to the historical data type, as 

denoted by a USGS peak flow rate qualification code of “7”. 

 

 
Figure C-17.  Bulletin 17 Analysis EMA Data Tab for “B17C Example 3”. 

 

Once all of the General and EMA Data tab settings are set or selected, 

the user can press the Compute button to perform the analysis.  Once the 

computations have been completed, a message window will open stations 

Compute Complete.  Close this window and then select the Tabular 

Results tab.  The analysis window should look like Figure C-18. 

In addition to the tabular results, a graphical plot of the computed 

frequency curves can be obtained by pressing the Plot Curve button at the 

bottom of the analysis window.  The Log Pearson Type III distribution fit 
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using EMA to the input annual maximum flow data set, the 5% and 95% 

confidence limits, and the annual maximum flow data set Hirsch/Stedinger 

and Median (for low outliers) plotting positions are shown in Figure C-19. 

 

 
Figure C-18.  Bulletin 17 Analysis Tabular Results Tab for “B17C Example 3”. 
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Figure C-19.  Plotted Frequency Curves for “B17C Example 3”. 

 

As shown in Figure C-19, the Multiple Grubbs-Beck Test identified a low 

outlier threshold of 2000 cfs.  Two annual peak flows were identified as 

being less than this threshold, as shown in Figure C-20.  These annual 

peak flows were then recoded to have a flow interval of zero – 2000.  The 

perception thresholds for the years in which an annual peak flow was 

recorded were also adjusted to correspond with the Multiple Grubbs-Beck 

Test low outlier threshold.  Consequently, these perception thresholds 

were changed from zero – inf to 2000 – inf, as shown in Figure C-21. 
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Figure C-20.  Report File for “B17C Example 3” showing censored low outliers. 
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Figure C-21.  Report File for “B17C Example 3” showing recoded perception 

thresholds.  



HEC-SSP User's Manual Appendix C – Bulletin 17C / EMA Examples 

 

 C-25 

Example 4: Historical Data – Arkansas River at Pueblo, 
CO 

 

Example 4 illustrates the computation of a peak flow frequency curve 

using EMA and Bulletin 17C procedures with an annual maximum series 

comprised of systematic and historical flood events as well as paleoflood 

information.  The largest historic floods are described as interval data, and 

multiple thresholds are needed to effectively extend the discontinued 

stream gaging record after the dam was built. 

A paleohydrologic bound of about 840 years (before water year 2004) was 

estimated at this site for inclusion in the flood frequency curve.  No 

estimates of individual paleofloods were made at this site, due to the 

relatively wide channel geometry and the lack of apparent stratigraphic 

evidence of large paleofloods during a limited field study (England, et al., 

2015). 

When fitting the Log Pearson Type III distribution using either Bulletin 

17B or Bulletin 17C procedures, an unregulated annual maximum series is 

required.  However, peak flow rates downloaded from the USGS website 

do not always reflect unregulated conditions, as is the case with the 

Arkansas River near Pueblo, CO (07099500) gage.  Pueblo Dam, which 

creates one of the largest reservoirs within Colorado, is immediately 

upstream of this gaging station.  The dam was constructed between 1970 

and 1975 and began impacting the annual maximum series due to flood 

control and water supply storage in water year 1974.  As such, the annual 

maximum series downloaded from the USGS website was altered to 

reflect unregulated conditions for water year 1974 and 1975. 

The modified annual maximum series is plotted in Figure C-22 and 

tabulated in Table C-. 
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Figure C-22.  Arkansas River near Pueblo, CO Annual Peak Flow Record 

(Modified). 
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Table C-4.  Arkansas River near Pueblo, CO Annual Peak Flow Record (Modified). 
Date Flow (cfs)    Date Flow (cfs)    Date Flow (cfs) 

31 Jul 1895 6100    12 Jul 1923 25600    03 Aug 1951 9300 

18 Aug 1896 16500    15 Jun 1924 6510    08 Jun 1952 4740 

02 Jun 1897 4300    03 Jul 1925 4930    21 Jul 1953 6770 

13 Jul 1898 7500    14 Jun 1926 4520    30 Jun 1954 10200 

14 Aug 1899 8800    22 Jul 1927 12400    19 May 1955 11100 

20 May 1900 7600    21 Jul 1928 7800    01 Aug 1956 8010 

21 May 1901 11100    28 Jul 1929 10500    29 Jun 1957 9070 

05 Aug 1902 30000    28 Aug 1930 6050    05 Jun 1958 4540 

09 Jun 1903 10500    01 Sep 1931 3560    17 Jun 1959 2820 

15 Aug 1904 8500    26 Jun 1932 4380    08 Jun 1960 5260 

06 Aug 1905 8000    02 Aug 1933 8630    02 Aug 1961 5760 

13 Jun 1906 11000    03 Aug 1934 2580    08 Jul 1962 3540 

28 Jul 1907 6600    18 May 1935 9880    14 Aug 1963 8360 

01 Aug 1908 7600    24 May 1936 11200    27 May 1964 2840 

18 Aug 1909 5800    29 Aug 1937 9300    22 Aug 1965 23500 

29 Jul 1910 8400    26 Aug 1938 11200    01 Aug 1966 10600 

28 May 1911 3700    01 Jun 1939 2910    18 Jul 1967 5870 

31 Jul 1912 10500    19 Aug 1940 3860    10 Aug 1968 5190 

23 Jul 1913 7800    19 Jul 1941 7560    23 Aug 1969 6620 

03 Aug 1914 7500    08 Jun 1942 10300    11 Aug 1970 6300 

24 Jun 1915 17000    18 Aug 1943 3320    07 Jun 1971 3360 

17 Jun 1916 8900    05 Jul 1944 5980    28 Jun 1972 3360 

19 Jun 1917 6800    14 Aug 1945 9290    30 Jul 1973 6760 

23 Jun 1918 9600    27 Aug 1946 7050    23 Jul 1974 5440 

04 Sep 1919 6300    09 Jul 1947 7280    10 Jul 1975 10200 

18 Jul 1920 8500    13 Jun 1948 10900    10 Jul 1976 12800 

03 Jun 1921 91500    06 Jun 1949 12800      
06 Aug 1922 8850    26 Jul 1950 8700        

 

A Bulletin 17 Analysis using EMA and Bulletin 17C procedures has been 

developed for this example.  To open the analysis, either double-click on 

the analysis labeled “B17C Example 4” from the Study Explorer or from 

the Analysis menu select open, then select “B17C Example 4” from the 

list of available analyses.  When “B17C Example 4” is selected, the 

Bulletin 17 analysis editor will appear as shown in Figure C-23.  As 

shown, the Skew option was set to use the Station Skew. 



 Appendix C – Bulletin 17C / EMA Examples HEC-SSP User's Manual 

 

C-28 

 
Figure C-23.  Bulletin 17 Analysis General Tab for “B17C Example 4”. 

 

Commonly, within dam safety studies, estimates of flow or volume 

frequency are required at extremely small exceedance probabilities.  As 

such, additional frequency ordinates (0.1- and 0.01-percent annual chance 

exceedance probabilities) were specified on the Options tab, as shown in 

Figure C-24. 
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Figure C-24.  Bulletin 17 Analysis Options Tab for “B17C Example 4”. 

 

The EMA Data tab for this example is shown in Figure C-25.  This 

example uses an annual maximum series consisting of both systematic 

data along with historical events and paleoflood information.  Multiple 

perception thresholds are needed to reasonably incorporate the various 

historical and paleoflood information. 

The default “Total Record” perception threshold should be modified to 

reflect the additional paleoflood and post Pueblo Dam construction 

information.  A start year of 1165 and end year of 2004 along with a 

perception threshold of zero – inf should be entered on the first line.   

The second perception threshold relates to the non-exceedance 

information obtained through the paleoflood analysis.  A start and end 

year of 1165 and 1858 should be entered, respectively, along with a 

150,000 – inf perception threshold.  This implies that no floods exceeded a 

peak flow rate of 150,000 cfs from 1165 – 1858 even though there were 

no gages present.   

The third and fourth perception thresholds represent a period of historical 

information from 1859 – 1892 where floods in excess of 40,000 cfs would 

have been recorded had they occurred.  Since a historical event was 
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recorded in 1864, two perception thresholds should be used, one from 

1859 – 1863 and one from 1865 – 1892.  Both perception thresholds 

should span from 40,000 – inf.  Additionally, a historical flow event that 

occurred in 1864 should be entered in the Flow Ranges table with a low 

and high flow value of 41,000 and 60,000 cfs, respectively, to denote 

uncertainty around the best-estimate of 50,500 cfs.  The data type for this 

event should be set to Historical. 

The fifth perception threshold represents an additional period of historical 

information from 1893 – 1894.  A perception threshold of 19,900 – inf 

should be entered for these two years.  Two events that aren’t part of the 

gage record occurred in 1893 and 1894.  The 1893 event had a low and 

high flow value of 20,000 and 25,000, respectively, with a best-estimate of 

22,500.  The 1894 event had a low and high flow value of 35,000 and 

40,000, respectively, with a best-estimate of 37,500.  Both events should 

be entered in the Flow Ranges table and the data types should be set to 

Historical. 

The 1921 event should be entered as an historical event with uncertainty 

around the best estimate of 91,500 cfs.  A low and high value of 80,000 

and 103,000 should be used. 

The sixth and final perception threshold represents the period when the 

stream gage was discontinued after the construction of Pueblo Dam.  It is 

known that floods in excess of 20,000 cfs would have been recorded had 

they occurred.  Therefore, a perception threshold of 20,000 – inf should be 

entered for these years. 

Once all six perception thresholds have been entered as shown in Figure 

C-25, click the Apply Thresholds button to assign the complementary 

flow ranges for the periods of missing data. 
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Figure C-25.  Bulletin 17 Analysis EMA Data Tab for “B17C Example 4”. 

 

Once all of the General and EMA Data tab settings are set or selected, 

the user can press the Compute button to perform the analysis.  Once the 

computations have been completed, a message window will open stations 

Compute Complete.  Close this window and then select the Tabular 

Results tab.  The analysis window should look like Figure C-26. 

In addition to the tabular results, a graphical plot of the computed 

frequency curves can be obtained by pressing the Plot Curve button at the 

bottom of the analysis window.  The Log Pearson Type III distribution fit 

using EMA to the input annual maximum flow data set, the 5% and 95% 

confidence limits, and the annual maximum flow data set Hirsch/Stedinger 

and Median (for low outliers) plotting positions are shown in Figure C-27. 
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Figure C-26.  Bulletin 17 Analysis Tabular Results Tab for “B17C Example 4”. 

 
Figure C-27.  Plotted Frequency Curves for “B17C Example 4”. 
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As is shown in Figure C-27, the Log Pearson Type III distribution is well 

fit to the majority of the data.  However, the largest flood event (June 

1921) is underfit by the EMA-computed Log Pearson Type III curve.  This 

is likely due to the influence of the paleoflood information which 

lengthens the historical record from 85 years to 840 years.  Consequently, 

the at-station skew coefficient is reduced which primarily affects the upper 

end of the computed curve.  Had the paleoflood information not been 

included, a larger at-station skew coefficient would have been computed. 
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Example 5: Crest Stage Gage Censored Data – Bear 
Creek at Ottumwa, IA 

 

Example 5 illustrates the computation of a peak flow frequency curve 

using EMA and Bulletin 17C procedures with an annual maximum series 

comprised of censored data with variable perception thresholds due to the 

presence of a crest stage gage. 

A crest stage gage is a simple, reliable device used to obtain the elevation 

of the flood peak of a stream. Most commonly, a crest stage gage consists 

of a vertical metal pipe containing a wood or aluminum staff held in a 

fixed position with relation to a datum reference.  At the bottom of the 

pipe is a perforated cap containing regranulated cork. When the water in 

the stream reaches and exceeds the height of the bottom cap (commonly 

referred to as the gage base), water is able to enter the pipe. As the water 

rises up the pipe, the cork floats on the water surface and as the water 

reaches its peak and starts to recede, the cork adheres to the staff thereby 

retaining the crest stage of the flood (England, et al., 2015).  As a result, 

crest stage gages provide a censored record of peak flows, as no annual 

peak flow that results in a flood stage below the bottom cap of the pipe 

will be recorded.   

For this example, USGS gage 05489490 Bear Creek at Ottumwa, IA is 

used.  This gage is a crest stage gage and has a drainage area of 22.9 

square miles.  It is located in southeast Iowa in the Southern Iowa Drift 

Plain land-form region which is characterized by rolling hills and deeply 

carved stream channels (Prior, 1991).  The stream banks and channel bed 

are comprised of sand, silt, and clay materials that are prone to shifting 

from hydrologic events. 

The Bear Creek at Ottumwa, IA stream gage has an annual peak record 

consisting of 50 annual peaks.  The historical record for this gage spans 

from 1965 – 2014.  The annual maximum series is plotted in Figure C-28 

and tabulated in Table C-. 
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Figure C-28.  Bear Creek at Ottumwa, IA Annual Peak Flow Record. 

 

 

Table C-5.  Bear Creek at Ottumwa, IA Annual Peak Flow Record. 
Date Flow (cfs)    Date Flow (cfs) 

21 Sep 1965 4000    25 May 1990 3120 

30 Nov 1965 1180    18 Apr 1991 1850 

09 Jun 1967 2880    15 Sep 1992 1840 

15 Oct 1967 1310    07 May 1993 2410 

05 Jul 1969 1420    23 Jun 1994 1400 

24 Jun 1970 3130    11 Apr 1995 1560 

30 Nov 1970 1180    28 May 1996 3130 

08 May 1972 1620    30 Nov 1996 714 

19 Jan 1973 1570    18 Jun 1998 1940 

19 May 1974 2060    05 Oct 1998 2840 

30 Nov 1974 705    23 Jun 2000 3520 

24 Apr 1976 3340    15 May 2001 2430 

07 Aug 1977 3530    11 May 2002 2670 

21 Jul 1978 2010    26 Jun 2003 560 

29 Mar 1979 1830    27 Aug 2004 3000 

17 Aug 1980 2240    12 Apr 2005 859 

04 Jul 1981 2770    30 Nov 2005 710 

03 Jul 1982 4030    23 Aug 2007 2390 

08 Oct 1982 2180    11 May 2008 3160 

08 Jun 1984 1780    27 Aug 2009 2520 

04 Mar 1985 1610    09 Aug 2010 3750 

19 Sep 1986 1910    14 Jun 2011 2600 

31 May 1987 990    14 Apr 2012 1450 

20 Feb 1988 899*    28 May 2013 3850 

09 Sep 1989 1820    10 Sep 2014 1200 

*gage height affected by backwater 
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A Bulletin 17 Analysis using EMA and Bulletin 17C procedures has been 

developed for this example.  To open the analysis, either double-click on 

the analysis labeled “B17C Example 5” from the Study Explorer or from 

the Analysis menu select open, then select “B17C Example 5” from the 

list of available analyses.  When “B17C Example 5” is selected, the 

Bulletin 17 analysis editor will appear as shown in Figure C-29.  As 

shown, the Skew option was set to use the Station Skew. 

 
Figure C-29.  Bulletin 17 Analysis General Tab for “B17C Example 5”. 

 

No changes to the Options tab are necessary. 

The EMA Data tab for this example is shown in Figure C-30.  This 

example uses an annual maximum series consisting entirely of systematic 

data.  However, physical changes to the actual gage base (i.e. minimum 

recordable flow rate) occurred in 1973, 1992, 2002, 2003, 2004, 2006, 

2010, and 2013.  To take the possibility of annual peak flows occurring 

below the gage base into account within the EMA framework, perception 

thresholds are required for each change in the gage base.  For instance, the 

gage base was lowered from the initial setting of 1180 cfs to a gage base 

of 705 cfs in 1973.  The next gage base change occurred in 1992.  This 

requires a perception threshold of 705 – inf for water year 1973 – water 

year 1991.  For information related to a specific crest stage gage, such as 
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the gage base, consult your local USGS office.  A total of nine different 

gage bases have been in effect for this gage.  Including the first perception 

threshold (which sets the start and end year of the analysis), this requires a 

total of 10 perception thresholds.  Once all five perception thresholds have 

been entered as shown in Figure C-30, click the Apply Thresholds button 

to assign the complementary flow ranges for the periods of missing data. 

A peak flow rate below the gage base occurred in 1966, 1971, 1975, 1997, 

and 2006, as signified by the USGS qualification code of 4.  This implies 

that the actual annual peak flow rate could have been between zero and 

whatever the gage base was at the time.  This requires a change to the flow 

range table.  For each of these years, a low value of zero and high value of 

whatever the gage base was at the time should be entered.  For instance, in 

water year 1966, the annual peak flow rate was below the gage base of 

1180 cfs.  Therefore, the flow range for that year should be entered as zero 

– 1180, as shown in Figure C-30.  The other four water years in which an 

annual peak flow was below the recordable limit should be entered in a 

similar fashion within the flow range table. 

 

 
Figure C-30.  Bulletin 17 Analysis EMA Data Tab for “B17C Example 5”. 
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Once all of the General and EMA Data tab settings are set or selected, 

the user can press the Compute button to perform the analysis.  Once the 

computations have been completed, a message window will open stations 

Compute Complete.  Close this window and then select the Tabular 

Results tab.  The analysis window should look like Figure C-31. 

In addition to the tabular results, a graphical plot of the computed 

frequency curves can be obtained by pressing the Plot Curve button at the 

bottom of the analysis window.  The Log Pearson Type III distribution fit 

using EMA to the input annual maximum flow data set, the 5% and 95% 

confidence limits, and the annual maximum flow data set Hirsch/Stedinger 

and Median (for low outliers) plotting positions are shown in Figure C-32. 

 
Figure C-31.  Bulletin 17 Analysis Tabular Results Tab for “B17C Example 5”. 
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Figure C-32.  Plotted Frequency Curves for “B17C Example 5”. 

 

 

As shown in Figure C-33, the Multiple Grubbs-Beck Test identified a low 

outlier threshold of 1200 cfs.  Nine annual peak flows were identified as 

being less than this threshold, as shown in Figure C-32.  These annual 

peak flows were then recoded to have a flow interval of zero – 1200.  The 

perception thresholds for the years in which an annual peak flow was 

recorded were also adjusted to correspond with the Multiple Grubbs-Beck 

Test low outlier threshold.  Consequently, these perception thresholds 

were changed from zero – inf to 1200 – inf, as shown in Figure C-34. 
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Figure C-33.  Report File for “B17C Example 5” showing censored low outliers. 
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Figure C-34.  Report File for “B17C Example 5” showing recoded perception 

thresholds.  
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Example 6: Historic Data and Low Outliers – Santa 
Cruz River at Lochiel, AZ 

 

Example 6 illustrates the computation of a peak flow frequency curve 

using EMA and Bulletin 17C procedures with an annual maximum series 

comprised of systematic data and historical flood information that can be 

used to extend the historical period. 

For this example, USGS gage 09480000 Santa Cruz River near Lochiel, 

AZ is used. The stream gage in question has an approximate 82.2 sq. mi. 

contributing watershed with an annual peak record consisting of 65 peaks 

beginning in water year 1949 and ending in water year 2013.  A large 

flood event occurred on October 9, 1977.  This flood is noted in the USGS 

Annual Water Data Report for this gage and there is historical information 

available for this large flood indicating that this flood is the largest since 

1927 (Aldridge & Eychaner, 1984). 

Of the 65 annual peaks, the August 15, 1984 flood is equal to the October 

1977 historic flood peak.  Based on information contained within Aldridge 

and Eychaner (1984) for the October 1977 flood, this event can be used as 

a perception threshold to represent the 22 years of missing information 

from 1927 to 1946.  The annual maximum series is plotted in Figure C-35 

and tabulated in Table C-. 

 
Figure C-35.  Santa Cruz River at Lochiel, AZ Annual Peak Flow Record. 
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Table C-6.  Santa Cruz River at Lochiel, AZ Annual Peak Flow Record. 
Date Flow (cfs)    Date Flow (cfs)    Date Flow (cfs) 

13 Sep 1949 1650    10 Aug 1971 2830    18 Jan 1993 4880 

30 Jul 1950 4520    16 Jul 1972 2070    30 Aug 1994 478 

02 Aug 1951 2560    30 Jun 1973 1490    12 Jul 1995 2020 

16 Aug 1952 550    04 Aug 1974 1730    10 Jul 1996 1860 

14 Jul 1953 3320    22 Jul 1975 3330    11 Sep 1997 2970 

22 Jul 1954 1570    22 Jul 1976 3540    07 Jul 1998 1110 

06 Aug 1955 4300    05 Sep 1977 1130    28 Jul 1999 4870 

17 Jul 1956 1360    09 Oct 1977 12000    06 Aug 2000 2240 

09 Aug 1957 688    25 Jan 1979 1060    22 Oct 2000 1080 

07 Aug 1958 380    30 Jun 1980 406    04 Mar 2002 2 

14 Aug 1959 243    15 Jul 1981 1110    14 Aug 2003 22 

30 Jul 1960 625    11 Aug 1982 2640    05 Aug 2004 256 

08 Aug 1961 1120    04 Mar 1983 1120    23 Aug 2005 73 

29 Jul 1962 8    15 Aug 1984 12000    08 Aug 2006 5940 

25 Aug 1963 2390    19 Jul 1985 850    19 Jul 2007 3060 

09 Sep 1964 2330    29 Aug 1986 4210    23 Jul 2008 1180 

12 Sep 1965 4810    10 Aug 1987 291    01 Jul 2009 1530 

18 Aug 1966 1780    23 Aug 1988 804    31 Jul 2010 392 

03 Aug 1967 1870    04 Aug 1989 871    13 Aug 2011 95 

20 Dec 1967 986    17 Jul 1990 3510    28 Jul 2012 12 

05 Aug 1969 484    26 Jul 1991 17    08 Sep 2013 612 

03 Aug 1970 880    01 Aug 1992 483        

 

A Bulletin 17 Analysis using EMA and Bulletin 17C procedures has been 

developed for this example.  To open the analysis, either double-click on 

the analysis labeled “B17C Example 6” from the Study Explorer or from 

the Analysis menu select open, then select “B17C Example 6” from the 

list of available analyses.  When “B17C Example 6” is selected, the 

Bulletin 17 analysis editor will appear as shown in Figure C-36.  As 

shown, the Skew option was set to use the Station Skew. 
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Figure C-36.  Bulletin 17 Analysis General Tab for “B17C Example 6”. 

 

No changes to the Options tab are necessary. 

The EMA Data tab for this example is shown in Figure C-37.  This 

example uses an annual maximum series consisting entirely of systematic 

data along with historical information.  As was previously mentioned, 

historical information indicates that the October 1977 flood event was the 

largest since at least 1927.  This information can be used within EMA to 

extend the historical record to a longer period through the use of a 

perception threshold.  Specifically, the first perception threshold should be 

modified to start at water year 1927.  Then, a second perception threshold 

of 12000 – inf should be added for the period of missing data spanning 

water years 1927 through 1948, as shown in Figure C-37.  Once both 

perception thresholds have been entered, click the Apply Thresholds 

button to assign the complementary flow ranges for the periods of missing 

data.  No further changes to the flow range table are necessary. 
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Figure C-37.  Bulletin 17 Analysis EMA Data Tab for “B17C Example 6”. 

 

Once all of the General and EMA Data tab settings are set or selected, 

the user can press the Compute button to perform the analysis.  Once the 

computations have been completed, a message window will open stations 

Compute Complete.  Close this window and then select the Tabular 

Results tab.  The analysis window should look like Figure C-31. 

In addition to the tabular results, a graphical plot of the computed 

frequency curves can be obtained by pressing the Plot Curve button at the 

bottom of the analysis window.  The Log Pearson Type III distribution fit 

using EMA to the input annual maximum flow data set, the 5% and 95% 

confidence limits, and the annual maximum flow data set Hirsch/Stedinger 

and Median (for low outliers) plotting positions are shown in Figure C-32. 
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Figure C-38.  Bulletin 17 Analysis Tabular Results Tab for “B17C Example 6”. 

 

 
Figure C-39.  Plotted Frequency Curves for “B17C Example 6”. 
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As shown in Figure C-40, the Multiple Grubbs-Beck Test identified a low 

outlier threshold of 380 cfs.  Ten annual peak flows were identified as 

being less than this threshold, as shown in Figure C-39.  These annual 

peak flows were then recoded to have a flow interval of zero – 380.  The 

perception thresholds for the years in which an annual peak flow was 

recorded were also adjusted to correspond with the Multiple Grubbs-Beck 

Test low outlier threshold.  Consequently, these perception thresholds 

were changed from zero – inf to 380 – inf.  The perception threshold for 

the years in which there is only historical nonexceedance data (i.e. 1927 – 

1948) were left at 12,000 - inf, as shown in Figure C-41. 

 

 
Figure C-40.  Report File for “B17C Example 6” showing censored low outliers. 
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Figure C-41.  Report File for “B17C Example 6” showing recoded 

perception thresholds
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A P P E N D I X  D   

Creating a Partial Duration Series 

To use the partial duration frequency curve estimation options within a 

General Frequency analysis, a partial duration series of flow rates or 

stages must be constructed outside of HEC-SSP.  This type of analysis is 

commonly called “Peaks over Threshold”.  The Find Peaks tool within 

HEC-DSSVue is a useful tool that can be used to construct a partial 

duration dataset from an input continuous dataset.  The creation of a 

partial duration series from a daily flow dataset is provided to illustrate the 

use of the Find Peaks tool within HEC-DSSVue as well as the differences 

between a partial duration series and an annual maximum series. 

The data for this example is from Delaware River near Delaware Water 

Gap, PA (gage number 01440200).  This stream gage is located near the 

site of a previously authorized but unconstructed large dam and reservoir 

named Tocks Island, which, if constructed, would have provided flood 

control, water supply, and hydropower benefits to the lower Delaware 

River watershed.  However, negative environmental concerns ultimately 

derailed the construction of the Tocks Island Dam and Reservoir.  

Property and flowage easements that were acquired in anticipation of 

construction and impoundment of water was turned over to the National 

Park Service in 1979 thereby creating the Delaware Water Gap National 

Recreation Area.  The project was officially deauthorized by Congress in 

July 1992. 

The Find Peaks tool can analyze any data set with a continuous record.  

Commonly, data sets consisting of daily, hourly, or sub-hourly (i.e. 15-

minute) observations are used to derive partial duration series.  For the 

purposes of this example, a daily flow data series can be downloaded for 

the Delaware River near Delaware Water Gap, PA gage from the USGS 

website within HEC-SSP.  Select a period spanning from 01Oct1939 – 

01Jan2015, as shown in Figure D-1.  However, it is important to note that 

data sets originating from different locations (i.e. USACE water control 

databases) can be used by as well. 
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Figure D-1.  Downloading Daily Flow Data. 

 

To use the Find Peaks tool, the appropriate Java plug-in (“Peaks.jar”) must 

be present within the “..HEC-DSSVue\Plugins\” directory.  By default, 

this directory is located at either “C:\Program Files\HEC\HEC-

DSSVue\Plugins” (for 32-bit versions of Windows XP, Vista, or 7) or 

“C:\Program Files (x86)\HEC\HEC-DSSVue\Plugins” (for 64-bit versions 

of Windows XP, Vista, or 7). The “Peaks.jar” file can be found on HEC’s 

website here: http://www.hec.usace.army.mil/software/hec-

dssvue/plugins.aspx.  Once the daily flow dataset has been downloaded 

and the “Peaks.jar” file has been placed within the appropriate directory, 

the DSS file associated with the HEC-SSP project can be by selecting 

Tools | HEC-DSSVue within the HEC-SSP project.  Alternatively, the 

DSS file can be opened independently of HEC-SSP.  Once the DSS file is 

opened within HEC-DSSVue, there will be a record created with the 

following part names: \\TOCKS ISLAND\FLOW\\1DAY\USGS.   

There cannot be missing values within the data set for the selected Time 

Window.  The Estimate Missing Values tool within HEC-DSSVue’s Math 

Functions can be used to fill in data gaps, if necessary. 

Select the daily flow data set and then select Tools | Find Peaks, as shown 

in Figure D-2. 

http://www.hec.usace.army.mil/software/hec-dssvue/plugins.aspx
http://www.hec.usace.army.mil/software/hec-dssvue/plugins.aspx
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Figure D-2.  Find Peaks Tool Location within HEC-DSSVue. 

 

The Find Peaks tool requires multiple user inputs in order to determine 

“hydrologically independent” peaks (or troughs), as described within EM 

1110-2-1415 “Hydrologic Frequency Analysis”.  For example, Figure D-3 

shows a flow hydrograph at the Delaware Water Gap stream gage 

(drainage area = 3,850 sq mi).  The peak flow at 09Dec1950 is not 

hydrologically independent; this peak was dependent upon the peak on 

05Dec1950.  The peak on 26Nov1950 can be considered hydrologically 

independent.  However, it is up to the user to decide whether the peak on 

05Dec1950 is hydrologically independent. 
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Figure D-3.  Example of Hydrologically Independent Peaks. 

 

The first user input within the Find Peaks tool asks whether the user 

wishes to find peak values (maximums) or troughs (minimums), as shown 

in Figure D-4.  Select “Peaks”, which will display a new window asking 

the user to specify a threshold (minimum) value.  By default, the Find 

Peaks tool will estimate a threshold value based upon the values contained 

within the selected data set.  The user may also leave the field blank which 

will enable all values to be discernable as peak values.   

The threshold value can be set to the minimum peak contained within the 

associated annual maximum series in order to capture a large number of 

peaks.  However, this threshold value is watershed (and study) dependent.  

For this example, enter 30000 within this field, indicating that all peak 

values greater than 30,000 cfs will be carried forward as potential peaks, 

as shown in Figure D-5. 

The next dialog will require the user to input a minimum magnitude and 

time differential.  These two inputs preliminarily determine whether a 

peak is truly “independent”.  In order for a peak to be independent, the 

flow/stage hydrograph must decrease (or increase when determining 

independent minimums) by a certain magnitude or below a certain 

threshold.  Also, a certain amount of time must elapse before the peak can 

be classified as independent.  These values are location dependent as well 

as reliant upon the study purposes.  By default, the Find Peaks tool will 

estimate a minimum magnitude and time differential based upon the 

values contained within the selected data set. 

Hydrologically
Independent 

Peak

NOT
hydrologically
independent

Hydrologically
Independent? 
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For the Delaware River near Delaware Water Gap, PA stream gage, the 

drainage area is large.  The contributing watershed requires approximately 

one week (i.e. seven days) to return to baseflow.  For smaller watersheds, 

such as highly urbanized streams that exhibit an extremely fast rise and 

fall in flow or stage, the time required to return to an approximate 

baseflow may be on the order of hours, not days.  For this example, the 

minimum magnitude and time differential can be set to 10000 and 240, as 

shown in Figure D-6.  This implies that the hydrograph must decrease by 

10,000 cfs and 10 days must elapse before a new peak can be considered 

independent of a previous peak.  Figure D-7 displays the threshold value, 

minimum magnitude, and minimum time differential values for a three-

month time span at the stream gage in question. 

 
Figure D-4.  Selection of Either Peaks or Troughs. 

 

 
Figure D-5.  Threshold Value Selection. 

 

 
Figure D-6.  Minimum Magnitude and Time Differential Selection. 
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Figure D-7.  Threshold Value, Minimum Magnitude, and Minimum Time 

Differential. 

 

Clicking OK results in the creation of an irregular time series record (i.e. 

the date-time of occurance is saved along with the data value) that is 

usable by HEC-SSP.  The flow data set and peak data set are shown in a 

separate window, as shown in Figure D-8. 

 

Minimum 
Magnitude 
Differential

Minimum 
Time

Differential
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Figure D-8.  Resulting Peak Flow Partial Duration Series. 

 

As is shown in Figure D-9, this partial duration series contains peak flow 

rates for multiple peak flow rates including the two extremely large peaks 

that occurred in late August and early September, 2011 (corresponding to 

the passage of Tropical Storm Irene and Tropical Storm Lee).  By 

definition, an annual maximum series only records a single peak flow rate 

for each water year.  Therefore, only the larger event (September 2011) is 

stored within an annual maximum series. 
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Figure D-9.  Resulting Peak Flow Partial Duration Series and Annual Maximum 

Series for 2008 - 2012. 

 

This peak flow partial duration series data set can now be used within a 

General Frequency analysis in HEC-SSP.  However, it is up to the user to 

review the peak flow partial duration series.  The three criteria (threshold, 

magnitude differential, and time differential) may not be adequate to 

completely define all independent peaks for a given data set; some non-

independent peaks may need to be deleted while others may need to be 

added. 




